70002-0265-03
05/2009

PowerLogic™ ION8600

Energy and power quality meter

User Guide

PowerLogic* ION8600

Schneider






Important Information

Read these instructions carefully and examine the equipment to become familiar
with the device before trying to install, operate, or maintain it. The following
special messages may appear throughout this documentation or on the equipment
to warn of potential hazards or to call attention to information that clarifies or
simplifies a procedure.

Danger
This symbol indicates the presence of dangerous voltage within and
outside the product enclosure that may constitute a risk of electric
shock, serious injury or death to persons if proper precautions are not
followed.

Caution
This symbol alerts the user to the presence of hazards that may cause
minor or moderate injury to persons, damage to property or damage
to the device itself, if proper precautions are not followed.

Note
This symbol directs the user’s attention to important installation,
% operating and maintenance instructions.

Installation Considerations

Installation and maintenance of the ION8600 meter should only be performed by
qualified, competent personnel that have appropriate training and experience
with these types of devices and their associated equipment. A qualified person is
one who has skills and knowledge related to the construction and operation of
these types of electrical equipment installations and has received safety training to
recognize and avoid the associated hazards. The meter must be installed in
accordance with all local and national electrical codes.

No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.

/\ DANGER

Failure to follow these instructions will result in death or serious injury.

¢ During normal operation of the ION8600 meter, hazardous voltages are present on
its terminal strips, and throughout the connected potential transformer (PT), current
transformer (CT), digital (status) input, control power and external I/O circuits. PT
and CT secondary circuits are capable of generating lethal voltages and currents
with their primary circuit energized. Follow appropriate safety precautions while
performing any installation or service work (i.e. removing PT fuses, shorting CT
secondaries, etc).

¢ The JON8600 meter must be installed with chassis ground. Ground the device
before power is applied. Proper grounding of the meter is necessary for the
following reasons:



Safety of personnel working with the meter.
Protection of the electronic circuitry in the meter.
Proper operation of noise filtering within the meter.

Proper operation of communication ports.

* 6 6 o o

Compliance with all local and national regulations on grounding electrical
devices.

The meter's grounding tab, ground terminal or ground wire (in case of meters
powered from auxiliary power source) must be connected to the protective earth
ground before the meter is powered up.

¢ The ION8600 is designed to be used as a permanently installed device. All electrical
connections to the meter must be installed with a permanent connection method.

¢ Install fuses (customer supplied) in all voltage measurement inputs and auxiliary
(control) power circuits.

& All electrical connections on the meter terminals should not be user-accessible after
installation.

¢ Do not use the ION8600 outputs for primary protection functions. These include
applications where the devices perform energy limiting functions or provide
protection of people from injury. Do not use the ION8600 in situations where loss of
device functionality can cause injury or death, or cause sufficient energy to be
released that can start a fire.

CAUTION

Failure to follow these instructions can result in equipment damage and void the warranty.

¢ Do not HIPOT/Dielectric test the digital (status) inputs, digital outputs, or
communications terminals. Refer to the applicable section in this manual for the
maximum voltage level the terminal can withstand.

¢ The ION8600 meter offers a range of hardware options that affect input ratings.
The ION8600 meter’s serial number label lists all equipped options. Applying
current levels incompatible with the current inputs will permanently damage
the meter. This document provides installation instructions applicable to each
hardware option.

¢ Recommended terminal screw torque for voltage and current inputs
(switchboard meters only) is 2.82 Nm (25 in-Ibs) max. Recommended terminal
screw torque for auxiliary power supply inputs (switchboard meters only) is
1.01 Nm (9 in-lbs) max.

FCC Notice

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation.



If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures.

¢ Reorient or relocate the receiving antenna
¢ Increase the separation between the equipment and receiver.

¢ Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

¢ Consult the dealer or an experienced radio/TV technician for help.
This Class B digital apparatus complies with Canadian ICES-003.

The Ringer Equivalence Number (REN) for the ION8600 optional internal modem
is 0.6. Connection to the ION8600 internal modem should be made via an FCC Part
68 compliant telephone cord (not supplied). The ION8600 cannot be used on a
public coin phone service or party line services.

Network Compatibility Notice for the Internal Modem

The internal modem in meters equipped with this option is compatible with the
telephone systems of most countries in the world. Use in some countries may
require modification of the internal modem’s initialization strings. If difficulty
using the modem on your phone system occurs, please contact Schneider Electric
Technical Support.

Made by Power Measurement Ltd.

Covered by one or more of the following patents:

U.S. Patent No's 7010438, 7006934, 6990395, 6988182, 6988025, 6983211, 6961641,
6957158, 6944555, 6871150, 6853978, 6825776, 6813571, 6798191, 6798190, 6792364,
6792337, 6751562, 6745138, 6737855, 6694270, 6687627, 6671654, 6671635, 6615147,
6611922, 6611773, 6563697, 6493644, 6397155, 6236949, 6186842, 6185508, 6000034,
5995911, 5828576, 5736847, 5650936, D505087, D459259, D458863, D443541,
D439535, D435471, D432934, D429655, D427533.
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Chapter

1

Introduction

PowerLogic™ ION8600 meters provide revenue-accurate, true RMS
measurements of voltage, current, power and energy, and are complemented by
extensive I/O capabilities, comprehensive logging, and advanced power quality
measurement and compliance verification functions. The meters come with an
extensive selection of pre-configured data screens and measurements, so you can
use the meters “out of the box” or customize them to fit your unique requirements.

ION8600 meters give you the tools to manage complex energy supply contracts
thatinclude commitments to power quality. You can also integrate the meters with
ION Enterprise or other energy management, SCADA, automation and billing
systems, via Internet communications and multiple industry-standard
communication channels and protocols including MV90.

In this chapter

¢ IONB600Meters .......cciviiniiiiiiiiiiiiiiiinenennnnnnnn 10
¢ ION8600 in Enterprise Energy Management Systems . ................ 11
Data Display and Analysis Tools ............... .. .o, 11
TheFrontPanel ........ ... .. 12
WebMeter Internal Web Server Feature .............................. 12
MeterM@il Internal Email Server Feature ............................. 12

XML Compatibility ........ ... ..o 12

ION Enterprise Software . ........... .. ... i 12

ION Setup Software ... 13

MVO0 13
Communications Methods ................ ... ... oo 13
Digital and Analog I/OOptions . ............ ... ... i i 13
Onboard I/O ... i 14
Expanded I/O .. ... 14

The Meter is Factory-Configured and Ready to Operate ................ 14

¢ UsingthisGuide ..........ooiiiiiiiiiiiiiiii it 15
Terminology ... 16
PDFDocuments ...............oiiiiiiiiiiiiiiii, 16

Getting More Information .............. .. ... . ool 17
Before You Can Use thisGuide ................ ... ...t 17
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ION8600 Meters

ION8600 meters are suited to a wide range of applications. The meters can be used
as stand-alone devices, but their extensive capabilities are fully realized when used
as part of an enterprise energy management (EEM) system. The ION8600 is
available in the following feature sets:

Model Feature Set

10MB memory, 50 data recorders (800 channels), waveform

IONB600A recorders and transient detection.
ION8600B 4MB memory, 20 data recorders (320 channels), Modbus Mastering.
ION8600C 2MB memory, 2 data recorders (32 channels), sag/swell detection

2\, NOTE

For complete details of the ION8600 meter feature sets, see the ION8600 Datasheet available for
download from the PowerlLogic website.

ION8600 Naming Convention

In the serial number and ANSI bar code area of the meter’s front panel you can
view the feature set, form factor and as well as any special order options available
with the meter.

Meter type: ION8600 Feature Set | Voltage Inputs ‘ Frequency.})MMS } Security ‘

P 860 0A0COHEE OAQA ! specil O0der |

‘ Form factor (36S, 35S, 9S...) | Current Inputs ‘ Power Supply | 1/O Option ‘

When there are differences between the models (such as a feature specific to one
model), it is indicated with the appropriate model number.

Page 10
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ION8600 in Enterprise Energy Management Systems

Power System Connections

\
\ phase power systems

Input/Output

- Pulses

- Breaker Status
- Control Signals
- Energy Pulses

Phase voltage, phase current, ground current,
and neutral current from Wye, Delta, or single-

On-Site Setup

- 320 by 240 pixel LCD
- ION Setup software

Applications that include the meter typically require additional equipment.
Display and analysis software tools are almost always used to manage, interpret
and distribute the data measured or logged by a meter. There are usually a variety
of tools used, and often these tools are connected using different communications
standards and protocols. In many cases, a meter must also provide control
capabilities and device-level data sharing.

The meter can adapt to many situations. Advanced communications allow data to
be shared simultaneously across multiple networks, built-in I/O provides
monitoring and control capabilities, and a variety of display and analysis tools can
be used to monitor your power system.

Data Analysis Tools

- Power Monitoring Network
- Third-Party Software for Modbus,
DNP 3.00, MV90

Corporate Network

/

Communications

- RS-232 and high speed RS-485
- Internal Modem
- Optical infrared

Internet Connectivity

- MeterM@il functionality
- WebMeter functionality

- LED Pulsing - 10 Base-T (:1.n.d 10 Base-FL Ethernet - XML compatibility
- Interoperability
Remote Data - Protocols: ION, Modbus Master,
g Displa Modbus RTU, Modbus TCP DNP 3.00,
T Isplay ModemGate (modem to RS-485
|/0 Expander - Vista gateway), EtherGate (Ethernet to RS-485

- WebReach

gateway), GPS: Arbiter, GPS: True Time/
Datum

Data Display and Analysis Tools

Not only does the meter’s front panel allow meter configuration and data display,
but the meter also integrates seamlessly with display and analysis software
available from Schneider Electric™. ION Enterprise™ software is the network and
device configuration software that also lets you analyze and monitor your system
and produce reports for any department in an organization. Furthermore, you can
use data acquired by the meter in a variety of third-party systems. ION Enterprise
software is designed to make use of all the available advanced capabilities.

© 2009 Schneider Electric. All rights reserved.
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The Front Panel

Local monitoring and standalone applications are facilitated by the meter’s front

panel interface. The front panel combines real-time display features with limited

device configuration functions. The front panel is often used in combination with
an ION Enterprise or ION Setup software system, providing an interface for field

personnel.

WebMeter Internal Web Server Feature

An on-board Web server combined with an Ethernet port provides quick and easy
access to real-time energy and basic power quality information without special
software: this is WebMeter™ functionality. The built-in web pages display a range
of energy and basic power quality information through the web-enabled device;
these pages even support basic meter configuration tasks.

MeterM @il Internal Email Server Feature

Configure the meter to automatically email high-priority alarm notifications or
scheduled system-status update messages to anyone, anywhere within the facility
or around the world. Specify the type of event that triggers an email alert, such as
power quality disturbances or logged data at any pre-determined interval, and
have your ION Enterprise or ION Setup software administrator program the meter
to respond with a MeterM@il™ message when these events occur. MeterM@il
messages can be received like any email message over a workstation, cell phone,
pager, or PDA.

XML Compatibility

The meters can exchange information using industry-standard XML format. This
simple machine-readable format supports easy integration with custom reporting,
spreadsheet, database, and other applications.

ION Enterprise Software

The complete ION Enterprise™ software package enables the meter to be part of a
fully networked information system with other meters and local and wide-area
computer networks. ION Enterprise is recommended for all power monitoring
systems where advanced analysis and control capabilities are required.

ION Enterprise provides tools for managing your power monitoring network,
logging data, analyzing real-time and logged data, generating power system
reports, and creating custom functionality at the meter level.

ION Enterprise also offers two ways to remotely view information through a web
browser: the WebReach component of ION Enterprise, and Microsoft Terminal
Services.

¢ WebReach only requires an URL to display a meter’s real-time data and select
views of historical and waveform data from a web browser; there is no client
machine configuration. WebReach is a data display application; there is no
control functionality available through it.

Page 12
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¢ Microsoft Terminal Services enable full ION Enterprise functionality, including
control features. Some client machine configuration is required.

ION Setup Software

ION Setup is a meter configuration tool designed specifically to configure and test
meters. ION Setup offers an intuitive graphical interface for performing basic
meter setup, installing templates into meters, viewing real-time and reset
accumulated values, verifying meter calibration and measurements, and setting
up advanced security.

MV90

MV90 software (by Utility Translation Systems) is a multi-vendor translation
system that can collect and analyze data from a variety of different brands of
meters. One of the unique features of MV90 is its ability to log some information
coming from several different brands of meters, each with unique database
formats. MV90 manipulates this data without extensive knowledge of the device
of origin. This is done by using TIM modules; each TIM module acts as a protocol
translator specific to a device type, and it will convert some pre-defined data from
a meter to the MV90 database format. The TIM module used for ION™ meters is
called TIM_ION.

Communications Methods

The meter can be integrated into various industry-standard networks. Data that is
measured by the meter can be made available to other devices using the Modbus™
Master, Modbus RTU, Modbus TCP, and DNP 3.00 protocols, as well the MV90
translation system. You can also configure the meter to import data from devices
on these networks. With these advanced communications functions, the meter
operates in most existing power monitoring systems. Any data display and
analysis software that works with Modbus RTU or DNP 3.00 devices will also
function with the meter.

The standard meter includes a selectable RS-232/RS-485 port (the factory default is
RS-232), a high-speed RS-485 port, and an IrDA optical port for communications
in the field. Order options include a 10Base-T Ethernet port or 10Base-FL fiber-
optic port, and a 57.6 kbps internal modem (both FCC and CTR-21 compliant).
Depending on the hardware options purchased, up to four separate ports can
communicate simultaneously.

Digital and Analog 1/O Options

The meter has digital inputs and outputs for a variety of applications.
Additionally, a LED on the front panel is configured for energy pulsing. An
optional I/O Expander product option is also available for digital and analog
communication. There is separate I/O Expander documentation that accompanies
this option.

© 2009 Schneider Electric. All rights reserved.
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Onboard 1/0

The meter contains four Form C digital outputs and three Form A digital inputs.
They can be used for monitoring breaker trips or send KYZ pulsing information to
third-party system equipment.

Expanded 1/0

The I/O Expander option extends the meter’s I/O capabilities. The digital I/O
Expander model provides four Form A digital outputs, four Form C digital
outputs, and eight Form A digital inputs. The analog I/O Expander model replaces
the four form A digital outputs with analog outputs.

The Meter is Factory-Configured and Ready to Operate

Even though the meter is fully customizable, it is shipped from the factory with
many pre-configured functions. Once you have performed the installation and
basic setup, all of the basic measurements, energy calculations and recording
functions are ready to operate right out of the box. You may find that the factory
configuration aptly serves your purposes, allowing you to forego additional
configuration.

Page 14
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Using this Guide

This User’s Guide is directed at three types of user: the typical user or operator, the
system administrator, and the advanced user. You might not fit into any of these
groups directly, or perhaps you are both an operator and an administrator. These
classifications are intended to make this guide easier to navigate with respect to
which information is appropriate to your needs.

Typical User or Operator

Most users simply want to display the data provided by the factory-configured
meter. These users want fast access to data through the front panel, ION Enterprise
or ION Setup software, or a third-party protocol such as Modbus or DNP.

System Administrator or Manager

Some users need to make minor adjustments so that their meters “fit” their power
systems: data recording intervals, demand sub-intervals and other parameters
may need to be set before the meter’s setup is complete. These users will use the
front panel, or ION Enterprise or ION Setup software to change settings in the
device’s operating software. (ION Enterprise is highly recommended.)

Advanced User or Systems Integrator

Advanced users may want to make use of the flexibility and power provided by
the device’s operating software. These users will need to become familiar with the
ION architecture, and the software tools used to customize the device’s operation.

© 2009 Schneider Electric. All rights reserved.
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Terminology

Clear: Place the mouse cursor over the check box for the specified
option, then click the mouse button so that the check mark is
removed from the check box.

Click: Place the mouse cursor over the specified option or button,
then press and release the mouse button.

Double-click:  Place the mouse cursor over the specified option or button,
then press and release the mouse button twice.

Drag: Hold down the mouse button while moving the mouse cursor
to the appropriate location, then release the button.

Enter: Type the information, then press the ENTER or RETURN key.

Point: Position the mouse pointer over a submenu or menu
command. For example, point to the File menu.

Press: Press the specified key or key combination on your keyboard,
for example, press CTRL+ALT+DEL.

Select: Place the mouse pointer over the check box for the specified
option, then click the mouse button so that an X or check mark
appears in the check box.

Or:

Place the mouse pointer over the specified box or button, then
click the mouse button.

Type: Type the information. Do not press the Enter or Return key.

PDF Documents

This manual is also provided in PDF (Portable Document Format) from the
PowerLogic website.

Use Acrobat Reader to view and print the PDF version of the manual. When
printing the manual, please print the entire manual, including the copyright and
disclaimer statements.

The PDF files for all Schneider Electric products are also available from the
website. Each Schneider Electric device has installation information and a user's
guide to teach you about the features of your device.

ION meters are programmed using ION modules that are linked to create
unlimited custom functionality. Your meter has many pre-configured modules
that provide most functionality that you need. If you want to extend or customize
the functionality of your meter consult the online ION Reference for general
information and ION module descriptions. For information on configuring
features search the technical notes.

Page 16 © 2009 Schneider Electric. All rights reserved.
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Getting More Information

Additional information is available from Schneider Electric. Check our website at
www.powerlogic.com, contact your local Schneider Electric representative, or
contact Schneider Electric directly (contact information is provided on the first
page of this document). Documents that are related to the installation, operation
and application of the meter are as follows:

Installation Guide

This brief guide is shipped with each meter. It details the mounting, wiring and
basic setup of the device.

Online ION Setup Help

This online reference has in-depth information on installation, setup and security
of ION Setup. It also contains detailed descriptions of ION meter configurations
using the Setup Assistant.

ION Reference

This online reference contains detailed descriptions of all modules in an ION
meter.

ION Enterprise Getting Started Guide

This guide explains the installation and configuration of the ION Enterprise
software suite.

Online ION Enterprise Help

Each ION Enterprise software component has an in-depth online help system.

Technical Notes

Technical notes are available from our website. These documents are regularly
updated with new and revised content and features.

Application Notes

Online application notes offer detailed, high-level descriptions of real-world
situations, where Schneider Electric’s ION devices and software provide beneficial
solutions.

Before You Can Use this Guide

By the time you are ready to use this guide, your meter should be installed, basic
setup should have been performed, and communications/basic operation should
have been verified. If the unit is not yet installed and operational, refer to the
Installation Guide that shipped with the meter.

© 2009 Schneider Electric. All rights reserved. Page 17
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Front Panel

The front panel of the ION8600 provides a user-friendly interface from which you
can view system data or configure meter settings. A scrollable display and three
distinct modes (NORM, ALT and TEST) provide easy access to a full range of
functions through a simple three-button keypad.

This chapter describes the front panel and explains how to use it to display data,
perform tests, and set up basic configuration options.

In this chapter

*

*

FrontPanel Features ............ooiiiiiiiiiiiiiiiiiiiieenn, 20
LED pulsers . ... 21
Demand reset switch ........... ... ... 21
Navigationbuttons ......... ... ... . i i 21
Optical port ...... .o 21
Master Resetbutton ............. ... .. . i 22
TESTmodebutton .......... ... ... 23

Display Screen Types . ......ovviiiiiiiiiiieiiiiiinneeeeennn 24

Modes of Operation . .........c.ciiiiiininnennnnrnnnnnnnnnnns 27
Basic operation NORM mode) ........... ..., 27
ALTmode ... 27
TESTmode ... 28

Configuring the Meter with the FrontPanel ........................ 29
Accessing theSetupMenu ................ . ... oo 29
Returning to Previous Setup Screens ........................ ... 31
Configuring Parameters Using the Navigation Buttons ................ 31
Confirming Configuration Changes ................................. 31

Setup MenuUS . ... 32
BasicSetupMenu ........ . ... 32
Demand SetupMenu ................. ... . i 33
COM Ports Setup Menu ..........coiiiiiiiiiiiiiiii i 33
Network SetupMenu .......... ..o 35
FormatSetupMenu ................... ... 37
Display SetupMenu .................. .. . 37
Security MeNU . ... 38

© 2009 Schneider Electric. All rights reserved.
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Front Panel Features

The front panel of the ION8600 includes a liquid crystal display with detailed
graphics and text, Up and Down arrow buttons to aid in screen navigation and
basic setup procedures, as well LED pulsers to aid in testing the meter. This section
outlines the features available on the front panel of the meter.

PowerlLogc

O Main display

Meter label

*ZYY00606019600000° ; K
PT-0606A196-01 P8600BOCOESM1B1A Demand resef SW”Ch

‘ Navigation buttons i ALT/Enter button

The meter’s display can show numeric data screens, event logs, phasor diagrams,
bar graphs and harmonics histograms. As the graphic above illustrates, the display
screen is divided into two sections: the main display area and the status bar.

The main display area presents meter data and status information; the status bar
provides time, date, phase, quadrant, and mode information. During normal
operation, the main display area automatically cycles through a series of several
displays. If you prefer, you can use the Up or Down arrow buttons to step
manually through these displays. By default, the automatic scrolling will resume
60 seconds after you have pressed a button.

@ e

To adjust the contrast, hold down the Up and Down arrow buttons simultaneously. When the contrast
reaches the desired level, release the buttons.

Page 20 © 2009 Schneider Electric. All rights reserved.



PowerlLogic ION8600 User Guide Chapter 2 - Front Panel

LED pulsers

o © Two LED pulsers located near the top of the front panel represent WATT - to the
left - and VAR - to the right.

These LEDs are pre-configured for energy pulsing. The adjacent smaller infrared
outputs are connected to the LEDs and pulse at the same rate. Pulse rates can be
adjusted by re-configuring the Calibration Pulser module; for a detailed
description of LED pulsers operation, refer to “Energy Pulsing with LEDs” on
page 141).

Demand reset switch

Located on the front of the meter's external cover assembly, the Demand Reset
switch resets the peak demand values logged in the meter. This switch can be
activated with the cover on or off. When the meter is in TEST mode, the Demand
Reset switch resets the test demand parameters.

In most applications, the Demand Reset switch is sealed with an anti-tamper
mechanism; a through-hole in the switch can accommodate either an external seal
or a locking mechanism. See “Anti-Tamper Sealing Methods” on page 69 for a
discussion of Anti-Tamper sealing.

The ION setup register labeled Demand Lockout Time sets the minimum time
allowed between consecutive demand resets; the meter ignores any attempts to
reset the demand outside the bounds of the register. The default value for the
Demand Lockout time is 25 days. For details on the Demand Lockout Time setup
register, refer to “Demand and Peak Demand Module Overview” on page 121.

Navigation buttons

The navigation buttons are the Up and Down arrow buttons and the round

Alt/Enter button. Pressing the Up or Down arrow buttons to manually scroll back

or forth through the available displays temporarily halts the display screen’s

automatic scrolling function. Pressing Alt/Enter toggles between NORM and ALT
A display modes. The automatic scrolling function restarts 60 seconds after a button
v ® was last pressed.

Hold the Alt/Enter button for approximately three seconds to display the Setup
menu. You can then use the navigation buttons to view the device's configuration
or edit communication settings. See “Setup Menus” on page 32 for further
instruction on modifying the device's configuration using the front panel buttons.

Optical port

An optical port facilitates infrared communication with the device. For details on
how to configure and use this port, see “Configuring the Optical Port” on page 82.

© 2009 Schneider Electric. All rights reserved. Page 21
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Master Reset button

You must remove the meter’s cover as well as the front panel label to access the
Master Reset button; it is a pin-hole located in the lower left of the faceplate (it is
labeled “Energy Reset” on some meters). This button is recessed to prevent
accidental activation. For instructions on removing the meter cover, see
“Performing a Master Reset from the front panel” on page 192.

MASTER
: RESET Use the Master Reset button to delete most accumulated values and all derived
revenue measurements from the meter.

To use the Master Reset button:

1. Remove the outer cover assembly.

2. Using a pencil or similar instrument, press and hold the Master Reset button
until the “Master Reset in Progress” message is displayed on the front panel.
CAUTION

After initiating a Master Reset, wait until the “Master Reset Completed” message appears on the front

panel (or about two minutes, depending on your firmware). This allows the meter to completely reset

parameters. This is especially important if you are powering down the meter after a Master Reset.

Failure to follow these instructions can result in equipment damage and void the warranty.

Hardware-Locked Meters and Master Reset

Master reset is not accessible via software in a hardware-locked meter, whether the

meter is in TEST, ALT or NORM mode. To perform a master reset on a hardware-

locked meter, you must remove the front cover and press the master reset button.

With a meter that is not hardware-locked, you can perform a Master Reset via

software. It does not have to be in TEST mode.

Parameters affected by a Master Reset

The Master Reset button resets many of the device's measurements and logs. The

mode that the meter is in (NORM mode or TEST mode - see “Modes of Operation”

on page 27) defines the values that will be reset.

NORM or ALT mode

In NORM or ALT mode, the following parameters are reset to zero:

¢ Energy and Demand

& Peak Demand

& Loss Calculation

¢ Power Quality disturbance counters

& Time of Use

The following are cleared:

¢ Event Log

& All Data Recorders

& All Waveform Recorders
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TEST
MODE

TEST mode

All TEST mode Energy and Demand measurements are set to zero.

TEST mode button

The TEST mode button is located under the meter's external cover assembly; it
places the meter into TEST mode. While in TEST mode, the meter ceases
accumulation of billable quantities; energy and demand measurements are
accumulated in TEST mode registers.

Refer to “TEST mode” on page 28 for more details on this mode of operation.

© 2009 Schneider Electric. All rights reserved.
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Display Screen Types

The front panel displays measurements, configured settings and configuration
data in a variety of forms. The types of display screens are described below. For
information on customizing the display on your meter, see “Configuring Front
Panel Displays” on page 173.

The status bar

The status bar runs along the bottom of the front panel display and contains
information about the following settings:

¢ Date and time (in 24 hour format).

¢ Voltage phases present. The labels and rotation of phases correspond to the
configuration of the power monitoring system. AB BC is for Delta configuration
(35S forms), ABC is four wire Wye configurations (95/36S forms).

¢ Quadrant where the system power factor resides.
& Mode (NORM, ALT or TEST).

¢ Time remaining in the Rolling Block Demand interval. If the interval has
counted to zero the letters EOI (End Of Interval) appear on the status bar. If the
interval is counting down then a time remaining indicator appears.

\

! 5600

9:36:54  12/09/2005 ABC Q1 TEST H__|

Numeric displays

All NORM mode data and some of the ALT mode display screens use numeric
displays. Numeric displays show up to four parameters at a time. If no numeric
values are available for a parameter, N/A is displayed.

Vin A MAX
0000347.9 «
Updated at: 12/09/2002 9:15:33
9:36:54 12/09/2005 ABC Q1 NORM EHJ

The front panel automatically scales the units for basic measurements (i.e. voltage,
current and power parameters). For example, a measurement of 2,000 Watts is
displayed as 2 kW. A measurement of 2,000,000 Watts is displayed as 2 MW. The
meter makes these conversions using your PT and CT Ratios.
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The meter only performs these automatic units if the measurement is derived
solely from the Power Meter module’s output.

Nameplate display and event log

Nameplate displays and event logs appear in ALT mode and are organized in
tabular format. Nameplate displays show owner, meter and power system details:

OWNER Best Utility
TAG 1 Substation 13A
TAG 2 Main Feed 13kV
FW Rev, FEATURE SET 8600V310, A
BATTERY LIFE 96.9% DIAG NUM 40/999
15:36:54 12/09/2005 Q1 ALT E—J 3:39m

The Event Log displays recent high priority events. You must use ION Enterprise
or ION Setup software to retrieve all logged data:

DATE TIME EVENT CODE
12/08/2005 10:23:45 Shutdown SD25
12/08/2005 10:42:03  Power Up SD25

12/08/2005 11:19:26 Changed Setup  SD25
VIEW EVENT LOG THROUGH COMMUNICATIONS
9:36:54  12/09/2005 ABC Q1 NORM HJ

Histogram displays

Harmonic content is displayed in histogram format. The 2" to the 63" harmonics
(315 on the ION8600C meter) are displayed in the histogram. The total harmonic
distortion (THD) is displayed above the histogram.

o VA HARMONICS
THD: 50%

93654  12009/2005 ABC Q1 NORM M

© 2009 Schneider Electric. All rights reserved.
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Phasor diagram displays

Phase information can be displayed in phasor diagram format. Phasor diagrams
are accompanied by tables that show phase, voltage and current magnitudes. In

cases where a phase vector is too small to be represented graphically, it is shown
as a table entry only.

vCc IC Va 84.6 KV 0
Vb 88.5 KV 240
Ve 84.6 KV 120

VA o 2006A  -20
B 1A b 2106A 220
Ic  2045A 100

9:36:54  12/09/20056 ABC Q1 NORM ]

Disk simulator

This display simulates the behavior of a mechanical watt-hour meter indicating
power received or delivered by the direction of the pulse.

KWh delivered 1.29

9:36:54  12/09/2005 ABC Q1 NORM H_]

Time and date

This displays supports time and date formats, enabling displays with nothing but
date and/or time and/or time remaining in the current interval.

9:36:54
12/09/2005

9:36:54  12/09/2005 ABC Q1 NORM H ]

Time-stamped values

Up to three timestamped parameters can display on the same screen. The
timestamp indicates the time that the displayed parameter was last updated.

kW block peak deliver 000001
12/09/2004 7:30:00
kVA block peak deliver 000002
12/09/2004 7:30:00
kVAR block peak deliver 000001
12/09/2004 7:30:00
9:36:54 12/09/2005 ABC Q1 NORM H__1]

Page 26
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Modes of Operation

The ION8600 has three modes of operation: NORM, ALT and TEST. Both NORM
and ALT are display modes, providing various power system data and meter
properties screens. TEST mode is used to perform diagnostics and verify the
meter’s calibration and function.

2\ NOTE

If your meter has the optional hardware lock, you must remove the meter’s cover to put it into TEST mode.

Refer to “Meter Security Features” on page 52 for more information.

Basic operation (NORM mode)

The meter defaults to NORM mode when powered up, and remains in this mode
until you manually switch to ALT or TEST.

2\ NOTE

You can customize NORM mode display screens and alter the front panel’s scrolling characteristics by
editing the configuration of the meter’s Display and Scroll modules — refer to “Display Setup Menu” on

page 37 for more details.

If you have a meter without the hardware lock, all of the settings available in the
panel Setup menu can be changed while the meter is in NORM mode, provided
you have the correct password. If you have a hardware-locked meter, only the
basic communications parameters in the COM Setup menu can be changed in
NORM mode. (You must enter TEST mode to change other meter parameters on
the hardware-locked meter — refer to “Additional Revenue Metering Security” on
page 67 for more details.)

ALT mode

ALT mode provides scrolling display screens that show power system data, billing
information (including extensive Time of Use data) and meter properties such as
Nameplate information.

ALT mode screens are described in “ALT mode default display screens” on
page 178.

Switching to ALT mode

Press the Alt/Enter button to switch to ALT mode. Press the Alt/Enter button again
to switch back to NORM mode at any time. If no buttons are pressed, the meter
automatically reverts to NORM mode after five minutes. As with any mode,
pressing any button temporarily suspends display screen scrolling, allowing you
to press the Up or Down arrow buttons to manually browse the available screens.
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TEST mode

TEST mode is typically used for verifying meter calibration and function. The
meter is usually reading data from a test power supply while these functions are
performed.

All of the billing quantities that are recorded when the meter is in NORM and ALT
mode will stop accumulating when the meter is switched to TEST mode — the data
is sent to special TEST mode registers instead. The values accumulated in these test
registers are displayed on the front panel (and in Vista software).

The regular NORM/ALT mode billing registers are unaffected while the meter is
in TEST mode; accumulation of this data continues as soon as you exit TEST mode.
All test registers are reset to zero when you exit TEST mode.

For detailed information on TEST mode, see “Switching to TEST Mode” on
page 185.

2\ NoTe

The meter will always return to NORM mode when you exit TEST mode, even if you entered TEST mode
from ALT mode.

Page 28
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Configuring the Meter with the Front Panel

With the meter’s front panel, you can navigate through different menus to perform
basic setup on your meter.

Powerlogic

Main display
dal 277
wema | T

Meter label
|
*ZYY00606019600000*

PT-0606A196-01 P8600BOCOESM1BIA Demand reset switch

’ Navigation buttons ALT/Enter button

Accessing the Setup Menu

To access the Setup menu, press and hold the front panel's Alt/Enter button while
the meter is displaying power system data. Within the Setup menu is a list of sub-
menus that contain the meter’s configurable settings. Setup menu items are
described in “Front Panel Features” on page 20.

Press the Up or Down arrow buttons to navigate through the menu. Highlight a
menu item and press the Alt/Enter button. When you select an item from the Setup
menu, you will be presented with another menu of the settings in the meter. You
may need to penetrate several layers of menus to access the setting you want to
change.
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The following diagram shows how the buttons are used to navigate the menus:

A

8600 SETUP

ENTER RETURN ress
BASIC SETUP_ [
DEMAND SETUP ﬂ} BASIC SETUP
[ VOLTS MODE |
COM3 SETUP Yo sIAiowe <‘>‘ VOLTS MODE
FORMAT SETUP PTPRIMARY | &\ 355 - 3 Wire
DISPLAY SETUP : 365 - 4 Wire Wye
SECURITY oETR

The settings contained in the Setup menu are:

Basic Setup:

Demand Setup:

COM1 Setup:
COM2 Setup:
COMS3 Setup:
COM1 Setup:

Network Setup:

Format Setup:
Display Setup:

Security:

Changes basic settings in the power measurement system
configuration.

Rolling Block/Sliding Window settings.
RS-232/RS-485 multiplexed port setup.
Modem setup.

Optical port setup.

RS-485 port setup.

Ethernet/Fiber 10Base-T port setup.

Customizes the style and values appearing on the display
screens.

Customizes display appearance, update time, and demand
lockout time.

Allows you to modify or disable the password, or disable
meter configuration with a web browser.

Each of these settings are discussed in turn in “Setup Menus” on page 32.

Page 30
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CONFIRM CHANGE
YES
NO

Returning to Previous Setup Screens

Use the Up or Down arrow buttons to scroll through the menu items. When the
setting you want to change is highlighted, press the Alt/Enter button.

To return to a previous screen, highlight the RETURN menu item and then press
the Alt/Enter button.

8600 SETUP
RETURN

BASIC SETUP
I DEMAND SETUP

BASIC SETUP

VOLTS MODE

| PT PRIMARY

Configuring Parameters Using the Navigation Buttons

Use the Up or Down arrow buttons to change the value (if numeric) or the setting
(if enumerated) of the highlighted parameter.

To change the position of the cursor, press the Up or Down arrow buttons for
about one second. The Up arrow button moves the cursor one position to the left,
and the Down arrow button moves the cursor one position to the right. Once you
have the value you want, press the Alt/Enter button to select it.

2\ NoTe

When setting Ethernet values (IP address, default gateway, etc.), press the Up arrow button to insert
additional digit spaces. Press the Down arrow to remove digit spaces (see “Network Setup Menu” on
page 35 for more information).

OUT OF RANGE screen

When editing numeric data the numbers below MIN and MAX indicate valid entry
bounds. If you enter a value outside valid bounds, you will be presented with an
OUT OF RANGE screen. You may then either return to the register you were
editing, or choose to exit.

Confirming Configuration Changes

The CONFIRM screen appears whenever you attempt to change the meter’s
settings through the front panel. This allows you to abort an unwanted
configuration change. The front panel also informs you when an entry is out of
range. In either case, you must press the Alt/Enter button to return to the previous
setup screen.

© 2009 Schneider Electric. All rights reserved.
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Setup Menus

8600 SETUP
RETURN _ [pres
INCRENE - SASIC SETUP
DEMAND SETUP Y, RETURN
LSl \/OLTS MODE
PT PRIMARY

The following sections describe settings for the Demand Setup, COM Setup and
Network Setup menus. Security setup is also discussed.

Setup menus can be accessed with ION Enterprise or ION Setup software or with
the meter’s front panel.

Basic Setup Menu

The Basic Setup menu lets you set volts mode, potential transformer (PT) and
current transformer (CT) ratios and various other settings (such as 14 and voltage
and current polarities) so that you can ensure that your meter is adequately set for
your application.

To access the Basic Setup menu with the meter’s front panel:

1. Press and hold the Alt/Enter button on the front panel of the meter. After
about three seconds the Setup screen appears.

2. Use the Up or Down arrow buttons to navigate to the BASIC SETUP menu. Press
the Alt/Enter button.

3. Press the Up or Down arrow buttons to navigate to the appropriate menus
(VOLTS MODE, PT PRIMARY, PT SECONDARY, CT PRIMARY,
CT SECONDARY).

Many of the settings will be configured when the meter is initially put into service
(the device will not operate properly until Volts mode and PT and CT ratios are
set), but some settings may need to be changed to refine the device’s operation.

2\ NOTE

If you have a hardware-lockable ION8600 meter, you must put the device into TEST mode prior to making

changes to the Basic Setup parameters. For TEST mode information, see “TEST mode” on page 28.

The functions of the setup registers in the Basic Setup menu are as follows:

Basic Setup Default Function
Menu ltem Value
Volts mode * The power system’s configuration and supported Form Factor
PT Primary 120 The Potential Transformer’s primary winding rating
PT Secondary 120 The Potential Transformer’s secondary winding rating
CT Primary 5 The Current Transformer’s primary winding rating
CT Secondary 5 The Current Transformer’s secondary winding rating
14 Primary 5 The Current Transformer’s primary winding rating for 14
14 Secondary 5 The Current Transformer’s secondary winding rating for 14
VA Polarity NORMAL The polarity of the Potential Transformer on V1
VB Polarity NORMAL The polarity of the Potential Transformer on V2
VC Polarity NORMAL The polarity of the Potential Transformer on V3

Page 32
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8600 SETUP

BASIC SETUP
DEMAND SETUP [

DEMAND SETUP

Com1 .SETUP ;— RETURN
. Bl S\WD SUBINTERVAL
SWD # SUBINTERVLS

8600 SETUP
DEMAND SETUP
eSSz |- | COM1SETUP
COM2 SETUP (~;— RETURN
IR E (  PROTOCOL

BAUD RATE

Basic Setup Default Function
Menu ltem Value
IA Polarity NORMAL The polarity of the Current Transformer on 11
IB Polarity NORMAL The polarity of the Current Transformer on 12
IC Polarity NORMAL The polarity of the Current Transformer on 13
14 Polarity NORMAL The polarity of the Current Transformer on 14
Phase Rotation ABC The expected rotation of the voltage phases (ABC or ACB)

Demand Setup Menu

You can access the Demand Setup menu with ION Enterprise or ION Setup
software or with the meter’s front panel.

To view the Demand Setup menu with the meter’s front panel, press and hold the
Alt/Enter button, and press the Up or Down arrow buttons to highlight Demand
Setup, and then press the Alt/Enter button.

The Demand Setup menu accesses the global settings for all of the revenue related
Rolling Block (Sliding Window) Demand functionality in the ION8600 meter. The
settings provided in the Demand Setup menu control the timing of these demand
calculations. The following setup registers and their default settings are displayed:

. Default .
Setup Register Value Function
SWD Sublnterval 900 s Specifies the number of seconds in the Rolling Block sub-interval

SWD # Sublntervals | 1 Sets the number of sub-interval in the Rolling Blocks

SWD Pred Resp 70 Specifies the speed of the predicted demand output

2\ NOTE

Refer to “Sliding Window Demand Module Settings” on page 119 for complete details about Sliding

Window Demand modules.

COM Ports Setup Menu

You can access the COM Ports Setup menu with ION Setup software or with the
meter’s front panel. See “Communications Options” on page 75 for more
information.

To make changes to communications settings with the meter’s front panel, hold
down the Alt/Enter button for three seconds to enter the Setup menu, then press
the Down arrow button to select the COM Setup you want.

© 2009 Schneider Electric. All rights reserved.

Page 33



Chapter 2 - Front Panel

PowerLogic ION8600 User Guide

Depending upon the communications options ordered with your meter, the
parameter settings available are as follows:

Menvu ltem Description
COM1 Setup Settings for the selectable RS-232 or RS-485 communications port.
COM?2 Setup Settings for the internal modem port.
COM3 Setup Settings for the optical communications port located on the meter’s front panel.
COM4 Setup Settings for the COM4 RS-485 port.
Network Setup Settings for the Ethernet communications port.
2 Note

For hardware-lockable meters, you do not need to be in TEST mode to alter these COM port settings.

Serial COM Settings

There are three main parameters that you must set or verify if your meter is
connected to a serial network (including modem communications): Unit ID, Baud
Rate, and Protocol.

2, NOTE

Other parameters such as TRANSMIT DELAY, are used in advanced configuration or fine-tuning your system.
Settings for the parameters mentioned above are commonly required to get your meter communicating.

You can access serial COM settings with ION Setup software, or with the meter’s
front panel. To navigate to the Unit ID, baud rate, and protocol settings using the
meter’s front panel:

1. Press and hold the Alt/Enter button on the front panel of the meter. After
about three seconds the Setup screen appears.

2. Use the Up or Down arrow buttons to navigate to the COM port you want to
configure. Press the Alt/Enter button.

Press the Up or Down arrow buttons to navigate to PROTOCOL, UNIT ID and
BAUD RATE menus.

Page 34
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The default configurations are listed in the following COM Setup menu for COM1
(selectable RS-232 or RS-485), COM2 (modem), COMS3 (optical port) and COM4

(RS-232 only)

Flow Control

this setting is located in the COM1 Hardware sub-menu

(RS-485).
Serial Port Setting Options Default
ION, Modbus RTU, Factory, DNP 3.0, GPS Arbiter] , GPS
Al Protocol Arbiter Vorr\el| ,and GPS:TrueTime/Dcx‘rum.I , therGateQ, ION
MoolemGoﬁe2
300, 1200, 2400, 4800, 9600, 19200, 38400, 57600,
All Baud Rate and 115200 bps 9600 bps
All Tran Delay Transmit delay-the bounds are 0.0 to 1.0 s. 0.01s (10ms)
COMT: Unit ID is based
Sets the meter Unit ID; on the serial number.3
All Unit ID a unique Unit ID is required for each device (including all COM2: 101
the devices on a ModemGate or EtherGate serial loop) COM3: 102
COM4: 103
COM1 Mode or Comm mode The communications mode selected: RS-232 or RS-485 RS-485
COMI1 ‘RTS/CTS’ or ‘RTS with Delay’;

‘RTS with Delay’

The number of rings during defined answer hours — Valid

COM2 Answer HR Rings entries for this register are 0-255 rings; an entry of 0 rings 1
will disable answering
COM2 Non-Answer HR Rings The number of rings during defined non-answer hours 5

8600 SETUP

COM3 SETUP
NETWORK SETUP

Press

See “Time Synchronization” on page 116 for more details about GPS settings. See also the technical

note Time Synchronization and Timekeeping for further details on using the meter’s time
synchronization functions.

page 88 for more details.

PA-0009B263-01, the Unit ID is set in the factory to 9263.

Network Setup Menu

NETWORK SETUP

Refer to “Configuring Ethernet Connections” on page 83 and “Internal Modem Connections” on

Unit ID for COMT is based on the meter’s serial number. For example, if the serial number is

There are two main parameters that you must set or verify if your meter is

RETURN connected to an Ethernet network: IP address and Subnet mask address.
IP ADDRESS
MASK
: 2\ NoTe

There are other parameters, such as GATEWAY ADDRESS and SMTP ADDRESS, that are used in advanced
configuration or in fine tuning your system. The parameters discussed here are the most common

parameters required to get your meter communicating.

© 2009 Schneider Electric. All rights reserved.
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The default configurations for the network settings are as follows:

Setting Description Default
IP Address Sets the IP Address for the meter None
Used if subnet masking applies to your network
Mask — see your Network Administrator to determine if Subnet Mask is None
used

Used in multiple network configurations

Gateway — see your Network Administrator to determine if Gateway is used None
Sets the IP Address for the SMTP Mail Server that is
SMTP configured to forward mail from the meter to the final destination None
Address — see your Network Administrator to determine if the SMTP Mail
Server is used
S.MTP Specifies the connection timeout for the SMTP Server 1 minute
Timeout

Most network settings can be configured through the front panel; all network
settings can be modified in ION Enterprise or ION Setup software.

CAUTION

Configuring the IP Address, Subnet Mask, and Gateway registers incorrectly can cause network
disruptions. See your network administrator for more information.

Typically, your Network Administrator will provide you with the appropriate IP
Address for the meter. The Subnet Mask and Gateway settings are only required
if you have communications between multiple Ethernet networks and if
subnetting is implemented.

Use the Navigation buttons to edit the values of the network settings so that they
match your system addresses. As you configure the network addresses, the front
panel automatically discards unnecessary leading zeroes from each three-digit
grouping. The hidden leading zeroes appear (and disappear again) as you move
the position of cursor across the network address.

89.123.40.[156

In the example above, the highlighted zero is discarded as soon as you change the
position of the cursor.
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8600 SETUP

NETWORK SETUP
O ENESSIEA| - [ FORMAT SETUP
DISPLAY SETUP [ ¢3= RETURN

I Fx4 (" PHASE LABELS

PF SYMBOL

8600 SETUP
FORMAT SETUP

DISPLAY SETUP
SECURITY

CONTRAST

Format Setup Menu

Format Setup contains the following values that set labeling and formatting

preferences.

Menu ltem

Description

Phase Labels

ABC, 123, RWB, RYB, XYZ, or RST

PF Symbol

Power Factor Symbols can be: LD/LG, +/-, or CAP/IND.

Digit Group

Numbers of three digits or greater can be grouped in any of the following
three formats: 1000.0 (no commas, no spaces) or 1,000.0 (commas, no
spaces) or 1 000.0 (no commas, spaces).

Date Format

The date can be expressed in any of three formats: DD/MM/YYYY, YYYY/
MM/DD, and MM/DD/YYYY.

Show DST

You can choose to display Daylight Savings Time (DST) or not.

Volts Decimal,
Current Decimal,
and Power Decimal

You can have voltage, current, and power measurements shown to one, two,
or three decimals of accuracy. The default value is two decimals of accuracy.

Display Setup Menu

You can configure the following display preferences within Display Setup.

Menu ltem

Description

Update Rate

The front panel can update its data from every one to every six seconds. The
default update time is one second.

Contrast

A front panel display contrast level can be set from zero to nine where higher
numbers represent a sharper level of contrast. The default level is five. The
contrast level may be adjusted at any time by pressing and holding down
both Up and Down arrow buttons simultaneously.

Backlight Timeout

This selection allows you to make the backlight turn off automatically after
zero to 7200 seconds (two hours). The default is 300 seconds (five minutes).
If this value is set to O (zero), the backlight will always be on.

DMD Lock

Demand lockout time (in seconds) controls the minimum allowable time
between consecutive demand resets. You may select values from O (disabled)
to 5184000 (60 days). The default is 216000 (25 days).

TEST mode TO

If there are no front panel key presses, the meter will exit TEST mode
automatically; the TEST mode time-out setting defines how long the meter
remains in TEST mode before switching to norm mode. While in TEST mode,
the value on the bottom right of the status bar indicates the amount of time
before TEST mode times out. The default TEST mode time-out value is 30
minutes.

Display Scale

Scale applied to values before they are displayed. Default is 1000.

Scaling Mode

Specifies whether values are divided or multiplied by the Display Scale before being
displayed. Default is Divide.

Delta Vectors

Specifies how vector diagrams are displayed when in Delta mode. Default setting is
Instrument.

© 2009 Schneider Electric. All rights reserved.
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8600 SETUP
DISPLAY SETUP

RETURN

SECURITY e

DISABLE SECURITY

Press SECURITY
\ <*>- RETURN
: |:~%'s&| MODIFY PASSWD

Security Menu

The settings in the front panel Security menu item allow you to:
¢ modify the existing meter password or reset it to the factory default.
¢ disable the password security check.

¢ enable web browser configuration on the meter.

You require the valid password to enter the Security Settings menu. The default
password is 0 (zero).

See “Meter Security Features” on page 52 for more details.

2\ NoTe

The password enables users to change the configuration of the meter. It is recommended that you change

your password from the default when you put the meter into service

If you have not yet entered your password, the meter’s front panel requires that
you enter it before you can view the Security Setup menu. Use the Navigation
buttons to enter numerical data. If you enter an incorrect password, the front panel
will display an “invalid password” message and you will have to try again.

Modify Password Sub-Menu

Use this sub-menu to change the password, or to reset the password to the factory
default (0).

From the meter’s front panel select SECURITY, then MODIFY PASSWORD. Two choices
appear: MODIFY PASSWORD or FACTORY DEFAULT. Use the Up button to select
MODIFY PASSWORD, or the Down button to select FACTORY DEFAULT.

Changing a password
¢ To change the value of a highlighted digit, use the Up or Down arrow buttons.

¢ To change the position of the cursor one space to the left, press the Up arrow
button for about one second.

¢ To change the position of the cursor one space to the right, press the Down
arrow button for about one second.

¢ When the correct password is displayed press Alt/Enter.

Disable Security Sub-Menu

Use this sub-menu to enable and disable password security on the meter.
Disabling the password allows changes to all the meter’s settings through the front
panel without a security check.

CAUTION

Non-secure access to critical settings in the meter, such as PT and CT ratios, is not advisable. It is highly
recommended that any meters in the field have the password security check enabled.

Page 38
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When you re-enable password security, the password is reset to the factory default
of 0 (zero). You should re-enter a custom password at this point.

Disabling the Password Security Check is necessary to write to the meter when it
is a Modbus Slave device. Refer to “The Meter as Modbus Slave” on page 97 for
details about configuring your meter for third-party systems.

Web Config

Use this setting to enable/disable web browser configuration of the meter. See
“Enabling and Disabling Web Config Access” on page 56 for more details.

© 2009 Schneider Electric. All rights reserved.
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Templates and Firmware

Your meter comes installed with a pre-configured default template. This template
contains various frameworks which provide all the power measuring and
analyzing functionality of the meter. Templates and frameworks can be used
immediately without any user configuration (“right out of the box”). They can also
be customized, reconfigured, and pasted from one meter to another.

For more information on templates, frameworks and ION modules, see the
ION Reference.

Your meter’s operating system is known as firmware. When newer firmware is
available for your meter, simply upgrade to the latest version for all the added
features and functionality.

In this chapter

¢ FactoryInformation ............ ... ittt 42
Factory Module Settings ............ ... ... ... ... ... 42

Howto TAG YourMeter .......... ... .. 42

# Restoring the Factory Configuration . ..............cooiiiiin.t, 43
Using the frontpanel .............. .. ... ... ... . i 43

Using ION Setup ... 43

Using Designer .......... ..o 44
Upgrading Your Meter ......... ... ... i 45

© 2009 Schneider Electric. All rights reserved.

Page 41



Chapter 3 - Templates and Firmware

PowerLogic ION8600 User Guide

Factory Information

The Factory module displays firmware version, serial number and other device
information in either read-only setup registers (read-only registers can be viewed
but not changed), along with configurable information in read/write setup
registers.

Factory Module Settings

The device information provided is as follows:

Setup Register Description
Device Type A device type identifier (e.g. “8600" for the ION8600)
Compliance A statement of whether the device is ION compliant or not
Options Shows model number of meter
Revision The meter’s firmware version
Serial Num The meter’s serial number
ION Version The ION version supported by the device
Template The name of the template (framework) installed on the device at the factory
Nom Freq The expected frequency of the power system being monitored
MAC Address Media Access Control address.’

! The MAC address of your meter cannot be changed, and is for information only.

The Factory module also holds the alternate PT and CT values, which can scale
operational values on revenue-locked meters (refer to “Scaled Operational Values”
on page 70), and numerous read-only setup registers that hold the calibration
constants used at the factory.

How to TAG Your Meter

Three configurable read/write setup registers are provided for you to enter your
company name and other text information you want stored in the meter:

Owner - This is a text register for storing user information (e.g. company name); it
can be up to 255 characters in length.

Tag 1 - This is a text register for storing user information (e.g. device location); it
can be up to 15 characters in length.

Tag 2 - This is a text register for storing user information (e.g. device number or
identifier); it can be up to 15 characters in length.

2\ NoTe

Tag 2, if entered, is used as the default MV-90 Device ID. Refer to the MV-90 and ION Technology
technical note for more information.
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Restoring the Factory Configuration

If you have made changes to the default meter template and want to return to the
factory configuration, you can re-initialize the factory configuration in the meter
using ION Setup or ION Enterprise software. The basic setup of the device can be
retained, so the meter does not need to be taken out of service for a long period of
time.

2\ NoTe

If you restore the factory configuration, all custom features (such as custom alarms, custom data
recorders) you have created are lost, as well as all recorded data.

Using the front panel

You cannot restore the factory configuration from the meter’s front panel.

Using ION Setup

1. Download your meter’s factory template from www.powerlogic.com.
Save the .DCEF file.
The default template file location is .../JION Setup/TEMPLATE folder.

2. Connect to your meter in ION Setup, using Basic Mode.
3. Navigate to Setup Assistant > Template.
4. Select the Send to Meter tab and click the Send button.

Setup Assistant E
= Template Saveto PC Sendto Meter | Firrnware Upgradel Register Editl
= Baszic Setup

= Security Sends a previously stored meter configuration file [.DCF) into an 10N

[Z] Communications [

== Clock
== Demand
(C Inputs/Outputs
Z1 Logging FACT DeviceType FH00
(C1 Revenue Eﬁg} E‘E\_"islﬁn ;5Kﬂg‘;"1250
Power Lualy FAC] Template. 7500 (E 160,00
g Verilication FACT Default Template 7500 |
= Reports

WL

< Back | Mest » Exit Help

5. The Open ION8600 DCF file window appears. Navigate to where you have
stored the downloaded .DCF file.

6. Select the .DCEF file and click OK.
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7. The Template Paste Options screen appears. Select the check boxes for the
settings you want to retain (not overwrite) and click OK.

Template Paste Options E

— Mewver o

Comm Settings
Security Settings
Log kil Modules

— Alzo, retain the following

[ PTACT Settings
[ Clack Settings
[ Mameplate Settings

ak. I Cancel | Help |

Rapid Meter Programming pastes the template onto your meter. A dialog box
confirms the paste was successful.

Using Designer
1. Display the meter’s main Configuration screen in Designer.
2. Click Select All from the Edit menu, then press Delete.

The confirmation dialog box appears explaining that some modules will not be
deleted (core modules cannot be deleted — scroll down in the dialog to see
which standard modules will be deleted).

3. Click OK on the confirmation dialog box.

After a brief wait the modules are deleted, and the main meter Configuration
screen is blank except for the Frameworks folder in the Advanced Setup area.
(The Frameworks folder contains the folder of core modules which cannot be
deleted.)

4. Click Edit > Select All to select the Frameworks folder. This selects all
sub-folders and modules within the folder.

5. Click Edit > Paste from Framework, then select the appropriate .fwn file from
the folder \ION Enterprise\ config\ fmwk\nd\. Click OK.

The Factory module’s Default Template register tells you the filename for the
default factory framework. (For details about framework files, contact Technical
Support or visit the Support area of www.powerlogic.com)

6. Click Open. The Paste Summary window appears.

7. Click on the first module, scroll down to the last module, hold the Shift key and
click on the last module. This selects all of the modules.

8. While holding the SHIFT key, click on the check box to the left of the module
name so you see a lock icon with a green check mark.
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2, NOTE

Persistent modules can be overwritten in Designer. When pasting a default framework onto a meter, use
lock-paste on the Persistent modules, not free-paste. A list of Persistent modules is available from
Technical Support.

9. Check “Maintain external inputs” and click OK on the confirmation dialog box.

A message appears indicating that Designer is pasting modules. All modules are
selected when the paste is complete. Click anywhere in the background of the
node diagram to deselect all of the modules.

10. Click the Power Meter shortcut in the Basic Configuration area to select it. Once
selected, click Reset in the Designer toolbar, or select Edit > Reset. This reverts
the Power Meter to the settings it had before you deleted any modules (retaining
your original basic setup).

11. Click File > Send & Save from the File menu. The factory configuration is now
restored and any custom functionality you created is removed.

2\ NOTE

The time required to complete steps 3, 5, and 11 may vary depending on your connection and the meter
configuration.

Upgrading Your Meter

See the Upgrading ION Device Firmware technical note for details.
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Basic Setup

This chapter explains how to perform basic meter setup via the front panel and
using ION Enterprise or ION Setup software.

In this chapter

@ Infroduction ...t 48
Configuring BasicSetup ........... ... i i 48
Using the FrontPanel ........... ... .. ... ... ... .. i i i i, 48

Using ION Setup ... 48

Using Designer ................ . i 49

Power Meter Module Settings .................... .. ... .. .. ... 50
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Introduction

Basic configuration of the meter is provided by the Power Meter module. The
Power Meter module is the main connection between the power system
measurements and all other ION modules in the device. This module reports the
values for all voltage, current and power measurements. The Power Meter
module’s setup registers describe details of the power system being monitored.
Many of the Power Meter module’s setup registers are configured when the meter
is initially put into service, although the device cannot operate properly until the
Volts Mode and PT and CT ratios are set. Some registers may need to be changed
to refine the device’s operation. See the ION Reference for more details on the Power

Meter module.

Configuring Basic Setup

Use the front panel or ION Enterprise or ION Setup software to perform basic

meter setup.

Using the Front Panel

The Basic Setup menu item provides access to the following power system settings.

Menu Setting Description Range (Values) Default
9S 4W-WYE/DELTA
Volts Mode The power system’s configuration — WYE, DELTA, etc. 3553 Wire 4W-WYE
36S 4 W-WYE
DEMO
PT Primary The Potential Transformer’s primary winding voltage rating 1 t0 999,999,999 120
PT Secondary The Potential Transformer’s secondary winding voltage rating | 1 to 999,999,999 120
CT Primary The Current Transformer’s primary winding current rating 1t0 999,999,999 5
o CT Secondary The Current Transformer’s secondary winding current rating 1 t0 999,999,999 5
2 |4 CT Primary Primary rating for the 14 current transformer (if available) 1.0 - 999,999.00 5
% 14 CT Secondary Secondary rating for the 14 current transformer (if available) 1.0 - 999,999.00 5
E VA Polarity The polarity of the Potential Transformer on VA Normal or Inverted Normal
VB Polarity The polarity of the Potential Transformer on VB Normal or Inverted Normal
VC Polarity The polarity of the Potential Transformer on VC Normal or Inverted Normal
IA Polarity The polarity of the Current Transformer on 1A Normal or Inverted Normal
IB Polarity The polarity of the Current Transformer on IB Normal or Inverted Normal
IC Polarity The polarity of the Current Transformer on IC Normal or Inverted Normal
14 Polarity The polarity of the Current Transformer on 14 Normal or Inverted Normal
Phase Rotation Power system’s phase rotation ABC, ACB ABC

Using ION Setup

The Basic Setup Assistant helps you configure the Power Meter module:

1. Open ION Setup and connect to your meter, using Basic Mode.
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2. Inthe Setup Assistant, navigate to Basic Setup and click on the PT/CT Ratios tab.

Setup Assistant E
PT/CT Ratios | Nameplate Infol Holloverl

Security Blloves you to program PT and CT ratios.
[Z] Communications

Clock.

Demand

(2 Inputs/Outputs

(Z] Logging Fhi1 Volts Mode  44WWYE

Power Cuality Em Q grim Eg

Flevenue PMICT Pim 5

== ‘erification PM1 CT Sec 5

Reports FhA1 14 CT Prim 5

PH114CT Sec &
Scale Rev Param OM

Edit |

< Back | Mest » | Exit | Help |

3. Configure each register as required by selecting the parameter and clicking Edit.

Using Designer

Open your meter in Designer and navigate to the Basic Configuration Framework.
Right-click on the Power Meter module to edit.
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Power Meter Module Settings

RZ;:::: . Function Default
Volts mode ! | The power system’s configuration — WYE, DELTA, Single, etc 4AW-WYE
PT Prim ! The Potential Transformer’s primary winding rating for V1, V2 and V3 120
PT Sec ! The Potential Transformer’s secondary winding rating for V1, V2 and V3 | 120
CT Prim ! The Current Transformer’s primary winding rating for 11, 12 and I3 5
CT Sec ! The Current Transformer’s secondary winding rating for 11, 12 and I3 5
V4 Prim ! The Potential Transformer’s primary winding rating for V4 120
V4 Sec ! The Potential Transformer’s secondary winding rating for V4 120
14 CT Prim ! | The Current Transformer’s primary winding rating for 14 5
14 CT Sec ! The Current Transformer’s secondary winding rating for 14 5
I5 CT Prim ! The Current Transformer’s primary winding rating for 15 5
I5 CT Sec ! The Current Transformer’s secondary winding rating for 15 5
Vn Polarity The polarity of the Potential Transformer on Vn Normal
In Polarity The polarity of the Current Transformer on In Normal
Phase Order | The expected rotation of the voltage phases (ABC or ACB) ABC
Phase Lbls ;\F}\?Bp:ro:;e;gc)ibel format assigned to the outputs (ABC, RST, XYZ, RYB, ABC

! The registers are typically set when the device is commissioned. Changing the values of these registers
while the device is in service is not recommended.

Once basic setup is performed (i.e. the PT/CT and Volts mode settings), the meter
operates properly. Typically there is no need to make further changes to the Power
Meter module’s setup registers.
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Security

IONB8600 meters offer standard and advanced meter security. Standard security is
enabled by default from the factory; procedures for changing these security
settings using the front panel and ION Setup or ION Enterprise software are
detailed in this chapter. Advanced security, which allows up to 16 users, each with
unique access privileges, is discussed as well as some security features available
for revenue meters. The scaled operational values (SOV) feature, which allows
scaling of non-revenue data on revenue-locked meters, is described in this chapter.

In this chapter

& Meter Security Features . ... ..ottt i i i 52
¢ Standard Meter Security . ..... ...ttt i 53
Configuring standard meter security using the front panel ............. 53
Entering the Password .............. ... .. ... ... il 53
Changing the Password ................. ... .. ... ...l 54
Enabling & Disabling the Password Security Check ................... 55
Resetting the Password ............ ... ... o i i i 56
Enabling and Disabling Web Config Access .......................... 56

Time Synchronization Security Considerations . ....................... 57
Configuring standard meter security in ION Setup .................... 57
Configuring standard meter security in Designer ...................... 59

& Configuring Advanced Meter Security ...........cciviiiieinnnnn.. 61
Device Security Access for ION Services .............. ..., 65

& Additional Revenue Metering Security . ...l 67
Hardware Lock Security Option ............ ... .. .o, 67
Anti-Tamper Sealing Methods .................... .. ... ... ......... 69

# Scaled Operational Values .................ciiiiiiiiiii.... 70
Configuring Scaled Operational Values ........................ ... . ..., 72
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Meter Security Features

Your meter includes the following security features:

Standard meter security

Anytime you make configuration changes to your meter you must enter a
password. See “Standard Meter Security” on page 53.

Advanced meter security

This level of security allows configuration of up to 16 users, each with unique
access rights to the meter. See the topic “Configuring Advanced Meter Security”
on page 61.

Revenue meter security

Your revenue meter can be protected by anti-tamper sealing. See “Additional
Revenue Metering Security” on page 67.

Software security

ION Setup and ION Enterprise software security brings access-level security to the
meter. With ION Setup and ION Enterprise software, you can configure multiple
users with different passwords and specify access rights. ION Setup and ION
Enterprise software security only applies to users who are accessing the meter
using this software.

For more information on ION Setup and ION Enterprise software security, refer to
the ION System Security technical note.
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Standard Meter Security

Standard meter security is enabled by default on all ION8600 meters; all
configuration functions are password-protected. The password is factory-set to 0
(zero).

¢ If you make configuration changes to the meter via the front panel, the meter
prompts you for its password before accepting any configuration changes.

¢ If you make any configuration changes via ION Setup or ION Enterprise
software you are prompted by the meter for its password (in addition to the
password used to access the software).

Once you enter the correct meter password and confirm the new configuration, the
change is set on the meter.

Configuring standard meter security using the front panel

When modifying values using the Setup menu on the front panel of the meter, you
will be prompted for the meter password before you make your first configuration
change. You will not need to re-enter the password for each subsequent change.
However, if you perform no additional configuration changes for five minutes,
you will need to re-enter the Setup menu and provide the valid meter password to
resume making changes. This is because the meter returns from setup mode to
data display mode after five minutes of inactivity.

This section describes the password security options available to front panel users.
Step by step instructions are provided on the following procedures:

1. Entering the meter password

2. Changing the meter password

3. Disabling (and Enabling) the password security check

This section also presents security precautions to consider when configuring time
synchronization and third party protocols.

Entering the Password

The first time you attempt to change any setting, you will be presented with the
password screen (shown below). After you have entered the correct password, you
will not have to re-enter it for other any other changes unless you exit the
configuration session.

ENTER PASSWD

0000000E

MIN: MAX:
00000000 99999999

HOLD ARROW KEY TO ADVANCE CURSOR
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To enter the password:

1.

To change the value of the highlighted digit, use the arrow buttons. The up
arrow increments the number and the down arrow decrements it.

To change the position of the cursor, hold down an arrow button for about one
second. The up arrow moves the cursor left one position, and the down arrow
moves the cursor right one position.

Once you have the value you want, press the Alt/Enter button.

Changing the Password

By default, the password is set to 0 (zero) in the factory. The password may be
changed to any eight-digit number. It is highly recommended that you change the
password from the default value. To change the password:

1.
2.
3.

Hold down the Alt/Enter button to access the Setup menu.
Scroll through the menu items using the arrow buttons, highlight SECURITY.
Press the Alt/Enter button to select SECURITY.

Press and Hold

8600 SETUP

ALT/

ENTER RETURN Press
BASIC SETUP [ <A
DEMAND SETUP —<>, SECURITY
COM1 SETUP | enter
e COM2 SETUP RETURN
COM3 SETUP MODIFY PASSWD
FORMAT SETUP
9L, biSoLAY SETUP DISABLE SECURITY
.

You are prompted to enter the current meter password (see “Entering the
Password”, above). Once you enter the password, you are presented with the
“MODIFY PASSWD” screen, as seen below:

MODIFY PASSWD

0000000H

MIN: MAX:
00000000 99999999

HOLD ARROW KEY TO ADVANCE CURSOR

To change the value of the highlighted digit, use the arrow buttons. The up
arrow increments the number and the down arrow decrements it.

To change the position of the cursor, hold down an arrow button for about one
second. The up arrow moves the cursor left one position, and the down arrow
moves the cursor right one position.

Once you have the value you want, press the Alt/Enter button. You will be
prompted for your current password before the new password is saved.
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Enabling & Disabling the Password Security Check

Disabling the password allows changes to all the meter's settings through the front
panel without a security check. This procedure may only be necessary if the
communications interface you are using does not support the meter’s security
protocols.

CAUTION

Non-secure access to critical settings in the meter, such as PT and CT ratios, is not advisable. It is highly
recommended that any ION8600 devices in the field have the password security check enabled.

Disabling the Password Security Check

Follow these steps to disable the password security check:

1.

Press the Alt/Enter button to enter the Setup menu. Scroll down the menu with
the arrow button. Press Alt/Enter again when SECURITY is highlighted.

Enter the valid meter password at the password prompt. You are then presented
with the Security menu.

Scroll down and highlight the DISABLE SECURITY menu item and press the
Alt/Enter button.

la 24011
Ib 2951.3 i
lc 2291.7 1
A | |In 102.1 1A

Press and Hold

8600 SETUP
RETURN Press

18300 1969.0601 ABC Q1 NORM [ 500m BASIC SETUP _€—
I DEMAND SETUP N/, SECURITY
COM1 SETUP ENTER
Ny COM2 SETUP RETURN
— y Fggm ngygp MODIFY PASSWD
L DispLaY SETUP DISABLE ECURlTY
:

Select PROCEED, then select YES at the following prompt.

DISABLE SECURITY

RETURN

ALT/
ENTER

A message appears on screen notifying you of how to re-enable password
security (refer to “Enabling the Password Security Check”, below). Your meter’s
password is now disabled; changes to settings in the meter do not require a valid
password.

Press the Alt/Enter button to return to the Setup menu.

© 2009 Schneider Electric. All rights reserved.
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Enabling the Password Security Check

When you re-enable the password security, you are required to enter a new
password. To re-enable password security:

1. Press and hold down the Alt/Enter button to enter the Setup menu. Scroll
down the menu and select SECURITY.

2. From the Security menu, select MODIFY PASSWD, and press the Alt/Enter
button. The Modify Password Screen appears.

3. The message FAC DEFAULT appears in the middle of the Modify Password
screen. If you want to use the factory default password, press the Alt/Enter
button. If you want to set the password to a different eight-digit number, use the
instructions in “Changing the Password” on page 54.

4. Once you have entered your new password, press the Alt/Enter button.
5. Select YES to confirm the change and return to the Setup menu.

The password security check is re-enabled, and all changes to the device's
configuration require the new meter password.

Resetting the Password

In the event that you forget or lose your meter password, you can reset the
password to the factory default value of 0 (zero). Resetting the password requires
that the meter be in TEST mode.

¢ If your meter has the Password Security check disabled, you can invoke TEST
mode using ION Setup or ION Enterprise software.

¢ If your meter has the Password Security check enabled (or your meter has the
hardware lock security option) you will have to remove the meter's outer cover
to access the TEST mode button.

Refer to “Switching to TEST Mode” on page 185 for details on invoking TEST
mode.

Follow these instructions to reset the password to the factory default:

1. Put your meter into TEST mode.

2. Once your meter is in TEST mode, press and hold down the Alt/Enter button
and Demand Reset button simultaneously.

A message appears on screen: PASSWORD RESET PASSWORD SET TO
DEFAULT. Password Security is now enabled; the meter password is 0 (zero).

Enabling and Disabling Web Config Access

By default, remote configuration of the device via web browser is enabled. Follow
these steps to enable or disable your meter’s web configuration access.

1. Press the Alt/Enter button to enter the Setup menu. Scroll down the menu with
the arrow button. Press Alt/Enter again when SECURITY is highlighted.

2. Enter the valid meter password at the password prompt. You are then presented
with the Security menu.
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3. Scroll down and highlight the WEB CONFIG menu item and press the Alt/Enter
button.
4. Select “Enabled” or “Disabled” as appropriate.
5. Confirm the change and select RETURN to go back to the Setup Menu.
8600 SETUP
RETURN pres
SSCSTE | &S SECURIY
COM1 SETUP ENTER RETURN WEB CONFIG Press
COM2 SETUP
COM3 SETUP , <<>- CONFIRM CHANGE
FORMAT SETUP RETURN R
_D'SPUP : Enabled NO

Time Synchronization Security Considerations

Depending on ION Setup or ION Enterprise software security settings, a
workstation that connects to an ION8600 device may send a time synchronization
signal to synchronize the meter's internal clock with the workstation's clock. This
could cause overlaps in the Demand intervals, and timestamps in the data logs
may not be accurate.

The Time Sync Source setup register, located in the Clock module, identifies the
only communications port that will accept time synchronization broadcasts. You
can configure this setup register through ION Setup or through the Designer
component of ION Enterprise.

Refer to the technical note Time Synchronization & Timekeeping for more
information on implementing time synchronization.

Configuring standard meter security in ION Setup
1. Launch ION Setup with Supervisor authority.

2. Connect to your meter, using Basic Mode

3. Inthe Setup Assistant, navigate to Security.

4. Select Security Mode from the Security tab and click Edit.
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Setup Assistant E

= Template Security |
= Baszic Setup
== Security Indicates what type of security i operating.

(2] Communications

Edt | send |

< Back | Mext » | Exit | Help |

5. In the Open File dialog, select the Standard.scf file and click Open to edit.

Open ﬂ!!i
Look jn: IE} Security j - £k B

Advanced
Standard

File name:

Cancel

Help /L

Standard. scf] j DOpen
|

Filez of type: ISecurity Configuration File [* 5CF)

6. On the configuration screen, select the check boxes of the security options you
want enabled. Some options may be disabled (greyed out) because of existing
security settings.
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To change the password, enter a new meter password and then confirm it by
entering it again.

Standard Options [ %]

— Step 2 Configuration Option:

Select the zecurity options you wish to employ.

Mew Password: I" Confirm Password: I"

¥ Active Web Server

¥ &llove ‘w'eb Server programming I~ Secure Web Page Yiewing

¥ &llow Modbus programming [+ &llovs Front Panel programming

¥ &llow Broadcasting Time Synchionization

< Back I Finizh I Cancel Help

CAUTION

Changing communications port settings with the Allow Front Panel Programming setting cleared
(unchecked) may cause loss of communications with your meter, and render it inoperable. In this case a
factory reconfiguration of your meter is required, which resets your meter to its factory defaults and
destroys all logged data.

7. Click Finish when you are done.
8. When prompted, you can choose to save your security settings in a file.

¢ Click Yes, enter a new name for your security file and click Save. If you want
to overwrite your default standard security file, select Standard.scf and click
Save.

+ Click No if you do not want to save the changes.

Configuring standard meter security in Designer
1. Launch Designer with Supervisor access.

2. Select Options > Show Toolbox if the toolbox is not displayed.
3. Select Options > Change Standard Meter Security...

Options

Enable Autalinking
Wiew Diagram Tesxt
Change Standard Mete
Edit TOU Programs. ..
Show Default Labels
v Show Toolbos
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4. Enter the meter password when prompted. You must enter the existing meter
password before you can change security settings (the default is zero).

Standard Meter Security |

Enter the meter paszword for MewF acility, PFC

zer name:  Default

Paszward:

ok, Cancel

5. Type a new numeric password and confirm by re-typing the password in the
fields (see image below). If you are sure you want to disable standard security,
click the Disable Standard Meter Security check box.

Change Standard Meter Security

Enter a new pazaword for MewF acilip. PPC

Ilzer name: Drefault

Password: Il

Confirm Pazsward: I

[T Disable Standard Meter Pazzward

ok Lancel

CAUTION

Do not disable security unless it is absolutely necessary. Disabling standard security leaves your meter
configuration open to tampering (intentional or unintentional) through communications and the front
panel.
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Configuring Advanced Meter Security

Advanced meter security is available on ION8600 meters. This level of security
allows configuration of up to 16 users, each with unique access rights to the meter.
Access rights consist of the following:

¢ Read: view any parameter except the security configuration.

¢ Peak Demand Reset: perform a reset of peak demand values (for example,
sliding window demand for kW, kVAR, kVA etc.).

¢ Timesync: set the time on the meter.

¢ Full Meter Configuration: configure any programmable register on the meter
except for registers related to the security setup, registers that result in a demand
reset, or actions that place the meter in test mode.

¢ TEST Mode: put the meter into test mode.

¢ Advanced Security Configuration: configure advanced security for the meter,
full meter configuration must also be set to YES.

When configuring users, in most cases you must set Read access to YES. However,
you can set up a user without read access; for example, you may want to create a
user who can only timesync the meter. In some cases (such as advanced security

configuration access) you must set multiple access options to YES. When you are
configuring advanced security, the software rejects unacceptable or unsecure user
configurations.

2\ NOTE

Use only ION Enterprise or ION Setup (version 1.1 and later) to configure advanced security. ION Setup

has a Setup Assistant that guides you through advanced security setup.

Entering an advanced security user name and password

When you attempt to view data or make a change to a meter that has advanced
security enabled, you are prompted for a user name and password.

Advanced Meter Security

% Enter a valid user and pazsword for Electric. Compary

Uszer name: I

Pazsword: I

Qg Lancel |

1. Enter the valid advanced security user name.

2\ NOTE

User names are fixed as USER1 through to USER16.

2. Enter the appropriate password and click OK.
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Configuring advanced security using ION Setup

If you are using ION Setup software follow the instructions below.

1.

2
3.
4

5.

Launch ION Setup with Supervisor authority.

Connect to your meter, using Basic Mode

In the Setup Assistant, navigate to Security.

Select Security Mode from the Security tab and click Edit.

Setup Assistant E

= Template S

= Baszic Setup

ecurity |

== Securty
(2] Communications

(27 Inputs/Outputs
(C1 Loaging

(Z] Revenue

== Alarming

= Power Quality
= Displays

= Werification

= Reports

Indicates what type of security iz operating.

5 vode  Standard
Hardware Lock Dizabled

W

Edt | send |

< Back | Mext > |

Bit | Hep |

In the Open File dialog, select the Advanced.scf file and click Open to edit.

Open

Look im: I 159 Security

[

[ 21 %]
« & £f EE-

E' | Standard

File name:

Filez of type:

IAdvanced.scf

j E . Open I

I Security Configuration File [*.SCF)

j Cancel |
I

6. On the configuration screen, select the check boxes of the security options you
want enabled. Some options may be disabled (greyed out) because of existing

security settings.
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To change the password, enter a new meter password and then confirm it by

entering it again.

Advanced Dptions [ %]

— Step 2 Configuration Option:

Select the zecurity options you wish to employ.

—I¥ Front Panel password

Mew Password: Ii Confirm Password: I"

¥ Active Web Server

¥ &llove ‘w'eb Server programming V' Secure Web Page Yiewing

v &llows Modbus programming

v &llow Broadcasting Time Synchionization

[+ &llovs Front Panel programming

< Back Mest » Cancel Help

CAUTION

Changing communications port settings with the Allow Front Panel Programming setting cleared
(unchecked) may cause loss of communications with your meter, and render it inoperable. In this case a
factory reconfiguration of your meter is required, which resets your meter to its factory defaults and

destroys all logged data.

7. Onthe second configuration screen, select the check boxes of the users you want
to configure (1 through 16). Select the appropriate access for each user.

Define individual users/passwords

— Step 4: Advanced Security

[refine each uzers rights by selecting the appropriate check boxes and for
each user, enter in a password.

[ Time Sync Access
Read Access
[ Peak Demand Reset Access
- [ Test Mode Access

- [ Full Meter Config Access
[ Security Corfig Access

il

- Passward |

< Back I Finizh I Cancel |

Help
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8. Select a user, then click Password to set a password for that user. Click OK.
When you have assigned passwords to all the users, click Finish.

Define individual users/passwords

— Step 4: Advanced Security

[refine each uzers rights by selecting the appropriate check boxes and for
each user, enter in a password.

;I Password |

Advanced Meter Security [ %]
Mew pazsword: I

Confirm new password:

g — ()3 I Cancel | Help |
KIN

< Back | Finizh | Cancel | Help |

9. When prompted, you can choose to save your security settings in a file.

¢ Click Yes to enter a name for your security file then click Save. If you want
to overwrite your default advanced security file, select Advanced.scf and
click Save.

¢ Click No if you do not want to save the changes.

Configuring advanced security using ION Enterprise

If you are using Designer software follow the instructions below.

1. Launch Designer software with Supervisor access. Select File > Open and
select the meter you want to configure with advanced security.

2. If the toolbox is not displayed, select Options > Show Toolbox.

3. If you do not want to allow front panel programming using the standard
security meter password then double-click on the Display Options module and
change the Front Panel Programming register to disallow.

CAUTION

Changing communications port settings with the Allow Front Panel Programming setting cleared
(unchecked) may cause loss of communications with your meter, and render it inoperable. In this case a
factory reconfiguration of your meter is required, which resets your meter to its factory defaults and
destroys all logged data.

2\ NOTE

If you allow front panel programming when you set up advanced security, the meter password (used in
standard security) is still active through the front panel. You may need to allow front panel programming
if someone installs the meter in the field and needs to make setup modifications. Once the meter is
installed, you can disallow front panel programming so that advanced security user names and
passwords must be used to view or change meter information.
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4. Double-click on the Meter Security Setup folder.

For each user you want to configure, drag out a Security User module from the
Toolbox, and modify the appropriate access level setup registers.

5. Click Change Password at the bottom left of the module setup screen to
configure a password. The default password is zero (0).

Click OK when you have configured the users.
6. Right-click on the Security Options module.

7. Double-click on any setup register and use the drop-down menu to change the
register setting or label.

You must set the Enable Advanced Security register to Enabled. Refer to the
Security Options module description in the ION Reference for more details.

8. Click File > Send & Save. Advanced security is now enabled on the meter.

Device Security Access for ION Services

Many ION Services need constant access to your network’s ION devices. These
services include the ION Log Server, the VIP and Site Server that perform the
following type of functions:

Service Function

ION Log Server Reads the ION meter Data Recorder or waveform modules and can
9 automatically rearm recorders that are configured as Stop-When-Full

Can be configured to read from a meter or perform control action
VIP . o
using Distributed Control.

Site Server Broadcasts time signals to the meter.

When Advanced meter security is enabled, these services may not have sufficient
access rights to perform their operations. You must specify a user with sufficient
access rights for these services.

2\ NOTE

You may want to configure a separate user for accessing services. If you encounter difficulties with ION
Setup or ION Enterprise software accessing the meter, it is likely that these services either do not have

access rights or the original user name and password have changed.

Allowing ION Services access to advanced security enabled meters (ION Enterprise)

1. Launch the Management Console and click Devices on the Management
Console’s System Setup Pane.

2. Highlight the ION device (or select multiple devices) with Advanced security
enabled, right-click and select Security... The following window displays.
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& Advanced Meter Security Settings E

These zettings are uzed by the software to gain access to a
% zecurty-enabled device.

I0N Services Access:

I~ Send Security Timesyncs to this device

Change Pazsword | ak I Cancel |

3. Select the user name you want from the drop down menu. Once you select a user
the Change Password button is active. Click the check box if you want to allow
this user to send time synchronization signals to the meter. Click OK.

4. Enter the valid password, re-type the password to confirm and click OK.

Allowing ION Services access to Standard security enabled meters (ION Enterprise)

ION Services automatically access standard security meters when the device
(meter) is added to the Management Console component of ION Enterprise.
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Additional Revenue Metering Security

To meet government regulations and utility security requirements, the ION8600
revenue meter incorporates additional security systems:

¢ a hardware-locked security system that prevents modification of revenue
quantities after the meter is sealed.

# traditional anti-tamper mechanical seals on the meter base unit and reset switch.

Hardware Lock Security Option

The hardware-locked security feature is an ordering option for some ION8600
meters that “locks” the ION module parameters specific to revenue data, so that
these parameters cannot be altered. This hardware lock is factory set; to make
configuration changes to billing parameters on a hardware-locked meter, you
must first place the meter in TEST mode. The TEST mode button is located under
the anti-tamper sealed outer cover, and the cover must be removed to access the
TEST mode button. This button cannot be activated remotely with a hardware
locked meter.

Press this button to
enter TEST Mode

4wv\m m
L@t el ||

SHIFT
) O
ALT/
SHIFT ENTER
DOWN

The hardware lock option, when combined with standard and advanced security
(front panel password), and physical anti-tamper sealing, offers the highest level
of security. Hardware locked meters operate as follows:

_——

¢ With the meter in normal mode, and with standard and advanced security
applied, ION modules that generate revenue data are locked and cannot be
altered. Users can modify unlocked ION modules depending on their level of
password-protected access through software or the front panel.

¢ With the meter in TEST mode (which requires removing the cover and breaking
the anti-tamper seals), users can modify ION modules depending on their level
of password-protected access through ION Enterprise or ION Setup software or
the front panel.
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Typical values that are hardware locked include:

& kWh, kVARh, kVAh delivered, received, del-rec, del+rec.

& kW, kVAR, kVA Sliding Window demand min and max values.
¢ Digital Outputs controlling the energy pulsing applications.

¢ All Power system settings, including PT and CT ratios.

Locked Module Listings

For a complete list of locked modules specific to your meter and its firmware,
please download the ION Device Templates help file from the
www.powerlogic.com website.
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Anti-Tamper Sealing Methods
The ION8600 meter uses the following anti-tamper sealing methods.

Demand Reset Switch Seal

The Demand Reset switch located on the front panel may be sealed by a wire seal
or lock inserted through the side of the switch. This seal does not have to be broken
to remove the meter's cover.

Socket Seals

A standard ANSI C12.7 type socket-sealing ring may be in place to hold the meter
to the socket. When removing the outer cover, the sealing ring must first be
removed. Some socket sealing rings facilitate wire seals.

Outer Cover Seals

The outer cover of the meter is factory sealed to its backplate with a T-type seal.
Depending on the installation, this seal may be inaccessible after the meter is
installed until you remove the device from the socket.

2\ NoTe

In certain countries the meter is no longer revenue certified if the anti-tamper seals are broken.

Socket sealing
Demand Reset ring.

Switch seal.

Outer cover
T-type seal.
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Scaled Operational Values

The scaled operational values (SOV) feature is only available for ION8600
firmware version v330 or later, for hardware locked meters where the Power Meter
module’s PT and CT ratios are 1:1. You will also need to update your meter
template and ION Enterprise device support to access this feature.

2\ NoTe

Meter firmware, templates and device support can be downloaded from www.powerlogic.com.

The SOV feature allows operational personnel to enter alternate PT and CT values
through the Vista component of ION Enterprise, in order to obtain scaled non-
revenue data for analysis. The alternate scaling registers are stored in the Factory
module and have a default value of one (1).

The Power Meter module’s PT and CT primary and secondary values are
compared against the Factory module’s alternate values by a series of Arithmetic
modules. The Arithmetic modules determine if the SOV feature is enabled (the
Power Meter module’s scaling ratios are all 1:1).

¢ If the SOV feature is disabled, the Arithmetic modules output the Power Meter
module’s PT, CT, 14 and kVA ratios.

& If the SOV feature is enabled, the Arithmetic modules output the alternate PT,
CT, 14 and kVA ratios. These ratios are applied to the outputs of the MU
(Metering Units) Power Meter module to generate scaled operational values.
The scaled operational values can be viewed and analyzed using the Vista
component of ION Enterprise and its reporting tools.

2\ NoTe

Scaled operational data can only be accessed through ION Enterprise.

The following diagram shows how scaled operational values are generated.

Al PT Prim
Factory Module e — : Two Arithmetic modules are used:
TP @ SetRatios1 and SetRatios2

Al PT P 240 iCTSec m Four Arithmetic modules are used:
Al PT 522;:30: — 120 4 Pim_m _ _ ScaledOpVals1 thru ScaledOpVals4
4 A7 Sec m Arithmetic e @
Module i — A4 ION Enterprise Server
Source - \

Arithmetic
T E PT Ratio = 2:1 i Module
Power Meter PTSec m Source
Module CT Prim W
r— Vina =60V
MU Power Meter @

Alt PT Primary = 1200 14 Prim B
Alt PT Secondary = 120 14Sec W

Module
Vina =30V
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1. Alternate PT, CT and I4 primary and secondary values are loaded into the first
series of Arithmetic modules.
Example: Alternate PT Primary = 240, Alternate PT Secondary =120

2. Power Meter PT, CT and I4 primary and secondary values are loaded into the
first series of Arithmetic modules.
Example: PT Primary = 120, PT Secondary = 120

2, NOTE

All the Power Meter module’s ratios must equal 1:1 to enable the SOV feature.

3. Because the Power Meter’s ratios are 1:1, the alternate scaling registers are used
to generate the PT, CT, 14 and kVA ratios, which are loaded into the second series
of Arithmetic modules.

Example: PT ratio =2:1

4. MU Power Meter per phase voltage, current and energy values, and total/
average voltage, current and energy values are loaded into the second series of
Arithmetic modules.

Example: VIna=30V

5. The second series of Arithmetic modules apply the PT, CT, 14 and kV A ratios to
the MU Power Meter values to output operational scaled values to your
ION Enterprise database.
Example: VIna=60V

The following 1-second data values are scaled by the SOV feature.

Vin a Vin b Vin ¢ Vin avg VIl ab

Vil be Vil ca Vil avg la I'b

lc | avg kW a kW b kW ¢

kW total kVAR a kVAR b kVAR ¢ kVAR total
kVA a kVA b kVA ¢ kVA total 14

The following are derived from scaled operational data values:
¢ Maximum/minimum,
¢ Historic high/low/mean, and

& Waveforms.

2\ NOTE

The Sag/Swell and Transient modules are not affected by the SOV feature. The nominal voltage register
in the Sag/Swell module must be set to the unscaled voltage value.

The Harmonics Measurement module outputs will only be scaled by the SOV
feature when the Display Mode register is set to Engineering units. No other
harmonics modules are affected.

Because total harmonic distortion (THD), total even harmonic distortion (TEHD)
and total odd harmonic distortion (TOHD) are expressed as percentages, these
values are not affected by the SOV feature.
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Configuring Scaled Operational Values

The alternate PT, CT and 14 values can be configured in the Vista component of
ION Enterprise.

1. Open your meter in Vista.

2. Navigate to the Power Quality tab and click the Setup icon to open the Power
Quality Setup screen.

3. The Power Quality Setup screen contains fields where you can enter the
alternate scaling register values, along with an indicator showing whether the
SOV feature is enabled or disabled.

2\ NOTE

The alternate scaling registers are set to one (1) by default.

4. Enter the alternate PT and CT values to provide the desired scaling.

When the SOV feature is enabled and the alternate PT and CT values are
configured (no longer equal to one (1)), the Vista screens indicate if the data values
displayed are scaled operational values or if the data values are not scaled.
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This chapter includes general instructions for connecting and configuring all the
communication ports on your meter.

For specific installation steps and meter specifications, consult your
ION8600 Installation Guide.

In this chapter
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Communications Overview

The following illustration shows all the possible connections to the
communications card.

Back view of ION8600

.| Communications
~| wiring on switchboard

1 n [ @
ocket or switchboard meter connections

Y \
Ethernet 10Base-FL:| | Modem on COM?2: | Serial COMs and Optional IRIG-B
Fiber connectors RJ11 or RI31 male | | Expanded I/O: Molex | | GPS Time Synch.
connector. See Micro-Fit 24 pin male
“Internal Modem connector. See
Connections” on “Communications
Sofbe’f (IJ_nIIY page 88. Options” on page 75.

Ethernet 10Base-T: RJ45
connector. See
“Configuring Ethernet
Connections” on page 83.

ANSI Type Il Optional communications Optional I/O Expander for serial
Magnetic Optical breakout cable for serial communications (and expanded 1/O).
Communications communications. Ordered Ordered and shipped separately. For
Coupler on COM3. separately. more information, see the ION8600
This port is located COMI1: RS-232 or RS-485. /O Expander documentation.
on the front panel. COM4: RS-485. Serial COMs Expanded 1/O
See “Configuring the See “Communications COMT1: RS-232 Eight Form A digital
Optical Port” on Breakout Cable” on or RS-485 inputs
page 82. page 81. Four Form C digital
COM4: RS-485 outputs (mechanical
relays)
Four Form A digital
outputs or four analog
outputs
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Communications Options

ION8600 meters have numerous communication possibilities depending on your
ordering preferences. Not all models have exactly the same communications
options available. Refer to the PowerLogic website for the latest ordering options

and documentation. All communications ports can be used simultaneously.

Socket and Switchboard Meters

Port Available Options Notes

COM1 RS-232 / RS-485 User selectable RS-232 or RS-485
Internal Modem RJ11 or .

COM?2 Maximum 57.6 kbps baud rate modem
Internal Modem RJ31

. ANSI Type Il optical port located at front of

COM3 Optical Port meter

COM4 RS-485

Network Ethernet RJ45 (10Base-T) Ethernet Fiber is only available on socket-style
Ethernet Fiber! (10Base-FL) meters, not switchboard.

! Onboard 1/O is not available with the Ethernet Fiber option.

Optional Switchboard Breakout Panel

sssss

POWER

Connector Type Available Comments
RS-485 Yes Captured wire connector
RS-232 Yes DB9 connector
Internal Modem RJ11 Yes RJ11 connector
Internal Modem RJ31 No RI3T connector
Ethernet RJI45 Yes RJ45 connector
Ethernet Fiber No This option available only on socket-style meters

Onboard I/O expansion Yes

Captured wire connector
(requires onboard expansion /O card)

@
@
@
©

IRIG-B Yes

Captured wire connector
(requires optional IRIG-B feature)

"

Auxiliary Power Yes

Terminal connectors
(requires one of the Auxiliary Power Options)

2\, NOTE

The COMs on an I/O Expander are not enabled when connected to a breakout panel. Use the RS-485

and RS-232 provided on the breakout panel.

Optional IRIG-B GPS Time Synchronization

IRIG-B cannot be configured via the meter’s front panel. See the IRIG-B Product
Option document for configuration procedures.
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Communications Accessories

The following accessories are currently available as separate products:

1/0 Expander

The PowerLogic I/O Expander connects with the male Molex connector on the
meter to provide I/O capabilities as well as access to standard serial
communications ports. Refer to the I/O Expander Installation Guide for complete
details about this device.

Communications breakout cable

The communications breakout cable connects with the male Molex connector on
the meter. This is a pre-made cable that provides access to the standard serial
communications ports on the meter.

Molex extension cables

Molex extension cables can be ordered in both 5 and 15 feet (1.5 or 4.5 meters)
lengths.

Optical probe

The optical probe attaches to the optical port on the front of the meter and allows
on-site communications (e.g. with a laptop computer).
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Serial Connections

The ION8600 provides RS-232 and RS5-485 serial communications connections,
located on the back of the meter, as well as an optical port, located on the front of
the meter.

If the meter’'s COM1 port is set to RS-232, you can connect this port to a remote
modem, which in turn is connected to a PC. You must use a null-modem RS-232
cable to connect the meter to an external modem. One end of the cable must be
equipped with a Micro-Fit 3.0 Molex female connector for mating with the Molex
male connector on the meter.

You can chain numerous meters’ COM1 ports, by selecting “RS-485" and using an
RS-232 to RS-485 converter (such as COM32 or COM128).

2\ NOTE

You cannot use both RS-232 and RS-485 ports on the meter’'s COM1 simultaneously.

If your meter is part of an ION Enterprise power-monitoring network, you can
configure your local and remote modems with ION Enterprise or ION Setup
software. You can also use ION Setup or ION Enterprise software to schedule
regular connection times to collect meter data.

Extension cables with Molex connectors are available for your meter. Pin
assignments for the Molex connector are provided in the ION8600 Installation
Guide that ships with the meter (also available at www.powerlogic.com).

2\ NOTE

The total number of possible serial connections is limited by the number of physical serial ports on the
meter. The ION8600 has two physical serial ports (not counting the front optical port).
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RS-232 Connections

Refer to ION8600 Installation Guide for the meter’s RS-232 specifications.

CABLE 1: Straight-Through Modem
CABLE 2: Null Modem

CABLE 3: 1/O Expander

CABLE 4: 1/0O Expander

CABLE 5: Null Modem

CABLE 6: Straight-Through Modem
*Maximum Length 15.2 m (50 ft)

Because of the wiring configuration between pins 2 and 3, the meter is considered
a DTE (Data Terminal Equipment) device in all RS-232 connections. Please refer to
“Meter Connections to Single Devices” on page 78. The maximum cable length is

50 feet (15.2 m).

DB9 Null Modem
Wiring Diagram

DCE
(computer)

X

ONOOD A WN

DTE
(meter)

ONOU A WN
LT L[]
I

Communications settings for the RS-232 port are accessible through the front panel
Setup menu (see Chapter 2 - “Using the Front Panel”) and with ION Enterprise or

ION Setup software.
Meter Connections to Single Devices

Breakout

CABLE 1
£ R

CABLE 2
) E "
CABLE 3 ]
CABLE 4
—

CABLE 5

DB? Direct Connect
to Computer

DB9 Direct Connect
to External Modem

Molex Direct Connect
to 1/O Expander
connected to Computer

CABLE 6
—_—> L

{
S

Molex Direct Connect
to I/O Expander
connected to External
Modem
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Meter Connections to a Serial Loop

RS-485 Connections

Refer to the ION8600 Installation Guide for RS-485 specifications.

The breakout cable’s twisted pair provide connections for both of the meter’s
RS-485 serial communications ports. The first set is for COM1 RS-485 connections.
The second set is for COM4 RS-485 communications.

Up to 32 devices can be connected on a single R5-485 bus. Use a good quality
shielded twisted pair cable for each RS-485 bus, AWG 22 (0.33 mm?) or larger. The
overall length of the RS-485 cable connecting all devices cannot exceed 4000 feet
(1219 m). The RS-485 bus may be configured in straight-line or loop topologies.
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Straight-Line Topology
Wiring color codes for the Molex cable
are provided in the
ION8600 Installation Guide that ships
with the meter and are available at
www.powerlogic.com.
RS-232 to
RS-485 - o
Converter Ry Terr.mnchon
/w ,\ ' Resistor
=N \= +)-
| E—{ Re
Loop Topology
& & @
RS-232 to + - A+ A-
RS-485 (] 1T (-
Converter v Termination

Block

= ) e

General Bus Wiring Considerations

Devices connected on the bus, including the meter, converter(s) and other
instrumentation, must be wired as follows:

¢ Connect the shield of each segment of the cable to ground at one end only.
¢ Isolate cables as much as possible from sources of electrical noise.

¢ Use an intermediate terminal strip to connect each device to the bus. This allows
for easy removal of a device for servicing if necessary.

& Install a ¥4 Watt termination resistor (RT) between the (+) and (-) terminals of the
device at each end point of a straight-line bus. The resistor should match the
nominal impedance of the RS-485 cable (typically 120 ohms — consult the
manufacturer’s documentation for the cable’s impedance value).

RS-485 Connection Methods to Avoid

Any device connection that causes a branch in the main RS5-485 bus should be
avoided. This includes star and tee (T) methods. These wiring methods can cause
signal reflections that may lead to interference. At any connection point on the RS-
485 bus, no more than two cables should be connected. This includes connection
points on instruments, converters, and terminal strips. Following this guideline
ensures that both star and tee connections are avoided.
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Avoid 3-way “Star”
connection point

Avoid 3-way “T"
connection point

Communications Breakout Cable

Refer to the ION8600 Installation Guide for the DB9 serial pin assignments for the
optional breakout cable female DB9 connector. A communications breakout cable
facilitates communications connections by connecting to the Molex male connector
on your meter. The cable splits to a standard DB9 female connector and two RS-
485 shielded, twisted pairs. Cable length is 152 cm (5 feet).

Molex male
from the meter

Two RS-485
twisted pairs

DB9 female
connector

RS-485 shield
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Configuring the Optical Port

Refer to the ION8600 Installation Guide for infrared port specifications.

The infrared port available on the ION8600 meters is compatible with standard
magnetic optical communications couplers, or optical probes (ANSI Type II).
Optical probes are available both from Schneider Electric and other suppliers as a
separate product; contact Schneider Electric for a list of suppliers. The original
equipment manufacturer’s warranty will apply. See the technical note Optical
Magnetic Couplers for more detailed information.

Optical probes can communicate real-time measurements via the ION, RTU, DNP
3.0, Factory, or GPS protocols. You can configure the optical port communications
settings with the front panel, with ION Setup, or with the Designer component of
ION Enterprise.

Using the front panel

1. Press and hold the Alt/Enter button for a few seconds. The SETUP MENU will
appear.

2. Use the Up or Down arrow buttons to choose COM3 SETUP.
3. DPress the Alt/Enter button to access COM3 SETUP parameters.

4. Configure the COM3 Baud Rate, Unit ID, and Protocol parameters to match your
communications system.

Press and Hold
6_4 \[ 8600 SETUP
N V4 RETURN
1021 kA ENTER BASIC gETUP COM3 SETUP
18:3000 1999.06.01 ABC 1 NoRM (BRI} 500m DEMAND SETUP
COM1 SETUP RETURN
pros || PROTOCOL
| COM3 SETUP |
COM4 SETUP BAUD,RATE
e 1/ | NETWORK SETUP .
W FORMAT SETUP
DISPLAY SETUP
SECURITY

Using ION Setup

1. Run ION Setup and connect to the appropriate meter.

2. Double-click on “Setup Assistant” in the right side of the Network Viewer.
3. In the Setup screens, navigate to Communications > Serial Settings.
4

Click the COM3 tab and configure the Baud Rate, Unit ID, and Protocol
parameters to match your communications system.

To enable communications from the infrared port, you must configure the COM3
Communications module. The Protocol, the Baud Rate and Unit ID setup registers
must properly match your system. When creating an ION site, ensure the RtsCts is
disabled (set to No) in the COMS serial site.

Refer to the Management Console section of the online ION Enterprise Help for
more details about adding serial sites.
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Using ION Enterprise

1. In Management Console, create a “Direct Site”.

2. Configure the COM3 communications module (refer to the online ION
Enterprise help for details). Ensure the Protocol, the Baud Rate, and Unit ID setup

registers properly match your system.

“_x Direct Site Options

This is your PC's = o I
(workstation’s) COM port. mopey — aue
Mame SernialSite
\ Computer CHUCKHEE7 -

- Gerial Poit COM3 -
If you are using ION — o =
Enterprise or ION Setup
software, ensure that Enabled Ves e
RtsCts is disabled for the Use DTR Mo M
infrared port's site in Baud Rats 9600 v
Management Console. Description E xample]

Configuring Ethernet Connections

This section only applies if your meter has an Ethernet option. Refer to the
ION8600 Installation Guide for Ethernet port specifications.

Ethernet connections are made via the RJ45 modular jack on the rear of the unit
(10Base-T option) or via two male ST connectors (fibre 10Base-FL option). Use high
quality Category 3, 4 or 5 UTP cable (R]45 female to RJ45 male) if you require an
extension. The optional Ethernet port is capable of data rates up to 10 Mbps, and
supports TCP/IP, ION, Telnet, and Modbus/TCP protocols. The meter supports a
maximum of four (4) simultaneous Ethernet connections. Meters with Modbus
Master over TCP/IP have an additional dedicated Ethernet connection.The
Ethernet port is controlled by the Ethernet Communications module.

Ethernet Connections for the ION8600

_—

j"l‘

TCP/IP Modbus Master dedicated
TCP connection. Connect with up to
10 Modbus slave IP addresses. Refer
to “Third Party Protocols” for Modbus
information.

4 simultaneous connections.
Protocols include ION, DNP
Modbus, etc.

SMTP Server (email)
outgoing only.
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The EtherGate feature provides communications through an Ethernet connected
device to a serial network connected to that device (See “Configuring EtherGate
Connections” on page 85).

You can configure the Ethernet Communications module to enable Ethernet
communications using the front panel, ION Setup or ION Enterprise. In each case,
you must configure the IP Address, Subnet Mask, Gateway, SMTP Server and SMTP
Connection Timeout to properly match your system.

Using the front panel

1. Select NETWORK SETUP from the main Setup menu (hold down the
Alt/Enter key for about 3 seconds and scroll down using the softkeys).

la

|b Press and Hold
le 2917 Q'::> 8600 SETUP
In

10211 |  ener
18:30:00 1999.06.01 ABC Q1 NORM Eﬂliﬂﬂm COM4 SETUP
I NEROASENE | ... [NETWORK SETUP
FORMAT SETUP [ 3= RETURN

2. Configure the Ethernet Communications module IP Address, Subnet Mask,
Gateway and SMTP Server setup registers to match your communications
system.

Using ION Setup

Once you have wired your meter to the Ethernet network and performed basic
setup, add the meter to your ION Setup network using the Setup Assistant.

1. Run ION Setup and connect to the appropriate meter.

2. Double-click on “Setup Assistant” in the right side of the Network Viewer.
3. Inthe Setup screens, navigate to Communications > Network Settings.
4

Click the various tabs to configure the IP Address, Subnet Mask, Gateway, SMTP
Server and SMTP Connection Timeout setup registers to match your
communications system.

Using ION Enterprise

After you have wired your meter to the Ethernet network and performed basic
setup, add the meter to your ION Enterprise network using the Management
Console. It is not necessary to add an Ethernet site.

To enable communications through the Ethernet port, you must configure the
Ethernet (Communications) module. Launch Designer and configure the IP
Address, Subnet Mask, Gateway, SMTP Server and SMTP Connection Timeout
registers to match your system.

Page 84
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Adding an Ethernet device to your ION Enterprise Network

In the Management Console, the Ethernet Device Options screen appears when
you add an Ethernet device (meter). Use this screen to describe your meter’s
Ethernet address and other communications information. Be sure to include:

¢ the server computer that communicates with the Ethernet device

& the Ethernet device TCP/IP address

" Ethernet Device Options

Property Value |
Graup Revenue
REN Meter
Device Type 8500 10N =]
TCF/IP Addiess 10.1.44.73
Enabled ez -
Dezcription
Computer CHUCKHEET -

Configuring EtherGate Connections

The EtherGate protocol is a powerful communications tool that lets you
communicate through a meter to a serial network connected to the meter. When a
meter installed on the Ethernet network has EtherGate enabled, a master device
(such as a workstation running ION Enterprise software) can communicate
through the meter to a serial network of devices wired to the meter’s COM port.
EtherGate is available on serial ports COM1 and COM4 in place of the ION,
Modbus Master, Modbus RTU, or DNP 3.00 protocols. The protocol permits the
direct transfer of data from up to 62 devices (31 devices per COM port).

Specifying the TCP/IP Port
instructs the ION gateway
meter to:

Each device in the
serial network must
have a unique Unit
ID and operate at

the same baud rate.

7801—talk through COM1
7802—talk through COM4

Once you have the chain of serial devices installed, use Designer or the meter’s
front panel to change the COM1 or COM4 Protocol setting to EtherGate. The
transfer of data between protocols is then handled automatically.
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Using the front panel

1.

Press and hold the Alt/Enter button for a few seconds to reach the Setup
screens.

Press the Up or Down arrow buttons to scroll to COM1 Setup (or COM4,
depending on your meter’s options). Press Alt/Enter to go to the COMI1 Setup
parameters.

Scroll to Protocol and press Alt/Enter. Change the port’s Protocol setting to
EtherGate using the Up or Down arrow buttons.

8600 SETUP

DEMAND SETUP
COM1 SETUP

y

COM1 SETUP

COM?2 SETUP RETURN

PROTOCOL
FACTORY

MODEMGATE

Using ION Setup

1.
2.
3.

8.

Run ION Setup in network mode.
Right-click on your workstation icon and select “Site”.

In the New Site window, General tab, enter your site name.
From the Comm Link drop down list, select an Ethernet port.
From the Link Type drop down list, select “EtherGate connection”.

Click on the Remote Info tab. Enter the IP address of your Ethernet connected
meter. Click OK.

Right-click on your newly created site.
The New Network Item window appears. Select “Meter” and click OK.

The New Device window appears. Enter serial device information here and click
OK. Your new device appears under your newly created site

Repeat steps 5 to 7 to enter each device on your serial network.

Refer to The ION Meter as an Ethernet Gateway technical note for complete details on
configuring your meter for EtherGate.

2\ NoTe

Use a standard Ethernet connection to connect to and read data from your EtherGate meter.
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Using ION Enterprise

To communicate to the devices on the RS-485 loop, you must use ION Enterprise
software as follows:

1. In Management Console, create an “Ethernet Gateway Site”.

2. Configure your Ethernet Gateway Site with the IP address of the gateway meter.
Select the IP Port that matches the gateway meter’s COM port that is connected
to the R5-485 loop.

3. In Management Console, add each of the devices on the RS-485 loop to the
Ethernet Gateway Site (but not the gateway meter itself).

The Devices list in the Management Console appears as follows:

Devices

Type ite Site Status Enﬂed 4 | Pratocol
10N 7300 10.168.69.73/7802/36  EtherGate_SiteS Port Aveailable  YES 10M
10.168.69.73/7802/42  EtherGate_SiteS Port Aveailable  YES 10M

101 INJS EtherGate_Site5 Port Available

The Gateway Site - set the IP Service Port

The devices that reside on the RS-485 7801 for COM] or 7802 for.COM4. The
loop connected to the ION8600. number following the IP Service Port
number is the device’s unique Unit ID.

2 NOTE

In the above configuration you communicate with the devices in the RS-485 loop through the meter.

Communicating directly TO the meter

In order to connect directly over Ethernet, add the gateway meter as an Ethernet
device in the Management Console. Refer to “Configuring Ethernet Connections”
on page 83.
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Internal Modem Connections

This section only applies if your meter has the internal modem option. Refer to the
ION8600 Installation Guide for internal modem specifications.

The internal modem is accessed through COM2 and supports all standard modem
protocols at transmission rates from 300 bps to 57600 bps (300 bps is only
recommended for paging applications) and can be shared by up to 31 devices on
an RS5-485 chain. It is available with a standard six-pin RJ-11 phone plug, or an
eight-pin RJ-31. If you have multiple meters linked on an RS-485 loop, only the first
meter requires an internal modem. This setup is referred to as a ModemGate (see
“The ModemGate Protocol” on page 91).You can configure the settings of the
internal modem with the front panel or with ION Enterprise or ION Setup
software.

To enable communications through the meter’s internal modem, configure the
COM2 communications module Baud Rate, Unit ID, and Protocol setup registers to
properly match your system, and setup the initialization string for the internal
modem must be using the ModemInit register.

2\ NoTe

When the meter is equipped with the ION Alert module, the modem can initiate calls. Paging is supported
through numeric paging and the TAP1 protocol. See the /ON Enterprise User Guide or online support for

details on managing modem connections, setting up periodic dial-out and configuring remote site event
noftification.

ModemlInit Setup Register

The Modemlnit string register defines the initialization string for the internal
modem with a maximum of 47 characters. Edit the ModemInit register and enter the
desired initialization string. The string is sent to the modem as soon as you
download the COM1 module. Note that the string is also sent to the modem
whenever the meter is powered up or the baud rate in the COM1 Communications
module is changed.

CAUTION

Changing the Modem/nit or Baud Rate setup registers while the internal modem is online causes the
modem to disconnect from the phone line.
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Modem Initialization Strings

Refer to the Modem AT Commands technical note for a complete list of AT
commands for meter modems.

2\ NoTe

The technical note also contains instructions on how you can determine your meter’s modem type based
on the meter’s serial number.

Adjusting the Modem Initialization String for CTR-21 Compliant modems

The table below shows the strings to add to the end of your modem configuration
string setup register for each of three possible scenarios.

Behaviour Add to Modem Initialization String

Does not answer

(modem does not detect ring tone) NC70

Does not dial
(modem does not detect dial tone)

In order of preference:
*NC70, *NC70X0, *NC8 (ltaly only)

Does not detect busy signal

*NC70

If your local modem (not the internal modem) is not already set up, configure it
with the Remote Modem Configuration Utility according to the instructions in the
online help. After the meter is installed and the internal modem is connected to the
telephone network, the COM2 module can be configured using the meter’s front
panel or ION Enterprise or ION Setup software. To learn how to connect the
internal modem to the telephone network, consult your ION8600 Installation Guide.

2\ NOTE

The /ON Enterprise Commissioning Guide and online help contain details on: commissioning an ION
network, managing modem connections, setting up periodic dial-out, and configuring remote site event
notification.

Configuring the COM2 module through the front panel
1. Press and hold the Alt/Enter button and scroll to COM2 Setup.

2. Select COM2 Setup to configure the COM2 communications module
Baud Rate, Unit ID, and Protocol setup registers to your communications system.

240114

|b 2951.3 KA Press and Hold
lc 29170l < 8600 SETUP
Al|n  A02a) e DEMAND SETUP
18:30:00 1989.06.01 ABC Q1 NORM [ER]5:00m| COM1 SETUP Press coM2 sETUP

COM2 SETUP

RETURN
PROTOCOL
BAUD RATE
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Configuring the COM2 module via Designer

Before you can configure the COM2 module in Designer you must add the meter
(with the internal modem) and a modem site to your ION Enterprise network.

Adding a meter and a modem site to your ION Enterprise network

In the Management Console, add the meter with the internal modem, and a
modem site to your ION Enterprise network. Describe how your remote modem
is wired and other communications information on the options screens.

Either before or after adding the Modem Site, you must add a dialout modem to
the server computer. The server computer dialout modem communicates to the
modem at the modem site. See the ION Enterprise online help for more
information.

On the Modem Site Options screen, be sure to include:

¢ the server computer that will communicate with the remote modem

¢ the remote modem telephone number

‘_* Modem Site Options

Remote modem telephone Property Value i
number. ’\ Marne MademSite_main
Phone Murnber 555- 4321 Server computer that
Enabled s j communicates with the
To avoid excessive communication Computer WORKSTATIONE ﬁ:i remote modem. Ensure that
errors, the baud rate of the modem | [BlEEdhE E B the server computer dialout
site should match the baud rate of Description modem is configured.
the COM2 port of the meter.
*_* Dialout Modem Options

Pick a Joca/ modem type

Property Value from the drop-down box.

Modem Type Hayes docura 336, 34+FAx ( <
Computer WORKSTATIONE N\
Serial Part COM3 i
RitsCrs e =
Uze DTR Yes -
Enabled Yes -
Conztraints

Description

Page 90

© 2009 Schneider Electric. All rights reserved.



PowerlLogic ION8600 User Guide

Chapter 6 - Communications

Workstation with
ION Enterprise
and modem.

Configuring the COM2 Communications module in Designer

Launch Designer, and configure the COM2 Communications module Baud Rate,
Unit ID, and Protocol setup registers to match your communications system.
Configure the initialization string for the internal modem using the ModemInit
register. Refer to “ModemInit Setup Register” on page 88.

The ModemGate Protocol

ModemGate is a powerful feature that creates a communications connection
between the telephone network and an RS-485 serial network of devices. When
you specify the protocol for a meter’'s COM port as MODEMGATE, all data received
by the meter’s internal modem is automatically transferred to the serial network.
ModemGate is available on either the COM1 or COM4 port; you cannot use the
protocol on both ports simultaneously.

Meter with internal
modem on COM?2.
The serial network is
connected to COM1.

Each device on the RS-485 loop,
including the gateway meter’s internal
modem, must have a unique Unit ID.
All serial devices must operate at the
same baud rate as the gateway meter.

The baud rate used between connected modem:s is independent of the internal
baud rate used for communication between the meter and its modem.

Wire a serial connection between one or more meters and the meter COM port
hosting the ModemGate (COM1 or COM4). You can make ModemGate
connections through an RS-232 cable to a single device, or through an RS-485
shielded twisted pair cable to multiple devices. ModemGate connections do not
connect a workstation running ION Enterprise (or other master device) to the
gateway meter's COM1 or COM4 port, but rather to the gateway meter’s internal
modem port (COM2).
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Configuring the meter for ModemGate
1. Install the meter and connect the internal modem.
2. Use the front panel or ION Enterprise or ION Setup software to set up the

internal modem and the serial communications port (COM1 or COM4) that is
the ModemGate. The default for these ports is:

Communications modules Setting Default
Comm Mode RS-485
COMT Baud Rate 9600
(Standard RS-232/485 port) Unit ID 100
Protocol ION
Baud Rate 9600
Unit ID 101
COM2 (Modem Port)
Protocol ION
Modem Init Strings AT&F
Baud Rate 9600
(CR?_'Z‘QS ot Unit ID 103
Protocol ION

2\ NOTE

You can enable ModemGate on either COM1 or COM4, not both simultaneously.

3. Set the internal modem COM?2 Baud Rate, Unit ID and Protocol. The baud rate
must be the same as the port hosting the gateway and all the devices connected
to the gateway.

4. Set the protocol of the port hosting the gateway to MODEMGATE (either COM1
or COM4). You must also set the baud rate to the same as the modem baud rate
(COM2).

Configuring devices connected to the ModemGate meter

1. Use ION Enterprise or ION Setup software or the front panel to change and
configure settings. Ensure each device connected to the meter has the same
baud rate as the meter ModemGate port (either COM1 or COM4).

2. Ensure each device connected on the RS-485 network (including the meter
modem) has a unique Unit ID number. Make a record of your changes.

2\ NOTE

In order to configure the dial-in connection the system administrator requires the serial baud rate of the

modem site and a record of the Unit ID numbers for every device.

3. Ensure ‘RS-485’ is selected for connections to multiple devices along the same
bus.
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Adding ModemGate meters to the network

1. Once you have created a Modem Site using the Management Console, add the
devices connected to the ModemGate port.

2. Ensure each meter on the modem Site has a unique Unit ID number (the
technician who installed the meter at the remote site should provide you with
this information).

Refer to the ION Meter as a ModemGate technical note for complete details on
configuring your meter for ModemGate.
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Third Party Protocols

This chapter explains how Modbus and DNP 3.0 protocols are implemented on the
ION8600 meter.

It also contains brief instructions for configuring your meter to work with MV90
systems.

2 NOTE

The total number of possible serial connections is limited by the number of physical serial ports on the
meter. The ION8600 has two physical serial ports, in addition to the front infrared port.

In this chapter

T @ T 96
Communications Protocol Configuration ................................ 96

¢ TheMeterasModbusSlave ............ ..., 97
Using the Modbus RTU Protocol . ............. ... i, 97
Configuring the Meter asa ModbusSlave ................................ 98
Modbus Slave Modules . . ... e 99
Using the Modbus/TCP Protocol ............cooo i, 103

¢ The Meteras Modbus Master .............c.citiuininenennnnnnn 104
The Factory Modbus Master Configuration ............................. 104
Configuring the Meter as Modbus Master . ....................... 105
Usingthe DNP 3.0 Protocol . ........coiiiiiieinnnnnnnnnnnnnnn 108
Configuring DNP 3.0 . ... 108

& Configuring MV-90 .. ... ...ttt ittt iiieennaennnnns 110
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Overview

ION8600 meters support DNP 3.0, Modbus RTU and Modbus/TCP protocols.

While your meter is factory configured to send data (acting as Modbus Slave), it is
not ready to receive data as a Modbus Master until you set up the necessary
framework. The meter is also pre-configured to send DNP 3.0 data to a DNP
Master.

2\ NOTE

Changing the default factory third-party protocol frameworks (or creating new frameworks to enable
receive functionality) is an advanced procedure. Refer to the DNP modules and Modbus modules
descriptions in the /ON Reference, as well as the technical notes Multiport DNP 3.0 and ION Technology,
and Modbus and ION Technology before proceeding.

Most Modbus and DNP modules on the meter are factory pre-set and only require
basic configuration, such as communications setup.

2\ NOTE

Changing these modules from their factory configuration is an advanced setup procedure that requires
an understanding of the protocol, as well as an understanding of the meter’s internal operation. For more
information on your meter and these protocols see the Common Modbus Registers document and the
/ON8600 DNP 3.0 Device Profile.

Communications Protocol Configuration

In order to use the factory Modbus or DNP configuration, you must first assign the
communications channel you want to use. By default, all communications ports
are configured to use the ION protocol. Choose the 3rd-party protocol you want
from the list of available protocols in the Communications module’s Protocol
setup register. See the chapter “Communications” on page 73 for instructions.

2\ NOTE

Modbus RTU is available on each of the meter's communications ports, and multiple ports can

communicate using Modbus simultaneously. Up to three ports can use the DNP 3.00 protocol at any one
time.
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The Meter as Modbus Slave

Using the Modbus

Your meter can act as a Modbus Slave, using both the Modbus RTU and Modbus/
TCP protocols.

RTU Protocol

The ION8600 meter can act as a Modbus Slave device, making any real-time data
available through the Modicon Modbus RTU protocol. Modbus Master devices
connected to the meter can access (read) this data or write data to your meter’s ION
registers, making device configuration changes and initiating control actions.

The Factory Modbus Slave Configuration

The meter makes data available to Modbus Master devices using pre-configured

Modbus Slave modules. These modules are linked to other modules in the meter

that provide the energy, power and demand data. Once a communications channel
is configured to use Modbus RTU protocol, the data is available to Modbus Master
devices.

2\ NOTE

Connect to IP Service Port 7701 for Modbus RTU communications over Ethernet. The Modbus Unit ID of
the meter over Ethernet has the factory default value of 100.

Set the COM port to
the Modbus RTU
protocol

Communications Port

Power Meter Modbus Slave
Module Vina Module
Data is available
to Modbus
master devices
Measured data is Modbus Slave
ION meter linked to the Modbus module outputs data
module’s input in Modbus format

As the data available through the Modbus Slave modules is in a specific format,
knowledge of the Modbus protocol and an understanding of the settings used in
the meter are required to interpret the data provided.

Changing the Modbus Configuration

If the factory Modbus configuration does not suit your needs, the existing Modbus

Slave modules can be relinked to other parameters that you want to access through
Modbus.
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If your Modbus Master device requires data in a format different than that
provided by the factory Modbus configuration, you can edit the setup registers in
the Modbus Slave modules. These setup registers specify the Modbus format,

scaling and base address settings. Refer to the ION Reference for complete details
on the Modbus Slave module.

Configuring the Meter as a Modbus Slave

You cannot configure Modbus through the meter’s front panel; you can only

assign the Modbus protocol to communication ports (see the Communications
chapter for details).

Use ION Enterprise or ION Setup software to perform full Modbus configuration.

Using ION Setup

The Modbus Setup Assistant helps you configure Modbus Slave functionality for
your meter.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to Communications > 3rd Party Protocols.
3. Click on the Modbus Slave tab to edit the Modbus Slave modules.
4

Select the map name (in this example, the default map) and click Edit.

Setup Assistant E
= Template Modbus Slave | Modbus Masterl DMP 3.D|
= Baszic Setup

= Security Alloves you to customize the Modbus map used by ather 3rd party

(2 Communications device to communicate to the meter.

= Serial Settings
= Metwork Settings
= 3rd Party Protocols

egisters | Start | End

Demand D efault 40011 41163

< Back | Mest » Exit Help
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5. The default Modbus map editor appears, allowing you to edit, add, delete or set
the name of Modbus Slave module registers.

Default Modbus Map E
Farameter Address | Regs | Format Scaling Edit
40m1 1 UINT1E %10
Winb aomz 1 UINT1E %10 Add
Win o 0mz 1 UINT1E + 10 —I
Win avg 4004 1 UINT1E + 10 Delete
Wl ab 40ms 1 UINT1E + 10 —I
Wil b 40ME 1 UINT1E + 10 Set Name
Wil ca 40m7 1 UINT1E + 10 —I
Wil avg 40ma 1 UINT1E + 10
la 40ma 1 UINT1E + 10
Ib 40020 1 UINT1E + 10
le 40021 1 UINT1E + 10
| avg 40022 1 UINT1E + 10
Y unbal 40023 1 UINT1E + 10
| unbal 40024 1 UINT1E %10 LI
ak. I Cancel FErint | Help |

Modbus Slave Modules

The ION8600 meter has ten Modbus slave modules. Modules 1 - 5 are part of the
original modbus mapping and are preserved for backward compatibility. If you
are using the new Modbus mapping (modules 6 - 10), you can delete modules 1 - 5.

4 Mod!nfs Slave M?dule 4 Modbus Slave Module
(original mapping) (new mapping)
1 Volts/Amps/Freq 6 Amp/freq/unbal
2 Power/PF 7 Volts
3 Min/Max/Demand 8 kW/kVAr/kVA
4 | Energy/THD 9 | kWh/kVArh
5 Flicker Count 10 | PF/THD/Kfactor

The settings for your Modbus Slave modules are as follows:
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Amp/Freq/Unbadl Volts
Format: unsigned 16 bit InZero: 0 Format: unsigned 32 bit InZero: 0O
Base Address: 40150 InFull: 6,000 Base Address: 40166 InFull: 1,000,000
Scaling: Yes OutZero: 0 Scaling: No OutZero: 0
OutFull: 60,000 OutFull: 10,000,000
Input Modbus Registers Parameter Input  |Modbus Registers Parameter
Source #1 40150 la Source #1 4016610 40167 |VIna
Source #2 40151 Ib Source #2 4016810 40169 |VInb
Source #3 40152 lc Source #3 4017010 40171 Vinc
Source #4 40153 14 Source #4 40172 10 40173  |Vin avg
Source #5 40154 15 Source #5 40174 10 40175  |VIn avg mx
Source #6 40155 | avg Source #6 40176 to 40177
Source #7 40156 | avg mn Source #7 4017810 40179  |Vll ab
Source #8 40157 | avg mx Source #8 40180 to 40181 VIl be
Source #9 40158 | avg mean Source #9 4018210 40183 |Vl ca
Source #10 40159 Freq Source #10 |40184 to 40185 |Vl avg
Source #11 {40160 Freq mn Source #11  |40186 t0 40187 | VIl avg mx
Source #12  |40161 Freq mx Source #12 |40188 to 40189
Source #13  |40162 Freq mean Source #13  |40190 to 40191
Source #14 |40163 V unbal Source #14 |40192 to 40193
Source #15 40164 | 'unbal Source #15 |40194 to 40195
Source #16  |40165 Phase Rev Source #16 |40196 to 40197
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kW/kVAr/kVA kWh/kVArh
Format: signed 32 bit InZero:  -1,000,000,000 Format: signed 32 bit InZero: -1,000,000,000
Base Address: 40198 InFull: 1,000,000,000 Base Address: 40230 InFull: 1,000,000,000
Scaling: No OutZero: -1,000,000 Scaling: No OutZero: -1,000,000
OutFull: 1,000,000 OutFull: 1,000,000
Input Modbus Registers Parameter Input Modbus Registers Parameter
Source #1 4019810 40199 kW a Source #1 40230 to 40231 kWh del
Source #2 40200 to 40201 kW b Source #2 40232 to 40233 kWh rec
Source #3 40202 to 40203 |kWc Source #3 40234 to0 40235 | kVARh del
Source #4 40204 to 40205  |kW tot Source #4 40236 to 40237 | kVARh rec
Source #5 40206 to 40207  |kW tot max Source #5 40238 to 40239  |kVAh del+rec
Source #6 40208 to 40209  |kvar a Source #6 40240 to 40241
Source #7 4021010 40211 kvar b Source #7 40242 to 40243
Source #8 40212 t0 40213  |kvar c Source #8 40244 to 40245
Source #9 40214 t0 40215  |kvar tot Source #9 40246 to 40247
Source #10 40216 t0 40217 |kvar tot max Source #10 40248 to 40249
Source #11 4021810 40219 |kVAa Source #11 40250 to 40251
Source #12  |40220 to 40221 |kVA b Source #12 40252 to 40253
Source #13  |40222 to 40223 |kVAc Source #13 40254 to 40255
Source #14 40224 t0 40225 | kVA tot Source #14 40256 to 40257
Source #15 40226 to 40227  |kVA tot max Source #15 40258 to 40259
Source #16 40228 to 40229 Source #16 40260 to 40261
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PF/THD/Kfactor
Format: signed 16 bit InZero: -100
Base Address: 40262 InFull: 100
Scaling: No OutZero: -10,000
OutFull: 10,000
Input Modbus Registers Parameter
Source #1 40262 PF sign a
Source #2 40263 PF sign b
Source #3 40264 PF sign c
Source #4 40265 PF sign tot
Source #5 40266 V1 THD mx
Source #6 40267 V2 THD mx
Source #7 40268 V3 THD mx
Source #8 40269 [T THD mx
Source #9 40270 12 THD mx
Source #10 40271 I3 THD mx
Source #11 40272 I1 K Factor
Source #12 40273 12 K Factor
Source #13 40274 I3 K Factor
Source #14 40275 I1 Crest Factor
Source #15 40276 12 Crest Factor
Source #16 40277 I3 Crest Factor
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Importing Data using Modbus RTU

It is possible to bring data into the meter using Modbus. Various ION registers can
be written by Modbus Master devices by correlating the Modbus register number
with the address of the ION register you want to write. When a Modbus register is
written with a value, the corresponding ION register will be written, provided the
Modbus RTU protocol is active on the communications channel that connects the
Modbus Master to the meter.

You can use the Modbus RTU protocol to write values into ION external numeric,
pulse and Boolean registers, allowing you to enable, disable and reset meter
functions. You can also use the Modbus protocol to change setup register values in
various ION modules to configure the meter’s operation.

To bring data into the meter with Modbus RTU, you must disable the meter’s
password security.

CAUTION

Writing to ION external boolean or external numeric registers via communications at a high rate (faster
than once per minute) will shorten the meter’s flash memory life. For possible workarounds, contact
Technical Support.

Using the Modbus/TCP Protocol

Modbus/TCP is the newest open Modbus protocol variant (formerly called
MBAP). It defines the packet structure and connection port (port 502) for the
industry standard TCP/IP protocol. The structure of Modbus/TCP is very similar
to the Modbus RTU packet except that it has an extra six-byte header and does not
use the cyclic redundancy check (CRC). Modbus/TCP retains the Modbus RTU
limit of 256 bytes per packet.

Modbus TCP Communications

You can communicate to the meter using Modbus TCP. Your meter must have the
optional Ethernet port. Configure the meter to connect using virtual socket 502 to
use Modbus TCP communications protocols.

Connect to socket 502
&

2\ NoTe

You cannot form an EtherGate connection to the Modbus TCP network.
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The Meter as Modbus Master

ION8600A and ION8600B meters can act as a Modbus Master using the Modbus
RTU and Modbus/TCP protocols, and can Modbus Master through serial
connections between the ION8600 meter’'s COM1 or COM4 ports and the Modbus
slave devices. Firmware versions 330 (v330) and later allow your meter to Modbus
Master over TCP/IP using up to ten available TCP sockets.

The ION meter acting as Modbus Master can write data to (export), and read data
from (import) Modbus Slave devices, using various ION modules. The data can be
processed by the meter and sent out using other communications methods (email,
ION software, etc.). The meter can also send control commands or data directly to
other devices on a Modbus network.

The Factory Modbus Master Configuration

There is no pre-configured Modbus Master framework on your meter. This
functionality must be “turned on” by configuring the following modules in your
meter’s framework.

Modbus Master ION Modules

Several ION modules work together to create Modbus Master functionality on the
meter. Your meter will have some or all of these modules, depending on the model
and firmware version. See the ION Reference for more information on these and other
ION modules:

¢ Modbus Master Device Module: The Modbus Master Device module reads
data from a Modbus slave, which can be an ION meter or third-party device.
This imported data can be used by other ION modules. The Modbus Master
Device module references a Modbus Master Map module setup register to
specify the Modbus format, scaling, and base address settings.

¢ Modbus Master Map Module: provides a common place to hold setup
information (used to decode a Modbus response) for specific device types.
This information can be referenced by multiple Modbus Master Device
modules.

¢ Modbus Master Options Module: maps any serial connection or Ethernet TCP
socket from the Modbus Import, Modbus Export and Modbus Master Device
modules to any serial communications port or unique IP address and port
number.

¢ Modbus Export Module: provides write functionality.
¢ Modbus Import Module: provides read functionality. This data can then be
used by other ION modules.

See the Modbus and ION Technology technical note for more information on
configuring Modbus Master.
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Configuring the Meter as Modbus Master

Using the Front Panel

You cannot configure Modbus through the meter’s front panel. You can only
assign the Modbus protocol to communication ports. See the chapter
“Communications” on page 73 for details.

Use ION Enterprise or ION Setup software to perform full Modbus configuration.

Using ION Setup

The Modbus Setup Assistant helps you configure Modbus Master functionality for
your meter.

1.

2
3.
4

5.

Open ION Setup and connect to your meter, using Basic Mode.

In the Setup Assistant, navigate to Communications > 3rd Party Protocols.
Click on the Modbus Master tab to edit the Modbus Import modules.
Click the Add button to add a Modbus Slave device.

Setup Assistant =]
Modbusz Slave  Modbus Master | DHP 2.0 I

Allows pou to program 3rd party device Modbus mapping information
for the meter ta retieve when configured as a Modbus master.

Slave device | Statuz | Last Update

[elete |

< Back | Mest » | Exit | Help |

The Modbus Device screen appears. Enter the Slave device’s name and a label
suffix, and select a device type (in this example, an ION6200).

Mame: ISubmeter_‘I
Label suffis: J5M1

Device Type: |B2DDIDN 'l Hew |
Connected via: I Serial Connection 1 l Cannections
Slave ID: |1 0o

ak. I Cancel | Help |
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Modbus Master Connections B
Serial1 | Serial 2| Serial 3| Serial4| TCP1| TCP2| TCP3| TCR4| TCRS| TeRE| Tl Serial1 | Serial 2| Serial 3] Serial4| TCR1 TCP2 | TCP3| TCR4| TeR5| TeRs| Tl
Agsigned Part: I_ vl IP &ddress: |1 0.168.69.71
Modbus Protocol: RTU IF Part: |502
Modbus Protocol: TCP

6. Click Connections to edit the connection used by the Modbus Master to connect
to this Slave device.

¢ Serial Connections: Select the appropriate port from the drop-down list.

2, NOTE

The total number of possible serial connections is limited by the number of physical serial ports on the
meter that can Modbus Master. The ION8600 has two physical serial ports that support Modbus Master.

& TCP Connections: Enter the IP address of the Modbus slave device. The
Modbus Master IP port is 502. Up to ten Modbus slave device IP’s can be
entered for Modbus Master over TCP/IP.

Click OK when you have finished configuring connections.

Ok I Cancel | Help | ()3 I Cancel | Help |

7. Click OK to add the Slave device. The device now appears in the list. Continue
adding devices by clicking Add until all your devices are entered.

2, NOTE

The meter as Modbus Master over TCP/IP will attempt to communicate to a slave for up to 100 seconds

(as per the RFC1122 standard) before moving on to the next slave device.

See the Modbus and ION Technology technical note for more information.

Using ION Enterprise
Use Designer to configure Modbus Master functionality on your meter.
1. Open your meter in Designer.

2. Update the Modbus Master Options module with the connection information
for your Modbus slave device. Right-click on the module to access the ION
Module Setup dialog. Configure the setup registers by selecting the setup
register you want to change and clicking Modify, or by double-clicking on the
register.

¢ Serial Connections: Select the appropriate port from the drop-down list.

¢ TCP Connections: Enter the IP address of the Modbus slave device,
followed by the IP port (502). Up to 10 unique IP addresses can be entered.
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2, NOTE

The total number of possible serial connections is limited by the number of physical serial ports on the
meter that can Modbus Master. The ION8600 has two physical serial ports that support Modbus Master.

3. Create a new Modbus Master Map module. The Modbus Master Map module
has two setup registers:

¢ Device Type: Enter the type of device that you want to map. This value is
referenced by the Modbus Master Device module.

¢ Device Map: This is the data you want to access from the Modbus slave
device, in the form of text strings containing the parameter label, register
value, data format, etc.

4. Create a new Modbus Master Device module. Configure the setup registers in
the Modbus Master Device module, ensuring that the Device Type value
matches the setup register in the Modbus Master Map module.

5. Link the module inputs and outputs as required.
6. Select File > Send & Save when you are finished.
See the online ION Enterprise Help for more information on creating, modifying

and linking modules in Designer, and the ION Reference for details of module setup
and output registers.
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Using the DNP 3.0 Protocol

The Distributed Network Protocol Version 3.0 (DNP 3.0) is an open protocol used
in the electric utility industry for communications and interoperability among
substation computers, Remote Terminal Units (RTUs), Intelligent Electronic
Devices (IEDs, e.g. meters), and Master Stations.

You meter can be integrated into a DNP network as a DNP Slave, using the DNP
Slave Import, DNP Slave Export and DNP Slave Options modules. For more
information on the various DNP modules, see the ION Reference.

Your meter supports a maximum of three concurrent connections (or “sessions”
using the DNP 3.0 protocol; one for each serial port, up to three using Ethernet, or
a combination of both. Combinations available will depend on the meter's
communications options. A session consists of all incoming and outgoing DNP
Master/Slave traffic on one of the meter's communications ports.

Consult the DNP User’s Group at http://www.dnp.org/ to learn more about the
protocol.

The Factory DNP 3.0 Configuration

Your meter is pre-configured with a DNP framework that allows for basic DNP
Slave functionality. DNP Slave Export modules are used to send data to the DNP
Master while DNP Slave Options modules provide per-session settings such as
communications options. Although some minor setup of the framework is
necessary before it becomes enabled (assigning the DNP protocol to the
communications ports etc.), most module settings should not require alteration.

For information on your meter’s default DNP map and factory configuration, see
the ION8600 DNP 3.0 Device Profile.

Importing Data using DNP 3.0

Data can be imported into the meter from a DNP control relay or analog output
device. DNP Slave Import modules are used to take a DNP Analog output or
Binary output object and map them into ION registers.

2\ NOTE

DNP Slave Import modules are not part of the factory DNP framework and must be added manually.
Refer to the DNP Slave Import module description in the /ON Reference for details. Refer to the /ON8600
DNP 3.0 Device Profile protocol document for a description on the DNP 3.0 communications protocol
used by the meter.

Configuring DNP 3.0

If the factory DNP configuration does not suit your needs, you can relink the
existing DNP Slave Export modules to access a different set of parameters through
DNP. Alternately, you can add additional DNP Slave Export modules and link the
desired ION parameters to them.
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If your DNP network requires data in a format different than that provided by the
factory DNP configuration, you can edit the setup registers in the DNP Slave
Export modules and the DNP Slave Options modules. Do not make any changes
to the DNP Slave Options modules’ setup registers unless you understand the
effects each change will cause. Refer to the ION Reference for complete details on
DNP Slave Export and DNP Slave Options module function.

For detailed information on configuring your meter to use DNP, see the Multiport
DNP and ION Technology technical note.

Using the Front Panel

You cannot configure DNP through the meter’s front panel. You can only assign
the DNP 3.0 protocol to communication ports. See the Communications chapter.

Using ION Setup

The DNP 3.0 Setup Assistant helps you configure the DNP Slave Export and DNP
Slave Options modules.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to Communications > 3rd Party Protocols and
click on the DNP 3.0 tab.

3. Select the DNP feature you wish to configure (Parameter Map in this example)
and click Edit.

Setup Assistant E

= Template Modbus Slave I Modbus Master  DHP 3.0 |
= Baszic Setup
= Security Allowes you to customize the DMP 3.0 map used by other 3rd party

(2 Communications device to communicate to the meter.

E= Serial Settings
== Metwork Seftings

3rd Party Protocols

Configuration of Operational Ports

Farameter map MOME

(C Loaging

[C] Revenue

== Power Quality
= Werification
= Reports

E dit f |

< Back | Mest » | Exit | Help |

4. The Setup Assistant guides you through DNP configuration. See the ION Setup
Online Help for more information.
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Configuring MV-90

ION8600 meters can provide energy values to a MV-90 data management system.
In order to recognize and communicate with your meter, the MV-90 software
requires meter configuration data to create a master (master.dat) file for your
meter. Use ION Setup software (version 2.1 and later) to generate a master.dat file
that can be directly loaded into the MV-90 database or printed for manual data
entry. ION Setup can also export .hhf files to transfer meter revenue data into MV-
90.

IONB8600 meters with firmware revision v330 or later are able to generate either
E-File or P-File MV-90 data; earlier firmware revisions generate E-File data only.
Use ION Setup to:

¢ create a meter configuration (master.dat) file for your ION8600 that can be
imported directly into your MV-90 system.

¢ configure your meter’s revenue data to be MV-90 E-File or P-File data format.
¢ export an .hhf file to transfer revenue data from your ION8600 to your MV-90

system using a handheld device.

For more information, see the MV90 and ION Technology technical note, available
from the website.
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Time

This chapter covers the meter’s clock and time synchronization. For information
on IRIG-B GPS time synchronization, see the IRIG-B GPS Time Synchronization
product option document.

In this chapter

¢ Meter Clock Configuration ................ccoiiiiiiiiiennnnn. 112
Configuring the Meter Clock ............ ... ... . i it 112
Using the FrontPanel ........... ... ... ... ... ... .. i i 112

Using ION Setup ...t 112

Using Designer ................. . i i 113

Clock Module Settings ........... ... ... ... ... . 113

¢ ReplacingtheBatery ..........cccviuiiiiiiiiiniinninnnnnnnn. 114
Toreplacethebattery .......... ... ... ... ... . .l 114

¢ Time Synchronization ............. ... iiiiiiiiiiiiinnnannnn 116
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Meter Clock Configuration

The Clock module controls the meter’s internal clock, which provides timestamps
for data logged by the device. The clock needs to be configured properly to ensure
that logged data has accurate timestamp information. The Clock module also
receives the time synchronization signals sent to it by the workstation running
ION Enterprise or ION Setup software, updating the device’s clock when required.

The Clock module’s Clock Source setup register defines how the meter’s internal
clock auto-corrects drift from its internally calculated time. A separate time source
(such as a GPS receiver, or a DNP Master) can be used to synchronize the clock

through a communications channel. By default, the clock is set to synchronize from
the line frequency.

See the ION Reference for more information on the Clock module.

Configuring the Meter Clock

Use ION Enterprise or ION Setup software to change the meter’s clock settings.

Using the Front Panel

You cannot configure the time via the front panel.

Using ION Setup

The Clock Setup Assistant helps you configure the Clock module.
1. Open ION Setup and connect to your meter, using Basic Mode.

2. Inthe Setup Assistant, navigate to the Clock folder.

Setup Assistant E

= Template
-= Basic Setup

Security Blloves you to program the meter clock settings.
[Z] Communications

Timezone | DST Settings |

Demand
(C Inputs/Outputs
(1 Loaging Timezone Pacific: (GMT-03:00]
[C] Revenue CL1 Time Sync Type TC

Pawer Quality CL1 Time Sync Source ETHERMET

— - CL1 Clack Source Internal
== Verication CL1 DST Offset 1 hour
Reports CL1 LocalTime wied Sep 01, 2004 3:53:29 AM
Edt | | TimeEune |
< Back | Mest » | Exit | Help |

3. Click on the Timezone tab to configure your meter’s clock settings. Select a
parameter and click Edit to change.

Page 112

© 2009 Schneider Electric. All rights reserved.



PowerlLogic ION8600 User Guide Chapter 8 - Time

4. Click on the DST Settings tab to configure your meter’s daylight savings periods
for up to 20 years. Select a parameter and click Edit to change.

Using Designer

Open your meter in Designer and navigate to the Meter Clock Setup framework.
Right-click on the Clock module to edit.

Clock Module Settings

The setup registers in the Clock module specify timezone and Daylight Savings
Time (DST) parameters and time synchronization functions.

Setup Register Function Default
TZ Offset Sets the timezone the device is in, relative to Greenwich Mean Time. 0
DST Start 20 The date and time when DST begins for 20 separate years. efer to the /ON Device Templates at

tart www.powerlogic.com for the DST
DST End Start and DST End defaults for the
DST End 20 The date and time when DST ends for 20 separate years. twenty separate years.
DST Offset The amount of time the clock is changed when DST begins or ends. 3, 600 seconds
Time Sync Source Specifies the communications port that receives time sync signals. COM3
Time Sync Type Specifies the type of time sync signal (Local or Universal time). UTC
Clock Source Speufles.the.clock.s time schhromzohon signal source (line frequency, Line Frequency
communications signals, or internal crystal).

O ™

When modifying setup registers of the Clock module in Designer, use the Format option to convert
between UNIX and conventional time. Refer to the description of the Clock module in the online
/ON Reference for more details.

Typically, the DST Start and DST End registers do not have to be reconfigured for
users in North America. The factory defaults are the DST start and end dates for 20
years, in UNIX time (the number of seconds since 00:00:00 UTC on Jan. 1, 1970).

Refer to the technical note Time Synchronization and Timekeeping for further details
on using the meter’s time synchronization functions.
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Replacing the Battery

The battery in the ION8600 meter keeps the real time clock running when primary
power is lost (loss of three phases). Assuming the battery was fresh when installed,
it runs the clock for about four years on an unpowered meter. When the meter is
fully powered, all battery drain is effectively eliminated; in this case battery life is
rated at 10 years minimum.

Replace the battery if the meter has been sitting for an extended period of time
without power (+/- two years). If the meter will be without power for an extended
length of time, disconnect the battery cable so that the battery maintains its 10-year
shelf life.

The battery can be changed when the meter is either powered or
unpowered (recommended).

2\ NOTE

Replacing the battery on an unpowered meter affects the internal clock settings. See “Event Screen/Event
Log confirmation (Unpowered Meter)” on page 115 for details.

To replace the battery
1. Remove the cover of the meter.

2. Remove the two Phillips screws that hold the EMI shield in place and carefully
slide the shield off.

3. Carefully disconnect the battery wire from the meter and remove the battery
from the housing.

ﬁ Battery

[

4. Place the new 3.6V Utility Meter LI battery in the housing and connect the wire
to the meter.

5. Replace the EMI shield and the two Phillips screws.

6. Replace the cover of the meter.
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Event Screen/Event Log confirmation (Unpowered Meter)

On an unpowered meter, the battery powers the internal clock. Removing the old
battery effectively stops the meter’s clock until the battery is replaced. Once
replaced, the clock restarts at its last known power-down time. The ION8600 logs
this as an event, which can be viewed from the Event Log on the meter’s front
panel (see “ALT mode default display screens” on page 178 for details on
navigating to the Event Screen). The Event Log appears as the following screen:

DATE TIME EVENT CODE

12/08/2005 10:23:45 Internal Error ~ PWRMAN: 600

12/08/2005 10:42:03 Information 450

9:36:54 12/09/2005 Q1 ALT B 13m
2\ NoTe

Event codes are written at the time of power up, as indicated by their ION event timestamp

The meter records the following event codes after battery replacement on an
unpowered meter:

Event Code Explanation Recommended Action
450 Seen only in combination with a ‘600 Refer to 600, below.
event.
Connect to the meter with ION Enterprise
or ION Setup software and synchronize
. . the meter’s internal clock.
600 Loss (.)f up to 10 minutes of b||||ng.doto See “Configuring the Meter Clock” on
and time late by as much as 10 minutes .
page 112 for details.
Double-check battery installation (if
required).

For details on resetting the meter’s internal clock, see “Configuring the Meter
Clock” on page 112.
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Time Synchronization

Time synchronization lets you synchronize your meter’s internal clock with all of
the other meters, devices, and software in a network. Once synchronized, all data
logs have timestamps that are relative to a uniform time base. This allows you to
achieve precise sequence-of-events and power quality analyses. Use ION software
to broadcast time signals across the network, or utilize an external source (such as
a DNP Master) to synchronize your meter’s clock.

Refer to the technical note Time Synchronization & Timekeeping for more
information on implementing time synchronization.

For information on IRIG-B GPS time synchronization, see the IRIG-B GPS Time
Synchronization product option document.
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This chapter explains how to configure and view demand values on your meter.

In this chapter

@ Introduction . ... ..ot i e 118
& ConfiguringDemand .......... ... it 118
Using the Front Panel ................ .. ... ... .. oot 118
UsingION Setup ............ 118
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Introduction

Demand is a measure of average power consumption over a fixed time interval.
Peak (or maximum) demand is the highest demand level recorded over the billing
period. Demand is measured using Sliding Window Demand modules. These
modules are configured to calculate the average current demand and kW, kVAR
and kVA demand. The setup registers in the demand module defines time
intervals for demand calculations, setting the sensitivity of the module’s operation.

See the ION Reference for more information about the Sliding Window Demand
module.

Configuring Demand

You can use the front panel controls or ION Enterprise or ION Setup software to
change your meter’s demand settings.

Using the Front Panel
1. Press and hold the Alt/Enter button until the Setup Menu is displayed.

2. Scroll using the Up or Down arrow buttons to select Demand Setup. Press the
Alt/Enter button to access Demand Setup parameters.

3. Scroll to the desired parameters using the Up or Down arrow buttons. Press the
Alt/Enter button to access each parameter.

¢ Use the Up or Down buttons to edit the value of each parameter.

& DPress the Alt/Enter button to select the value.

2\ NOTE

You may be prompted for the meter’s password the first time you attempt to change any values.

4. Select Yes to confirm the change.

Using ION Setup

The Demand Setup Assistant helps you configure Sliding Window Demand. This
screen also contains two registers used for configuring Sliding Window Demand
while the meter is in TEST Mode.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. Inthe Setup Assistant, navigate to the Demand folder.
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Setup Assistant E

= Template Roling Block. | [emand Forgivenessl
= Baszic Setup
= Security This specifies the number of sub-intervals in use.

[Z] Communications

== Clock

== Demand

(21 Inputs/Dutputs

(C1 Looaing Mumber of Sub-ind 5

(Z1 Reverue Sub-interval Length 15 mirutes
Poner Quay Ten e 1Y

= Displaps Test Sub-interval Length 15 minutes

= Verlfication PkDmd Mn/Mx Rist OFF

= Reports

E dit |

< Back | Mest » | Exit | Help |

3. To configure Rolling Block demand, select a register and click Edit.

You can also configure the Sliding Window Demand module using Advanced
Mode.

1. Connect to your meter, using Advanced Mode.

2. Click on the module you want to configure.

Using Designer

Open your meter in Designer and navigate to the Demand Setup framework. Click
on Demand Setup to access the Sliding Window Demand modules. Right-click on
a module to edit.

2, NOTE

For Time-of-Use Demand setup, go to Advanced Setup > Revenue Framework folder.

Sliding Window Demand Module Settings

Sliding Window Demand is often referred to as Rolling Block Demand. To
compute sliding window demand values, the Sliding Window Demand module
uses the sliding window averaging (or rolling interval) technique which divides
the demand interval into sub-intervals.
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The demand is measured electronically based on the average load level over the
most recent set of sub-intervals. This method offers better response time than fixed
interval methods.

Setup Register Function Default
Sub Intvl The time, in seconds, in the sliding window demand 900
sub-interval.
#Sublntvls The number of sub-intervals in the sliding window. 1
Pred Res The speed of Predicted Demand calculations; use higher values 70
P for faster prediction (70 to 99 recommended).
Update Rate Defines the update rate of the SWinDemand output register Fnrljr\?;SUb_
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Demand Forgiveness

Demand Forgiveness is the time programmed to the meter during which demand
(and therefore peak demand) will not be calculated in the power restoration period
following a total power outage.

During power-up following a complete power outage, customer equipment
consumes a higher than normal amount of power. The Demand Forgiveness
feature lets a utility forgive the customer for peak demand penalties that may arise
from power-up following a power outage (should the outage exceed a user-
specified period of time).

Demand and Peak Demand Module Overview

Power utilities generally bill commercial customers based on their peak usage
levels, called peak demand (in kW) and energy consumption (in kWh). Demand is a
measure of average power consumption over a fixed time interval, typically 15
minutes. Peak (or maximum) demand is the highest demand level recorded over
the billing period. Sliding window demand is one method of measuring demand.

To compute sliding window demand values, the Sliding Window Demand
module uses the sliding window averaging (or rolling interval) technique which
divides the demand interval into sub-intervals. The demand is measured
electronically based on the average load level over the most recent set of sub-
intervals.

In the following diagram, the Sliding Window module labeled “Demand”
calculates demand from the power input by measuring and averaging the power
over a set interval. The demand value is then output to a Maximum module
labeled “Peak Demand” that records the highest demand value over time (peak
demand).

Power output

DEMAND averaged PEAK DEMAND Maximum
Power (Demand) value (Peak)
 —— Sliding Window  ——— Maximum module —
module

For information on ION modules, refer to the online ION Reference.

Demand and Peak Demand Module Behavior During Demand Forgiveness

A peak demand value is the highest demand value since the last peak demand
reset. The Demand Forgiveness framework sets the Sliding Window module
inputs to zero during a Demand Forgiveness period. This method allows demand
interval data to accurately reflect a complete interval that includes data:

¢ prior to an outage
¢ during the Demand Forgiveness period (zero values)

¢ after the Demand Forgiveness period

© 2009 Schneider Electric. All rights reserved.

Page 121



Chapter 9 - Demand

PowerLogic ION8600 User Guide

2, NOTE

During a Demand Forgiveness period, Demand module inputs are set to zero and do not reflect actual
demand. These values should not be used to calculate energy for billing purposes. Energy values are not
affected and will reflect actual energy consumption during the Demand Forgiveness period.

The settings listed below must be made for Demand Forgiveness functionality.
These settings can be accessed from ION Setup software; refer to “Using ION
Setup” on page 124.

& Minimum Outage Duration lets you specify the amount of time (in seconds) that
the power must be out before the Demand Forgiveness period begins.

& Demand Forgiveness Duration lets you specify the amount of time (in seconds)
that demand is forgiven (demand inputs are zero).

& Update Rate lets you define the update rate of the SWinDemand output register
and is set to EVERY SECOND by default for revenue-related demand modules.
With this setting, demand value measured is updated once per second.

& Outage Voltage (line-to-line average in unscaled meter units) lets you define a
voltage level that is considered an outage. This is set to 20 volts by default.

KW @ "
A ‘B <
8 &
a a
O [0
c C
g 2
ey o
0 L
e e

Power 3]
E [0
a a

A

A B
N — -Ti
1:30 1:45 2:00 'me
Demand Demand Demand
Interval #1 Interval #2 Interval #3

Power Outage

(A The specified amount of time that the power must be out before demand is
forgiven

(B) The specified amount of time that demand is delayed during the Demand
Forgiveness period

The preceding diagram shows an example of a meter that is set up for Demand
Forgiveness. The Sliding Window Demand module is averaging demand values at
15 minute intervals. During interval #1, the meter has a power outage that lasts for
18 minutes. The power outage is defined by a system voltage of 20 volts which has
been specified in the Outage Voltage setting. The Minimum Outage Duration setting
is specified as 10 minutes, so this is amount of time that the power must be out
before demand can be forgiven. The Demand Forgiveness Duration setting is
specified as 1800 seconds (30 minutes), so for 30 minutes following power
restoration, demand inputs are zero. The power is restored during interval #2,
where the surge of power consumption during power-up is included in the
Demand Forgiveness period and has a value of zero.
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Additional Information

2\ NoTe

To function properly, the Demand Forgiveness feature requires firmware v310 or greater.

The following points are important to note:

¢ The following demand input values are zero for kQ, kW, kVA, and kVAR during

the Demand Forgiveness period:

Delivered

Received

Delivered + received
Delivered — received

Q1,Q2,Q3, Q4

* 6 6 o o

If a new peak is set prior to a power outage, it will persist.

Even though demand is zero during the Demand Forgiveness period, a new
peak could be set if the demand was very high prior to the power outage, or
after the Demand Forgiveness period ends.

Demand Forgiveness works for auxiliary and blade powered meters.
All ION modules in the Demand Forgiveness framework are fully locked.

If a Demand Forgiveness period is initiated, and another power outage occurs
that is less than the time specified in the Minimum Outage Duration setting, then
the Demand Forgiveness period continues. If a second outage is greater than
the time specified in the Minimum Outage Duration setting, then the Demand
Forgiveness period restarts.

Both the power outage downtime and the Demand Forgiveness downtime are
stored within the Demand Forgiveness framework. The Store modules preserve
a timestamp that is viewable in Vista.

The Sliding Window demand module Update Rate setup register must be set to
EVERY SECOND (default).

If Demand Forgiveness is enabled on an auxiliary-powered meter and there is
no power on the blades, then the meter assumes that this is an outage. When
power is applied to the blades, demand is forgiven for the specified time.

If Demand Forgiveness is enabled and the meter is unplugged for servicing or
other reasons, then the Demand Forgiveness framework assumes there was an
outage and demand is forgiven for the specified time.

For meters where Demand Forgiveness is enabled at the factory (e.g. RMICAN
Canadian revenue meters), demand will not be measured when the meter is first
put into service. Instead demand is forgiven for the specified time.

© 2009 Schneider Electric. All rights reserved.
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Configuring Demand Forgiveness

Demand Forgiveness is disabled by default. To enable Demand Forgiveness, use
ION Setup software to set the:

*

L 4
L 4
L 4

External Boolean module named “Demand Forgiveness Enable” to ENABLE.
minimum outage duration.
demand forgiveness duration.

outage voltage.

2\ NOTE

If Demand Forgiveness is enabled, do not use demand values to calculate energy for billing purposes.

Energy values are not affected and will reflect actual energy conception during the Demand Forgiveness
period.

Using the Front Panel

You cannot enable or edit Demand Forgiveness settings via the front panel.

Using ION Setup

ION Setup version 1.1 and later supports the Demand Forgiveness feature:

1.
2.
3.

Launch ION Setup and double-click the Setup Assistant.

Select the Demand setup screen, and click on the Demand Forgiveness tab.
Select Demand Forgiveness Enable.

Click Edit (provide a password if requested) and select ON.

Select Min Outage Duration, and click Edit.

Type the amount of time (in seconds) that the power must be out before the
Demand Forgiveness period starts, and click OK.

Select Demand Forgiveness Duration and click Edit.

Type the amount of time (in seconds) that demand is forgiven (demand inputs
are zero), and click OK.

If required, select Outage Voltage and click Edit.

Type the minimum voltage (line-to-line average in unscaled meter units) that is
considered an outage; this is set to 20 V by default but you can adjust this.
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This chapter provides information on the meter’s various digital and analog inputs
and outputs (1/O).

Refer to your Installation Guide for instructions on wiring inputs and outputs and
for the general meter I/O specifications.

In this chapter

@ Infroduction ....... ..ol 126

IO Cabling ...t 128

Specifying an I/O Portinan ION Module ................... ... ... ..... 129

Using the Onboard Digital Outputs ......................... .. ... ... 131

OutputModules .......... ... ... 131

Using the Onboard Digital Inputs ...................................... 133

Analog Outputs ... 134

Setting the Zeroand Full Scales .................................... 134
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Introduction

The ION8600’s digital and analog I/O ports simplify data gathering by importing
a variety of data types into a single, common system.

| [ ]

Socket or switchboard meter connections

ey

2

Expanded I/O (and serial
COMs): Molex Micro-Fit
24 pin male connector.

D -

e

Optional Onboard
1/O: 16 pin male
connector.

A
¥
7

Optional 1/O Expander for serial
communications and expanded 1/O.
Ordered and shipped separately. For
more information, see the ION8600
/O Expander documentation.

Serial COMs Expanded 1/O

COMT1: RS-232  Eight Form A digital

or RS-485. inputs.

COM4: RS-485, Four Form C digital

depending on outputs.

the ordering Four Form A digital

option. outputs or four
analog outputs.

Onboard 1/O break-
out cable with
female connector
and sixteen bare-
ended wires. Ships
with a meter ordered
with onboard I/O:
Four Form C digital
outputs.

Three Form A digital
inputs.
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Onboard 1/0

Onboard I/O for the ION8600 meters provides four Form C digital outputs and
three Form A digital inputs for a variety of applications.

For example, you can use a Form A digital input to monitor a breaker to verify how
many times the breaker trips. When the breaker has reached its limit for the
number of trips, you can use the digital output to light an LED next to the breaker
so field personnel are alerted. You can also use a Form C digital output to send
KYZ pulsing information to third-party system equipment.

1/0 Expander for ION8600 meters

For enhanced analog or digital I/O with the ION8600 meters, you can use an
external I/O Expander. Complete information for the I/O Expander is available in
the 1/O Expander Installation Guide.

The I/O Expander equips an ION meter with eight digital inputs, four Form A
digital outputs, and four Form C digital outputs, or four analog outputs (0 to 20
mA, -20 to 20 mA, or -1 to +1 mA) in place of the four Form A digital outputs. The
1/O Expander also provides a convenient location for the ION meter’s RS-232 and
RS-485 communications wiring. The I/O Expander box is wired as a DTE device
and does require a NULL modem cable/adapter to connect to the computer’s serial
port.

The I/O Expander is mounted separately, no more than 15 feet away from the
meter. It connects to the meter via a standard Molex Micro-Fit 3.0 connector. RS-
232 and RS-485 links are made via standard DB9 and captured-wire connectors
located on the I/O Expander. The analog output version of the I/O Expander must
be powered by an external source, a standard AC/DC supply.

As the I/O Expander board is external, you can install and configure I/O points
without affecting the meter’s operation. Terminal strips simplify connections to
external equipment. Furthermore, the low-profile connectors between the meter
and the I/O board let you easily remove the meter without disconnecting all the
attached I/O wiring,.

External 1/O with Grayhill Products

You can change the number of inputs and outputs available for ION meters, or
extend the functionality of the standard digital outputs through external I/O
boards. Just plug Grayhill analog or digital I/O hardware modules into the boards.
For more information, visit the www.powerlogic.com website.

Meter Digital Inputs Digital Outputs | Analog Inputs | Analog Outputs
Option A 8 8 0 4
Option B 8 8 0 4
Option C 8 8 0 4

As with onboard 1/O, the functionality of these external Grayhill hardware
modules are controlled by ION Enterprise or ION Setup software modules inside
the meter. ION Digital Output, Analog Output, Pulser, and Calibration Pulser
modules specify output signal characteristics, while the Digital Input or Analog
Input modules define incoming signals.

© 2009 Schneider Electric. All rights reserved.
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Refer to the Digital and Analog I/O technical note available from the PowerLogic
website and the ION8600 Installation Guide for more information regarding digital
and analog inputs and outputs.

1/0 Cabling

Expanded 1/0O: Molex Micro-Fit 24 pin male connector
Refer to the ION8600 Installation Guide for the Molex pin assignments.

Onboard 1/0 breakout cable: 16 bare wires

Output K Y y A
Cl1 Black Green White
C2 Blue Orange Red
c3 White wire Orange wire Red wire
Black marking Black marking Black marking
ca Black wire Blue wire Green wire
White marking Black marking Black marking
S1 S2 S3 SCOM
Input (status) Green wire Red wire Black wire Blue wire
White marking White marking Red marking White marking
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Specifying an 1/O Port in an ION Module

The Digital Output, Digital Input, Analog Output, Analog Input, Pulser, and
Calibration Pulser modules have Port setup registers that allow you to specify
which port handles the outgoing or incoming signals. To assign a port to one of
these modules, simply modify the Port setup register by picking a port from the
enumerated list. This can be done with both Designer component of ION
Enterprise and ION Setup.

EthernetSite - EthernetD x|
Inputs  Setup Reqgisters | Dutput Fegisters
Parameters: D071 EvLlogMode  Log Off |kzert,..
007 Polarity Hon-lverting —l
D071 Pulzetidith i
D1 Port NotUsed ﬁl
Edit... |
Select DO1 Port E3
INDtLIsecI ﬂ
1/0 Exp FamC 1 —
140 Exp FarmlC 2 1.
1/0 Exp FormC 3 —
140 Exp FarmlC 4
1/0 Exp Forme, 1 ~
Serd | Cancel | Help |

The image above shows the enumerated list of the Port setup register as it is seen
in ION Setup. Be aware that the list only displays those ports that are not yet
assigned to another module. For example, the meter’s factory configuration makes
use of Digital Output DO4 (it is already assigned to Calibration Pulser module
“kWh Pulser -D4”). If you create a new Digital Output module and set its Port
setup register, the port DO4 does not appear in the list of available ports.

To make a port available, you must locate the module controlling the port and set
its Port setup register to NOT USED (or delete the module entirely). The port now
appears in the enumerated list.

[ Modify Enumerated Register E3
Options:

INotUsed

The enumerated list only

|'»

shows those ports which have Part DO
not already been assigned to Part D02
another module. Part DO3
Port DO4 has already been Ez::y 212
assigned to another module, Helaﬁ A3 b
so it is absent from the list. Alarm LED
|/0 Exp FarmC 1
1/0 Exp FormC 2 il

Ok I Cancel
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Configuring Other Energy Pulsing Applications

To configure these LED outputs for other energy pulsing applications (for
example, kVAh), link the appropriate MU Power Meter module output to the
input of the Calibration Pulser module using Designer software.

The following table describes the ports that can be configured (in the Digital
Output, Pulser, Digital Input, Analog Output, and Calibration Pulser modules) to

handle outgoing or incoming signals.

2\ NoTe

You must confirm the meter I/O options (onboard
following apply to your meter.

and/or Expander 1/O) to determine which of the

Digital Output Port Names

Description

Port RA-1 Digital (Form A Solid State) Output port 1
Port RA-2 Digital Output port 2

Port RA-3 Digital Output port 3

Port RC-1 Digital (Form C Relay) Output port 1

Port RC-2 Digital Output port 2

Port RC-3 Digital Output port 3

Port RC-4 Digital Output port 4

kWh Pulse —-LED LED Output

kVARh Pulse —LED LED Output

Analog Output Port Names

Description

Port Analog Out 1

Analog Output port 1

Port Analog Out 2

Analog Output port 2

Port Analog Out 3

Analog Output port 3

Port Analog Out 4

Analog Output port 4

Digital Input Port Names

Description

Port DI-S1 Digital (Status) Input port 1 (I/O Expander)
Port DI-S2 Digital Input port 2 (I/O Expander)
Port DI-S3 Digital Input port 3 (I/O Expander)
Port DI-S4 Digital Input port 4 (/O Expander)
Port DI-S5 Digital Input port 5 (I/O Expander)
Port DI-Sé Digital Input port 6 (I/O Expander)
Port DI-S7 Digital Input port 7 (/O Expander)
Port DI-S8 Digital Input port 8 (I/O Expander)
Port DI-S9 Digital Input port 9 (Onboard 1/0O)
Port DI-S10 Digital Input port 10 (Onboard 1/O)
Port DI-S11 Digital Input port 11 (Onboard 1/0)
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Using the Onboard Digital Outputs

Digital outputs are used for hardware relay control or pulse counting applications.
For example, an ION meter’s digital outputs can provide on/off control signals for
capacitor banks, generators, and other equipment. The digital output ports can
also send out status signals or kWh pulses, if the receiving device determines
energy usage by counting pulses.

Onboard I/O for the ION8600 meters provides four Form C digital outputs and
three Form A digital inputs. You can use a Form A digital input to monitor a
breaker to verify how many times the breaker trips. When the breaker has reached
its limit for the number of trips, you can use the digital output to light an LED next
to the breaker so field personnel are alerted. You can also use a Form C digital
output to send KYZ pulsing information to third-party system equipment.

All digital outputs can deliver a continuous signal or a pulse. (Contact Schneider
Electric for complete information regarding relay applications.)

/\ DANGER

Do not use the meter outputs for primary protection functions. These include applications where the

devices perform energy limiting functions or provide protection of people from injury.
Failure to follow these instructions will result in death or serious injury.

These outputs can be controlled by Digital Output modules, Pulser modules, or
Calibration Pulser modules, depending on the application. For relay and control,
the Digital Output module is used. For pulsing applications, the Pulser and
Calibration Pulser modules are generally used. All of these modules can act as
intermediaries between the hardware port and the other modules in the meter.
They define the characteristics of outgoing signals.

Output Modules

Both the Form A and Form C relays can be controlled with Digital Output
modules, Pulser modules, or Calibration Pulser modules. By default, six Digital
Output modules (labeled DO RA-2 to DO RA-4 and DO RC-1 to DO RC-4) are
already created for this purpose. You can either use these modules, or create and
configure other modules to control the output ports.

¢ Calibration Pulser modules allow you to generate high accuracy energy pulses
for calibration testing purposes. They integrate instantaneous power inputs.

¢ Digital Output modules accept Boolean inputs, and output a continuous signal
or pulses.

¢ Pulser modules convert instantaneous pulses to pulses or transitions.

Consult the ION Reference if you require more information about these ION
modules.
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Configure the settings of the controlling module to match your requirements. The
settings in these modules are as follows:

ION Module | Setup Registers Available Settings Creation Default Description
Not Used
1/O Exp FormC 1
1/O Exp FormC 2
1/O Exp FormC 3
1/O Exp FormC 4
1/O Exp FormA 1
Port 1/O Exp FormA 2 Not Used The output hardware channel
1/O Exp FormA 3
1/O Exp FormA 4
. On-Board Form C 1
Digital Output On-Board Form C 2
On-Board Form C 3
On-Board Form C 4
Pulse Width 0 t0 2000000 0 Pulse Width, in seconds
(O for continuous pulse)
Polarity Inverting or Non-Inverting Non-Inverting Inverted or non-inverted output
Whether or not to log status changes in
EvLog Mode Log on or Log off Log off the Event Log
Port As per Digital Output, above Not Used The output hardware channel
I PulseWidth 0.020 to 2000000 1 Pulse width, in seconds
Pulser
OutputMode Pulse or KYZ Pulse Full pulse or KYZ (transition pulse)
Polarity Inverting or Non-Inverting Non-Inverting Inverted or non-inverted output
Port As per Digital Output, above Not Used The output hardware channel
Pulse Width 0.010 to 1.000 0.05 (5A meter) Pulse Width, in seconds
I 0.02 (TA meter)
Calibration
Pulser! Kt 0.01 to 1000000000 1.8 Watts per pulse
Int Mode Forward, Reverse, Absolute, or Net | Absolute Integration modes that may be selected
OutputMode Pulse or KYZ Pulse Full pulse or KYZ (transition pulse)
! See “Calibration Pulsing Relay DO4,” below.
Ensure that the module’s Port setup register matches the meter’s output you want
to control. If the port you want to use does not appear in the Port setup register’s
list, that port is in use by another module. Edit the port setup register of the module
using that port and set it to NOT USED - the port will then be available to other
modules.
Calibration Pulsing Relay DO RC-4
Solid-state relay DO RC-4 is factory configured for calibration pulsing and
requires no further setup. The Calibration Pulser module labeled kWh Pulse-LED
controls this port. By default, the module is linked to the kW del+rec output of the
Arithmetic module labeled “KW del, rec” (this Arithmetic module is linked to the
MU Power Meter module’s MU kW tot output). The port will output a pulse for
every 1.8 Wh accumulated (in NORMAL or TEST mode). This is the same pulsing
rate as the LEDs on the front panel of the meter.
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Using the Onboard Digital Inputs

Digital inputs are necessary for status monitoring or pulse counting applications.
Status monitoring can help you prevent equipment damage, improve
maintenance, or track security breaches. Some common status monitoring
applications are monitoring the closed/open positions of breakers, on/off status of
generators, armed/unarmed conditions in a building alarm system, and
over/under pressures of transformers.

The function of each status input is controlled by a Digital Input module; this
module tells the meter how to interpret incoming signals. Digital Input modules
can be linked with other modules for counting status changes.

2\ NOTE

The onboard status inputs cannot be used for voltage sensing applications. Also note that your meter
template (default configuration) may have factory configured Digital Input modules.

The settings in the Digital Input modules are as follows:

Setup Register | Available Settings Default Description
Input Mode Pulse, KYZ Pulse Specifies complete pulse or KYZ transition pulse
EvLog Mode Log On, Log Off Log Off Specifies whether or not to log status changes
Debounce numeric 0.015 Setting for the mechanical contact bounce, in seconds
Polarity Iﬁi‘j&?fﬁgl\l_ II:I(\)/EIR_TING Specifies a Non-inverted (or level) pulse
I/O MODULE IN1 7o
Port I/O MODULE IN 8, NOT USED Specifies which hardware port the module controls
NOT USED

© 2009 Schneider Electric. All rights reserved.
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Analog Outputs

An ION meter’s analog outputs act as transducers. The meter measures power and
energy, and then sends that information via the analog outputs to a remote
terminal unit (RTU). The analog outputs provide industry standard 0 to 20 mA
current signals.

Four Analog Output modules control the optional I/O Expander’s analog output.
These modules are not linked or configured. Link the numeric output of another
ION module to the Source input of the Analog Output module —this value is
represented on the I/O Expander’s analog output port. Setup the Zero Scale and Full
Scale setup registers of the Analog Output module to the numeric range you want
to emulate. The settings in these modules are as follows:

Analog Output Module
Setup Registers Available Settings Default Description
1/O EXP AnOut 1 to .
Port /O EXP AnOut 4, U?E'II'D SEeaﬁels the output hardware
NOT USED channet

Sets the measured value that will
Full Scale 1x102 to 1x10? N/A create the maximum possible output
on the analog output hardware port.

Sets the measured value that will
Zero Scale 1x10% to 1x107 N/A create the minimum possible output
on the analog output hardware port.

Ensure that the module’s Port setup register matches the I/O Expander’s output
you want to control. If the port you want to use does not appear in the Port setup
register list, that port is in use by another module. Edit the Port setup register of
the module using that port and set it to NOT USED - the port is then available to
other modules.

See the ION8600 Meter I/O Expander Installation and Basic Setup manual and the
technical note Digital and Analog I/O available from the website for more
information.

Setting the Zero and Full Scales

You control external devices by delivering a specific current or voltage that is
proportional to the source input. This is done by setting the Full and Zero Scale
setup registers and the hardware Port that the output is sent to. Use Designer
software to configure these setup registers in the Analog Output module.

The Zero Scale setup register defines the source input value that creates the
minimum current output on the analog device.

The Full Scale setup register defines the source input value that creates the
maximum current output on the analog device. The Full Scale is determined by the
input to the Analog Output ION module (which is commonly connected to kW).
The Full Scale value is the maximum kW expected.
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The following table describes setting your Zero Scale and Full Scale to use a limited
portion of the output's range.

2\ NOTE

This table assumes the source input varies between zero and the full scale setting. If the source input falls
below zero the output will not be within the desired Output Range.

Ovutput Type Desnl'!e:n;):tPM Zero Scale setting Full Scale setting
110 1 mA Oto 1 mA negative value of Full 1000
© Scale (e.g. -1000) ¢-9:
negative value of Full
0 to 20 mA Scale (e.g. -1000) e.g. 1000
-20 to 20 mA
-1.5 times value of
41020 mA Full Scale (e.g. -1500) | &9 1090
-0.25 times value of
0to 20 mA 410 20 mA Full Scale (e.g. -250) e.g. 1000

See the ION8600 1/O Expander Installation Guide and the technical note Digital and
Analog I/0 for more information.
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Energy Pulsing

This chapter provides instructions for configuring energy pulsing on your meter.

In this chapter

@ Infroduction ....... ..ol 138
o Configuring Energy Pulsing .. .......... ... ittt 138
Using the Front Panel ................ .. ... ... .. oot 138
UsingION Setup ............ 138

Using Designer .......... ... ... i 139

Pulser Module Settings ........... ... i 139
Calibration Pulser Module Settings ......................... ... ... ..., 140
Energy Pulsing with LEDs ........ ... ... .. i 141
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Introduction

Your meter uses Calibration Pulser modules and Pulser modules for energy
pulsing.

The Pulser module serves as an intermediary between other modules’ pulse
output registers (accepting them as pulse inputs) and a hardware output channel

on the device. These modules are capable of sending pulses or pulse transitions to
any hardware output channel.

The Calibration Pulser module is a highly accurate energy pulser used for
verifying calibration on meters employed in billing applications. This module type
serves as an intermediary between the power (kW, kVAR or kVA) outputs of the
Power Meter module and a device’s hardware output channel.

See the ION Reference for more information on these modules.

Configuring Energy Pulsing

Use ION Enterprise or ION Setup software to change your meter’s energy pulsing
settings.

Using the Front Panel

You cannot configure Energy Pulsing using the front panel.

Using ION Setup

The Energy Pulsing Setup Assistant helps you configure the Calibration Pulser
modules.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to Inputs/Outputs > Energy Pulsing

Setup Assistant E
Template Kwth Del | kiwh Rec | KR Del | KvARh Rec | End of Interval |
Basic Setup
Security Blloves you to program kiwh Delivered pulsing via digital outputs.
[Z] Communications

E= Port Settings

E 3rd Party Protocols
Clock.
== Demand CAPIEL 18
(23 Inputs/Dutputs CAP3 Pulze Width 0.1

= LED Puking CAP3 Outputbode K2

- CAPS Port Motlzed

EETEDy YT Wh del ovild "Not Available'

== Analog Outputs
(C Loaging
[C] Revenue
Power Cuality
== Dizplays
== ‘erification
== Feports

Edit |
< Back | Mest » Exit Help
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3. Click any of the first four tabs; each tab corresponds to a Calibration Pulser
module. Configure each module as necessary.

4. Click the End of Interval tab to configure the end of energy pulsing.

You can configure the Calibration Pulser and Pulser modules using Advanced

Mode.

1. Connect to your meter, using Advanced Mode.

2. Click the module you wish to configure.

Using Designer

Open your meter in Designer and navigate to the Energy Pulsing Setup
Framework. Right-click a module to edit.

Pulser Module Settings

The Pulser module contains the following setup registers:

h .
Se P Function Default
Register

Pulse Width This register specifies the width of the output pulses (in 1
seconds).

OutputMode This register defines whether the output is a complete pulse or Pulse
a transition pulse (KYZ).

. This register specifies the polarity of a pulse output. It has no . .

Polarity effect if OutoutMode is KYZ. Non-inverting
This register specifies which hardware port the output appears

Port on. Only those hardware channels that are still available Not Used
appear in this list.

Five common parameters (kWh del, kWh rec, kVARh del, kVARh rec, and kW sd
del) are already linked to the Pulser modules for you.

2\ NOTE

By default, no hardware channel is pre-selected. To make use of these links, you must configure the Pulser

modules’ Portsetup registers to the appropriate hardware port that receives the output.
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Calibration Pulser Module Settings

Configure the solid-state output D4 for calibration pulsing by editing the setup
registers of the module labeled “kWh Pulser -D4”. By default, the output on a
standard meter generates a pulse for every 1.8 Wh accumulated. This is the same
pulsing rate as the middle front panel LED (controlled by a Calibration Pulser
module labeled “kWh Pulser -LED”). Modify the pulsing rate of either channel by
changing the value of the Kt setup register of the Calibration Pulser module
controlling them (see below).

The following setup registers are available in the Calibration Pulser module:

Setup Register

Function Default

Pulse Width This register specifies the width of the pulses sent to the hardware channel (in seconds). The
Calibration Pulser module maintains a minimum duty cycle of 50% on the output pulse train.

0.05

The numeric bounded register defines how much energy the module accumulates before a pulse is
Kt sent to the hardware channel. An industry standard for energy pulsing is 1.8, or one pulse per 1.8 1.80
energy-hours.

Int Mode Specifies the modes of integration that may be selected. Absolute
OutputMode '(I';Ylsz)reglsfer specifies whether the output is a complete pulse (Pulse) or a change of state transition Pulse

Port

This register specifies which hardware port the pulse/KYZ transition appears on. Only those hardware
channels that are still available appear in this list.

Not Used
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Energy Pulsing with LEDs

@ ©

The two LEDs on the front panel are preconfigured for energy pulsing. The
adjacent smaller infrared outputs are connected to the LEDs and pulse at the same
rate.

The LED's pulse rate can be adjusted by modifying the Kt setup register in the
Calibration Pulser module. The value entered defines how much energy the
module accumulates before a pulse is sent to the hardware channel. The front
panel WATT and VAR LEDs are factory set to the same pulse rate. The Kt value is
shown on your meter’s front panel label; the default setting for Kt depends on the
form factor your meter services.

LED pulse indicators Infrared pulsers

Kt value for the

meter

WATT - LED and VAR - LED

Like solid-state relay output DO4, the WATT — LED is controlled by a Calibration
Pulser module that has its Source input linked to the kW del+rec output of the
Arithmetic module labeled “KW del, rec”.

Similarly, the VAR — LED is controlled by a Calibration Pulser module that has its
Source input linked to the kVAR del+rec output of the Arithmetic module labeled
“kVAR del, rec”.

¢ For Form Factor 9S, 39S, 365, and 76S meters, the default pulse rate of the front
panel WATT LED is 1.8 (1.8 Watt-hours per pulse). The VAR LED's Kt value is
also 1.8.

¢ For Form Factor 355 meters, the default pulse rate of the front panel WATT LED
is set at 1.2 (1.2 Watt-hours per pulse). The Kt value for the VAR LED's is also 1.2.

Customizing Energy Pulsing

Changing the value for the Kt setup register of the controlling Calibration Pulser
module lets you modify the pulsing rate of either channel. If you want to configure
the LED port for a different pulsing application, you must re-link the Source input
to the output register of a different instantaneous power quantity in one of the
Arithmetic modules. Ensure that the quantity you choose originates from the MU
(meter units) Power Meter module.

© 2009 Schneider Electric. All rights reserved.

Page 141



Chapter 11 - Energy Pulsing PowerLogic ION8600 User Guide

Page 142 © 2009 Schneider Electric. All rights reserved.



Chapter

12

Logging

The ION8600 meter has powerful data logging and event recording capabilities.
Data and event logs recorded by the meter are prioritized and stored onboard.
Data is retrieved periodically by the ION Enterprise software Log Server (or other

third party application).

If you use ION Enterprise software, all retrieved data from your system is stored
in an ODBC-compliant database. The information in the database can be viewed
and analyzed using ION Enterprise software applications such as Vista (for

viewing), or reporting tools (for organizing and presenting data).

In this chapter

@ Datalogging ......cvviiiiiiiiiiiiiinienennennennenns
Configuring Data Logging .................. ... ... it
Using the FrontPanel ........... ... .. .. ....... ... ... ...

Using ION Setup ...
Changing Waveform Recording ............................

Default Logging Capacity ................ ...
Changing the Log Depths ........... ... .. ......... ... ...
Changing the Frequency of Logging .........................

Default Logging Configuration .............................
Viewing DataLogs .......... ... ... i i

@ Eventlogging .......coviiiiiiiiiiiiii it
ION Event Priority Groups ............................. ...,
External ION Events ............. ... ... ...t

Displaying Events ............. ... i

¢ Logging and Recording Capacity . ........cooviiiiiinnnn.n.
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Data Logging

The meter ships with a comprehensive data-logging configuration. Information
regarding the default logging capacity and default logging configuration can be
found in “Default Logging Capacity” on page 146.

To learn more about the data recorder modules in your meter, refer to the
ION Reference.

Configuring Data Logging

Use ION Enterprise or ION Setup software to change your meter’s logging
settings.

Using the Front Panel

You cannot configure Logging using the front panel.

Using ION Setup

The Logging Setup Assistant helps you configure meter data logging.
1. Open ION Setup and connect to your meter, using Basic Mode.
2. Inthe Setup Assistant, navigate to the Logging folder.

Use the two screens (Memory, Load Profile) to configure your logging settings.

Memory Screen

3. Select the Memory screen to re-allocate meter memory.

Setup Assistant E
Template Status |
Basic Setup
Security Bllowes you to allocate the meter log memory.
[Z] Communications
E= Port Settings
E= i Party Protocols
== Clock
Demand Log | Allocated | Cruration | Fecords | o
(2 Inputs/Outputs Load Profile 2.40% FE0days 3360
[C] Logaing Event Log 0.34% MAA 500
B Memory Wwaveforms 3.88% WA 50
= Load rofile EquDmd Log FARES A 0days 33680 2 —
= Evenue Harm high Log 1.18% 3B 0day: 840
= . Harm mean Log 1.158% 3B 0day: 840
Powier Qualty Hist high Log 753%  B0das 330
== Displays Hizt lows Log 7R3 FE0days 3360 LI
Werification
Reparts Log kemaory: 3840 Kb InUsze: 7E5% Available: 23.5%
Edit |
< Back | Mest » | Exit | Help |

4. Select the Log you wish to configure and click Edit. You can change both the Log
Duration (days) and the Log Size (records). Notice how changing these
parameters affects the meter memory allocated to that log.
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Load Profile Log Screen

5. Select the Load Profile Log screen to configure Data Recorder #1 (the Revenue

Log).
Setup Assistant E
= Template Charinels | Interval.-"DepthI
Basic Setup
= Security Blloves you to program the load profile channels.
[Z] Communications
== Port Settings
== 3rd Party Protocols
-= Clock
== Demand Source 10 kKw'h del int -
2 Inputs/Dutputs Source 20 KVARh del int
(2 Logging Source 3 Kiwih rec int
— Source 4 KMARh rec int
== Memory Source 5
B8 Load Profile Source B
[C1 Fieverue Source 7
== Power Quality Source 8
= Source 3
== Displays Source 10
== “erification Source 11:
== Feports Fource 12: LI
e
< Back | Mest » | Exit | Help |

6. Click the Channels tab to access the Data Recorder #1 Sources. Select a source.

¢ Click Unlink to unlink the parameter from the source.

¢ Click Edit to edit the parameter. The Parameter Selection window appears,
showing source register groupings. Click on the ‘+ symbol beside the
register group to view the individual registers. Select the register you want
to connect to the source and click OK.

Parameter Selection E

Setup Assistant E
= Template Charinels | Interval/Diepth I
= Baszic Setup
E= Security Wllowes you to program the load profile channels.
C icati [ Energy - Interval
(2 Commurications Parameter Selection E I o kwh del int
kKiwihi rec int

nergy - Pulses

nergy - Cumulative
nergy - TOU Cumulative
emand - Block

- Diemand - TOU Black

[~ Show all available registers

| | L - | /

0];8 | Cancel |

- kish del int
- kWah rec int

- MU 13" 2h int

0K

- MU Wln a"2h int
MU WIn b 2h int
- MU Wln & 2h int

[~ Show all available registers

-

Help |

Help |

You can also select the “Show all available registers” checkbox for a
complete listing of all possible registers.

2 NOTE

Use Energy - Pulses registers save Revenue Log data in MV-90 P-File data format.

7. Click the Interval/Depth tab to edit the Load Profile log interval and duration.
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Changing Waveform Recording

The Waveform Recorder modules do not require changes to their default settings.
If you want to change the format of the recorded waveforms, refer to the
Waveform Recorder module description in the ION Reference.

Default Logging Capacity

The following table summarizes the default recording depths and recording
intervals of the various Data recorders and Waveform recorders in the meter.

Log Types D|0N8600C ION8600B ION8600A Inferval
efault Depth | Default Depth | Default Depth
Revenue Log 3360 3360 3360 900 seconds
Energy Logs Loss Log N/A 3360 3360 900 seconds
EgyDmd Log N/A 1350 3360 900 seconds
Time of Use Logs TOU Logs N/A 50 50 Triggered on demand
Historic Logs Hist Logs N/A N/A 3360 900 seconds
Harmonic Logs Harm Logs N/A N/A 840 3600
Disturbance Recorders Transient Log N/A N/A 100 Triggered on demand
Sag/Swell Log 100 100 100 Triggered on demand
SagSwellState Log 3000 3000 3000 Triggered on demand
EN50160 Logs (ION8600A only) N/A N/A 10 Daily, weekly, 10 min...

Changing the Log Depths

Change the value in the Data Recorder’s Depth setup register to increase the
number of records stored in the recorder. The RecordMode setup register controls
how the Data Recorder will overwrite old records; refer to the Data Recorder
module description in the online ION Reference before changing this setup register.

Changing the Frequency of Logging

The five Periodic Timer modules that control the frequency of different data
recording are as follows:

¢ “Revenue Log Trg” controls the frequency of the logging of revenue values
¢ “Loss Log Trg” controls the frequency of Loss Compensation Data logging

¢ “EgyDmd Log Trg” controls the frequency of logging for the Energy and
Demand Log (this log is used for generating reports using Reporter)

¢ “Hist Log Trg” controls the frequency of Historic Data logging

¢ “Harm Log Trg” controls the frequency of Harmonics logging
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Hist Mean Log

VIl ab mean

CAUTION

Programming your meter to write any data recorder at continuous intervals lower than 60 seconds (heavy
logging configuration) may cause loss of data in the event of a power failure. Use of an uninterruptible
power supply (UPS) is recommended for such heavy logging configurations.

Change the value in the Period setup register to change the frequency of data
logging (Period values are specified in seconds). Do not change the Sync Mode
setup register.

Default Logging Configuration

The following sections describe each Data Recorder and the parameters they log.

Revenue Log

The Revenue Log (Data Recorder #1) is configured for use with UTS MV90 billing
software. The Revenue log is located through the following folder path on the
meter’s program: Advanced Configuration > Revenue Framework > Energy. The
default values logged by the Revenue Log are as follows:

Parameter Description Parameter Description
kWh del int Interval kWh delivered kVARh del kVARh delivered
kWh rec int Interval kWh received kVARh rec kVARh received
kVARh rec int | Interval kVARh delivered kVAh del kVAh delivered
kVARh rec int | Interval kVARh received kVAh rec kVAh received
kVAh rec int Interval kVAh delivered kWh loss int I(fll.:::/j_l IEY::) fotal losses
kVAh rec int Interval kVAh received kVARh loss int Interval kWh total losses
kWh del kWh delivered Period Length Logging Period in seconds
kWh rec kWh received Period Status Logging Period verification

Historic Data Logging

Three data recorders are used to record “standard” power system quantities, such
as phase current, phase voltage and power factor. These recorders are labeled Hist
Mean Log, Hist High Log, and Hist Low Log. They are located through this folder
path on the meter’s program: Advanced Configuration > Historic Data Logging.
By default, they log the following ION output register values:

| avg mean
VIl bc mean | 4 mean
VIl ca mean kW tot mean

VIl avg mean

kVAR tot mean

V unbal mean

kVA tot mean

la mean PF lag mean
Ib mean PF lead mean
Ic mean Freq mean

Hist High Log Hist Low Log
VIl ab high | avg high Vil ab low | avg low
VIl be high | 4 high VIl be low | 4 low
VIl ca high kW tot high VIl ca low kW tot low
VIl avg high kVAR tot high VIl avg low kVAR tot low
V unbal high kVA tot high V unbal low kVA tot low
la high PF lag high la low PF lag low
Ib high PF lead high Ib low PF lead low
Ic high Freq high Ic low Freq low
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Loss Log

One Loss Log recorder is configured to record loss values. It is located in the
following folder path on the meter’s program:

Advanced Configuration > Revenue framework > Energy framework.

By default, it logs the following ION parameters -- note that the parameters differ
depending on the meter template:

Template Loss Log Parameter Description
35S and Default MU la ™ 2h int Phase A interval current squared hours
35S and Default MU Ib " 2h int Phase B interval current squared hours
35S and Default MU lc” 2h int Phase C interval current squared hours
35S only MU VIl ab ™ 2h int Phase A interval voltage Line-to-Line squared hours
35S only MU VIl bc ™ 2h int Phase B interval voltage Line-to-Line squared hours
35S only MU VIl ca ™ 2h int Phase C interval voltage Line-to-Line squared hours
Default (95-395/36S-765) MU VIn a” 2h int Phase A interval voltage Line-to-Neutral squared hours
Default (95-395/365-769) MU VIn b 2h int Phase B interval voltage Line-to-Neutral squared hours
Default (95-395/36S-76S) MU Vin ¢ 2h int Phase C interval voltage Line-to-Neutral squared hours

Harmonics Logging

Two recorders provide various harmonics logs, including K-factor and Total
Harmonics Distortion (THD). These recorders are labeled Harm Mean Log and
Harm High Log. They are located through the following folder path on the meter’s
program: Advanced Configuration > Harmonics Logging.

By default, they log the following ION output register values:

Harm Mean Log Harm High Log
V1 THD mean 11 K Fac mean V1 THD high 11 K Fac high
V2 THD mean 12 K Fac mean V2 THD high 12 K Fac high
V3 THD mean 13 K Fac mean V3 THD high I3 K Fac high
1 THD mean I1 THD high
|2 THD mean 12 THD high
I3 THD mean I3 THD high

Time-of-Use Logging

Six data recorders are used to record energy and demand values based on the rates
(A, B, C, D) set in the Time of Use (TOU) module. These recorders are labeled as
follows: TOU kWh Log, TOU kVA(R)h Log, TOU kW/VAR sd Log, TOU kW/VAR td
Log, TOU kVA sd Log, and TOU kVA td Log. They are located through the following
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folder path on the meter’s program: Time of Use. By default, these data recorders

log the following ION output register values:

TOU kWh Log TOU kVA(R)h Log TOU kW/VAR sd Log
kWh del A kVARh del A kVAh del A kW sd mx del A kVAR sd mx del A
kWh rec A kVARh rec A kVAh rec A kW sd mx rec A kVAR sd mx rec A
kWh del B kVARh del B kVAh del B kW sd mx del B kVAR sd mx del B
kWh rec B kVARh rec B kVAh rec B kW sd mx rec B kVAR sd mx rec B
kWh del C kVARh del C kVAh del C kW sd mx del C kVAR sd mx del C
kWh rec C kVARh rec C kVAh rec C kW sd mx rec C kVAR sd mx rec C
kWh del D kVARh del D kVAh del D kW sd mx del D kVAR sd mx del D
kWh rec D kVARh rec D kVAh rec D kW sd mx rec D kVAR sd mx rec D
TOU kW/VAR td Log TOU kVA sd Log TOU kVA td Log

kVA sd mx del A

kVA sd mx del A

kVA td mx del A

kVA td mx del A

kVA sd mx rec A

kVA sd mx rec A

kVA td mx rec A

kVA td mx rec A

kW td mx del A kVAR td mx del A
kW td mx rec A kVAR td mx rec A
kW td mx del B kVAR td mx del B

kVA sd mx del B

kVA sd mx del B

kVA td mx del B

kVA td mx del B

kW td mx rec B

kVAR td mx rec B

kVA sd mx rec B

kVA sd mx rec B

kVA td mx rec B

kVA td mx rec B

kW td mx del C

kVAR td mx del C

kVA sd mx del C

kVA sd mx del C

kVA td mx del C

kVA td mx del C

kW td mx rec C

kVAR td mx rec C

kVA sd mx rec C

kVA sd mx rec C

kVA td mx rec C

kVA td mx rec C

kW td mx del D

kVAR td mx del D

kVA sd mx del D

kVA sd mx del D

kVA td mx del D

kVA td mx del D

kW td mx rec D

kVAR td mx rec D

kVA sd mx rec D

kVA sd mx rec D

kVA td mx rec D

kVA td mx rec D

For more information refer to “Configuring Time of Use” on page 161 as well as
the TOU module description in the online ION Reference.

ION Enterprise Reporting

One data recorder is configured to provide power system data for the reporting
tools component of ION Enterprise software. It is located through the following
folder path on the meter’s program: Advanced Configuration > Revenue
Framework > Reporting. This recorder is labeled Egy Dmd Log. If any input links
to this module are changed, the reporting tools in ION Enterprise will not be able
to create reports from the device’s logs. If you use ION Enterprise reporting tools,
do not change the parameters that are logged in the Egy Dmd Log.
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Sag/Swell and Transient Logging

Three data recorders provide details of these power quality events. They are
located through the following folder path on the meter’s program:

Advanced Configuration > Power Quality > Sag/Swell/Transient Detection.
The Sag/Swell and Transient data recorders, by default, log the following ION
output register values:

Sag/Swell Log

DistDur DistV2Engy DistV1Engy DistV3Engy
DistV1Min DistV3Min DistV2Min DistNominal
DistV1Max DistV3Max DistV2Max SwellLim
DistV1Avg DistV3Avg DistV2Avg Saglim

Transient Log

TranV1Dur TranNominal TranV2Max PT Sec
TranV1Max Threshold TranV3Dur CT Prim
TranV2Dur PT Prim TranV3Max CT Sec

The SagSwellState data recorder provides additional information required by the
Sag/Swell and Transient logs.

Refer to “Configuring Power Quality Event Logging” on page 167 for enabling or
disabling Sag/Swell and Transient events from being recorded in the Event Log.

2\ NOTE

Modification of the Sag/Swell, Transient and SagSwellState logs is an advanced procedure and should

only be undertaken by experienced users familiar with ION and the interaction of these data recorders.

High Speed Modules in the ION8600C

In the ION8600C meter, the update period for the following modules are 1-second.
Measurement periods for these modules are configured in Designer or ION Setup.

Alert Module Modbus Slave Module
And/Or Module One-Shot Timer Module
Convert Module Pulser Module

Digital I/O Module Pulse Merge Module
Display Module Sag/Swell Module

DNP Slave Export Module Setpoint Module
Min/Max Module

EN50160 Compliance Logging

For more information about EN50160 data logging, refer to the technical note
Power Quality: ION Meters and EN50160.
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Viewing Data Logs

See the Report chapter. You can also view Data Logs using ION Setup.

1.
2.

Open your meter in ION Setup, using Basic Mode.

Navigate to View > Data Screens > Data Recorders. The following logs are
available for viewing:

Average Harmonics

Energy & Demand

Historic Average, Historic Highs, Historic Lows
Maximum Harmonics

Revenue Log

Sags & Swells

Transformer Losses

Transients (ION8600A only)

® 6 6 6 6 6 o o
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Event Logging

Events produced by a meter’s various ION modules are prioritized and grouped
to facilitate custom logging. Each event is assigned a priority group number based
on its type and severity.

ION Event Priority Groups

Some event groups are preset with a Priority Number as shown in the table below.
You can also define your own priority number for some modules. Priority
numbers from 128-191 appear in the global event log viewer in ION Enterprise
software. Priority numbers from 192-255 are also logged, and additionally initiate
a beep and cause the window to flash. You can customize these responses to
display messages or perform netsend messages, for example.

Event Group Description Priority Number
Reset Module reset or re-synchronized 5
Setup Change Module setup changes (setup register changes, label changes, input handle changes) 10
Input Register Change Inputs of certain modules change value (ie, input to And/Or module changes) 15
I/O State Change I/O state changes (ie, relay closes) 20
Information Module produces important user information 25
Warning Module produces a warning 30
EN50160 Event An EN50160 Counter (N or Ny) increases 50
Loss of Potential Loss of Potential has occurred 128
Error Detected An error has been detected 255
Setpoint Setpoint condition goes Active or Inactive (ie, Sag/Swell module detects a disturbance) E:zgfglgﬂt;levm

The Event Log Controller module allows you to set a priority cutoff for event
logging. Any events with a priority number greater than the cutoff value are
logged, and events with lower priorities are discarded. Refer to the individual
module descriptions and the Event Log Controller module description in the
ION Reference for more details.

External ION Events

Some events are not produced by a specific module. These events are generated
internally by the meter. Their associated priority levels are shown in the table
below.

Page 152

© 2009 Schneider Electric. All rights reserved.




PowerlLogic ION8600 User Guide

Chapter 12 - Logging

Event Group Description Priority Number
Factory initialize performed
Firmware or memory upgrade performed
Meter power-up or power-down
Warning Internal modem not responding or modem recovered 30
Battery low
Telnet or serial terminal locked out
Security disabled or enabled
Failure Communications not able to allocate required memory 255
. I o
Displaying Events
View Events in the following locations:
Application Menu / Screen Navigation
Front Panel Event Log ALT display mode
ION Setup Event Log Setup Assistant > Reports > Event Log
Vista Meter Events System & Logs tab > Meter Events object
WebMeter N/A N/A
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Logging and Recording Capacity

The meter provides both data and event logs. The amount of memory required to
store these logs depends on the number of parameters being logged and the
frequency with which these parameters are logged.

The following equation can help determine the amount of memory required to
store data and event logs:

each record consumes (in Bytes) = [(number of parameters * 5) + §]

The meter can also perform waveform recording. It can simultaneously capture
events on all channels to a maximum of 96 cycles each.

To calculate the waveform memory usage use the following formula:

waveform memory usage (in Bytes) = [2*(number of samples per cycle) + 10]*
(number of cycles in waveform) + 30

2\ NOTE

Round up to the nearest kilobyte after each of the above calculations.
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This chapter provides instructions for configuring transformer line loss
compensation and time of use.

In this chapter
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PT/CT Correction

The primary application for PT/CT correction is to apply correction factors for ratio
errors and phase angle errors to instrument transformers. Instrument transformer
correction reduces or eliminates the need to replace transformers in installations
where high accuracy is required.

Configuring PT/CT Correction

PT/CT Correction (the Instr Xformer module in the meter’s firmware) can be
configured in the meter via ION Enterprise or ION Setup software.

Using ION Setup

In the following ION Setup example, the PT/CT Correction Setup Assistant allows
you to configure the Instr Xformer modules on the ION meters.

1
2
3.
4

Open ION Setup and connect to your meter, in Basic Mode.
Open the Revenue folder in the Setup Assistant and click PT/CT Correction.
On the ITC Correction tab, select Active Correction and click Edit.

The Transformer Connection Setup screen is displayed.

Transformer Correction Setup E

— Specify amount of provided information

Enter the number of test points that ratio cormection factors and phaze angle
errors will be specified for each input. Also enter the nominal secondary
voltage/current rating for each type of instrument transformer.

1 Woltage Inputs

il wl  we Mominal [120 =
va [

1 Curent Inputs

nfg el @ Nominal |5 |
w2 s [ Noriinal |5 =

< Back I Finizh I Cancel | Help |

5. Click the checkbox beside the Voltage Inputs or Current Inputs and click Next.
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6. The first correction screen is displayed.

¥1 Correction E

todify each test point by entering the point az a percentage of nominal with its
comesponding ratio correction factor and phase eror [in minutes).

Test Paint [X]| Fiatio Correction | Phasze Error Edit |
a

100 1.000
0% 1.000 0

< Back I Mext » I Cancel | Help |

7. Click Edit to enter the test points and click Next to move to the next correction
screen. When you have gone through all the connection screens click Finish.

2\ NOTE

You may select a maximum of eight (8) test points.

8. On the ITC Correction tab, select Active Correction and click Analyze to access
screens where you can input your wiring configuration and power system
information.

The Instrument Transformer Correction module is a core module; there is an ITC
module for each current input (11, 12, I3, I4) and for each voltage input to the meter
(V1, V2, V3). Note that the correction affects only the 1-second values in the Power
Meter module. No high-speed, harmonics, or waveform values are affected by the
correction. For more information, see the ITC (Instr Xformer) module descriptionin
the online ION Reference.
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Transformer Line Loss Compensation (TLC)

Configuring TLC

Transformer Loss Compensation is used when a meter’s actual location is different
from the electrical location where change of ownership occurs; for example, where
meters are connected on the low-voltage side of power transformers when the
ownership change occurs on the high-side of the transformer. This physical
separation between meter and actual billing point results in measurable losses.
Compensating for this loss - Loss Compensation - is the means of correcting this
meter reading. Losses may be added to or subtracted from the meter registration.

Meters are usually installed on the low-voltage side of a transformer because it is
more cost-effective. There are also cases where change of ownership may occur
halfway along a transmission line where it is impractical to install a meter. In this
case, power metering must again be compensated.

CAUTION

Due to the variation in installations, advanced knowledge of power systems and connection methods is
required before transformer loss compensation can be properly implemented. Data parameters should
only be programmed by qualified personnel that have appropriate training and experience with
Transformer Loss Compensation calculations.

For more information, see the latest version of the Transformer Line Loss
Compensation technical note.

Use ION Enterprise or ION Setup software to change your meter’s TLC settings.

Using the Front Panel

You cannot configure Transformer Line Loss Compensation using the front panel.

Using ION Setup

The Revenue Setup Assistant helps you configure TLC. The Transformer Loss
screen allows you to enable/disable TLC, choose which method you prefer (1 or 2)
and configure TLC settings.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. Inthe Setup Assistant, navigate to Revenue > Transformer Loss
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3. First, enable TLC by selecting Loss Comp Enble and clicking the Edit button.

Setup Assistant

= Template
= Baszic Setup
== Security

[Z] Communications

== Demand
(C Inputs/Outputs
(C Loaging
[C] Revenue

= Time of Uz
= Power Quality
= Werification
= Reports

o
£

== PT/CT Carrection
Transformer Loss

Methad Selection | Test Sheetl #Loss Eonstantsl

Thiz specifies if meter readings are loss compensated or nat.

=
Comp Mthod Slct - Method 1

\ E dit |

< Back | Mest » | Exit |

Help |

4. Select Comp Enabled from the drop-down list and click OK.

5. Next choose the TLC method you wish to use by selecting Comp Mthod Slct and
clicking the Edit button.

Select Method 1 to use the Test Sheet method and Method 2 to use the %Loss
Constants method.

6. Finally, click the tab of the TLC method you chose in the previous step and
configure the settings for that method.

Using Vista

Click the Loss Compensation button in the Revenue screen to access the Loss
Compensation screen:

1. Launch Vista.

2. In the User Diagram screen that appears, click the Revenue button.
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3. Click the Loss Compensation button. The following window appears:

Click here to enable
Loss Compensation
calculations

Choose eithe

Loss Compensatio
{click radio buttons tg nge state)

ation Mode

r the Test

Sheet or %Loss Constants
compensation method

Loss Compensation Method

pensation  Disabled

=]
@ —

@  Method 1 ("Test Sheet" method)

are
ss Compensation  Enabled

©  Method 2 ("%Loss Constants” method)

Mote:

If Loss Compensation is enabled, all billing parametars

compensated,

{click boxes, enter value and then press the Enter key)

- Loss Calculation - Method 1 crsnesetios)
q

Loss Calculation -

Supply Sida Lina  Load Sida Lina

g

Indicate if meter location is supply side
or load side

Indicate if meter location is transformer
side or not

= o Instrument Transformer
Mot Transfarmer Transfarmer ratios (primisec)
Side Side

Instrument Transformer information PT ratio:
PT ratio: Primary W1l rated: CT ratio:

L o ]

CT ratio:

Transformer Losses
kv rated:

er Tranzformer Ratio:

Copper Loss Compensation
LWFe (no-laad):

Lo ]
Lo ]
L o ]

{* Enabled
L Cu (full-load): ™ Disabled
Supply Side Line Loss
| wwow [0 ]
Line Length: u] )
Resistance/Unit Length: 1] s lIl
Reactance/Unit Length: o Reactance/Unit Lengt

Method 2 '%Loss Constants Method")

Meter Information

Rated Meter Voltage:

1/2 Class Meter

II

# Stator Elements

Iron Loss Compensation
{* Enabled

" Disabled

WLNWF e:
WLWF e

[ o ]
L o ]

L

These are the true instrument
transformer ratios. Normally
they coincide with the Power
Meter module’s setup.

4. Configure your values as required.

See the Transformer Loss Compensation technical note for more details on this feature.
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Time of Use

The Time of Use module may only be important if you are using the meter in a
billing application (i.e. you are a power provider), as the module contains the
meter’s seasonal rate schedules. Typically, power consumers do not require Time

Of Use configuration.

See the ION Reference for more information on the Time of Use module.

Configuring Time of Use

Use ION Enterprise or ION Setup software to change your meter’s Time of Use
settings.

Using the Front Panel

You cannot configure Time of Use using the front panel.

Using ION Setup

The Time of Use Setup Assistant helps you configure the Time of Use module.

1.
2.

Open ION Setup and connect to your meter, using Basic Mode.

In the Setup Assistant, navigate to Revenue > Time of Use

Setup Assistant

= Template
= Baszic Setup
== Security

[Z] Communications

== Demand
(C Inputs/Outputs
(C Loaging
[C] Revenue
E= PTACT Comection
Transformer Loss
== Time of Use
= Power Quality
= Werification
= Reports

Time of Use |

Allows pou to program the meter time of use information.

Sample TOU

\Edit | send |

< Back | Mest » | Exit | Help

Select a Time of Use program from the list (in this example, Sample TOU) and

click Edit.

Follow the Time of Use Wizard to configure your program. Click Send to save
the TOU program on your meter.
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Using Designer

Open your meter in Designer and navigate to the Time-of-Use Setup Framework.
Right-click the Time of Use module to edit.
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Time Of Use Module Settings

The Time of Use module’s setup registers define your seasons’ start and end dates,
the day types where your rates may differ, and the rate schedules for each season’s
day types. The module compares the meter’s internal clock with the season, day,
and time of day settings in these registers, and changes its output registers to
reflect the current state of these settings.

Seasonal Settings

The Time of Use module supports up to four separate seasons. Each seasons’ start
and end dates are set into the appropriate Season setup register.

2\ NOTE

Ensure that there is no date overlapping when defining seasons and that every day of the year is covered

by your seasons. If there are gaps between seasons, the module returns an exception message and will
not function.

If your rates do not change between seasons, you do not need to configure the
Season setup registers — Season 1 is the default, and all Season 1 rates are in effect
all year.

If you have different seasons, enter their start and end dates into the appropriate
setup registers. If your season is active on the same dates every year, you only need
to enter a single range of dates in the appropriate Season setup register. If the active
dates are different each year (for example, Season 3 becomes active every first
Monday in August), the start dates must be individually specified for each year.

The Time of Use module is partially configured at the factory. Check the setup
registers to ensure that the settings match your Time of Use schedules.

Setup Register

Function

Season 1- 4

These setup registers define the dates for each active season. When a season is active, the Time of Use module will
use the applicable rate schedules.

Season 1 - 4
Weekday Rates

These setup registers specify seasonal weekday rates.

Season 1 - 4
Weekend Rates

These setup registers specify seasonal weekend rates.

Season 1 - 4
Alt 1 Rates

These setup registers specify a season's daily rates during the days specified in the Alt 1 Days setup register.

Season 1 - 4
Alt 2 Rates

These setup registers specify a season's daily rates during the days specified in the Alt 2 Days setup register.

Season 1 - 4
Holiday Rates

These setup registers specify a season's daily rates during the days specified in the Holidays setup register.

Weekdays

This register defines the days of the week for all seasons. The rates in the Season (1, 2, 3, or 4) Weekday Rates
setup registers are used on these days.

Weekends

This register defines the weekend days for all seasons. The rates in the Season (1, 2, 3, or 4) Weekend Rates setup
registers are used on these days.
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Setup Register Function
This register defines a set of alternative dates for all seasons. These dates generally have different rates from
Alt 1 Days .
weekdays, weekends, or holidays.
Alt 2 Days This register is similar in function to Alt 1 Days, but contains a different set of dates.
. This register defines the holidays for all seasons. The rates defined in the Season (1, 2, 3, or 4) Holiday Rates setup
Holidays .
registers are used on these days.
Self Read Davs This setup register defines the dates and times that the Self Read output register will pulse. If no time is entered in
4 this register, the Self Read output register will pulse on the date specified at 12:00 AM.

Creating a New Time Of Use Schedule

You can create a new TOU schedule using the TOU Program Manager; the

program is a self-documented, graphical wizard. You launch the TOU Program
Manager in Designer from the Options menu.

4% Time OF Use Program Manager

I Il B

‘Welcome to the Time OF Use Program Manager

Create, copy or delete your TOU Programs uzing the file management features below,
or click the Edit button to modify an existing Program.

~ Risnaming TOU Progranm

i~ File Management

Use these buttons Make a News TOL Program |
to create, copy.

or delete a TOU Copy Selected TOU Pragram |
program.
Delete Selected TOU Program |

~Edit a TOU Program

Select a program from the list on the left, then click the
Edit button below ta launch the TOU Program Editar.

Edit [Launch Program E ditor] |

save the change.

*ou can ienams a TOL Fragrsm by selecting it, then clicking its name a second time. The
program's name appears in a thin black bok - type in & new name, then press the Enter key to

Closz I

Displaying Time of Use

View Time of Use values in the following locations:

Application Menu Navigation
Active TOU Rate and Active .
Front Panel TOU Season screens ALT Display mode
ION Setup N/A N/A
Vista Time of Use Screen Revenue tab > Time of use object
WebMeter N/A N/A
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This chapter explains how to configure your meter’s power quality functionality.

In this chapter

¢ Power Quality Configuration . ............ ..o, 166
Configuring Power Quality Settings ................ ... .. ... .. ... ..., 166
Using the FrontPanel ........... ... ... ... ... ... . . o .. 166
Using ION Setup ... 166
Using Designer ................ .. i 167
Configuring Power Quality Event Logging .............................. 167
Using the FrontPanel ........... ... ... ... ... .. . . o i 167
Using ION Setup ... 167
Using Designer ................. . i 168
Sag/Swell Module Settings ............... ... o i 168
Transient Module Settings (ION8600A only) ............ .. ... .......... 169
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Power Quality Configuration

Power quality configuration is provided by a number of modules, depending on
your meter type, such as the Sag/Swell module, the Transient module, and the
Mains Signalling Evaluation module, among others.

See the ION Reference for more information on these modules.

For a description of the scaled operational values (SOV) feature and the alternate
scaling registers on the Power Quality page in the Vista component of ION
Enterprise, refer to “Scaled Operational Values” on page 70.

Configuring Power Quality Settings

Use ION Enterprise or ION Setup software to change your meter’s power quality
settings.
Using the Front Panel

You cannot configure Power Quality from the front panel.

Using ION Setup

The Power Quality Setup Assistant helps you configure the various power quality
modules.

1. Open ION Setup and connect to your meter, using Basic Mode.
2. In the Setup Assistant, navigate to the Power Quality folder.

Setup Assistant E

= Template Sag/Swell |W’aveforms| Transientl

= Baszic Setup
= Security Thiz iz the nominal valtage used for sag/swell and transient
[Z] Communications sttt

== Demand

(2 Inputs/Outputs

23 Logging Mominal voltage 0
[C] Reverue gwelll_ |iTit°/°/e 1838
£ IR Rl Sag/5wel depth 100
== Dizplays

== ‘erification

== Feports

E dit |

< Back | Mest » | Exit | Help |

3. Click on the Sag/Swell tab to set sag and swell limits, configure sag/swell

waveform recorder settings and most importantly, record your system’s nominal
voltage.
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4. Click on the Waveforms tab to configure the waveform recording features of the
meter, including the waveform depth, the number and samples per cycle.

5. Click on the Transient tab to configure various settings such as voltage deviation
threshold and transient waveform recorder depth and frequency.

2, NOTE

The ION8600A features dual waveform capture: Sags are recorded at 32 samples x 54 cycles. Transients
waveform capture at 256 samples x 7 cycles.

Using Designer

Open your meter in Designer and navigate to the Power Quality Setup
Framework. Right-click a module to edit.

Configuring Power Quality Event Logging

Use ION Enterprise or ION Setup software to change your meter’s power quality
event log settings.

2\ NOTE

By default, Power Quality events are not included in the Event Log.

Using the Front Panel

You cannot configure Power Quality event logging from the front panel.

Using ION Setup

The Event Log Setup Assistant allows you to enable/disable Power Quality event
logging.
1. Open ION Setup and connect to your meter, using Basic Mode.

2. Click on the Event Log tab.
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3. Select the Sag/Swell Event Priority (551 EvPriority) and click Edit.

Setup Assistant E

Ewvents |

= Template

= Basic Setup
E= Security llawys you to set the eventt prianity for sag/swell events. Setto 0
(2 Communications [zero] to dizable sag/swell recording. Set to greater than the Event
Log Cutoff walue to enable sagdswell recording.
== Clock
== Demand
(27 Inputs/Outputs
(Z] Logging EL1 Cutaff 5
= Memory o
= LosdPuoie TR EvPriorty D
= EvertLog
[C] Revenue INumeric Bounded Format j
== Power Quality
= Displays |2DE|
= Werification
= Reports
ak. I Cancel | Help |
Edit |
< Back | Mext > | Exit | Help |

¢ To stop Sag/Swell events from being recorded in the Event Log, set
551 EvPriority to zero (0).

¢ Toinclude Sag/Swell events in the Event Log, SS1 EvPriority must be greater
than the Event Log Cutoff (ELI Cutoff) value. The recommended EvPriority
value for enabling Sag/Swell events is 200.

4. Select the Transient Event Priority (TR1 EvPriority) and click Edit.

¢ To stop Transient events from being recorded in the Event Log, set
TR1 EvPriority to zero (0).

¢ Toinclude Transient events in the Event Log, TR1 EvPriority must be greater
than the Event Log Cutoff (ELI Cutoff) value. The recommended EvPriority
value for enabling Transient events is 200.

Using Designer

Open your meter in Designer and navigate to the Power Quality Setup
Framework. Right-click the Sag/Swell or Transient module to edit.

Sag/Swell Module Settings

The Sag/Swell module monitors voltage waveforms for sags and swells (i.e.

ITTI [CBEMA] Type 2 and Type 3 disturbances). It then reports each disturbance’s
magnitude and duration. The Sag/Swell module can also detect sub-disturbances
during a Sag/Swell event. Settings are as follows:

Setup Register Function Default
Swell Lim This is the magnitude above which a voltage deviation is considered a swell. | 106
Sag Lim This is the magnitude below which a voltage deviation is considered a sag. | 88
Change Crit This is the amount a voltoge_ signal must change during a disturbance to 10

be considered a new sub-disturbance.
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Nom Volts This is the nominal power system voltage (used for all Power Quality ol
functions). Set Nom Volts to “0” to disable the Sag/Swell module.
. The priority assigned to Sag/Swell and Transient module events 9
EvPriority (0o 255, 255 is highest). 0

! The primary power system voltage is sometimes different than the PT Primary setup register value (i.e.
when the PT Primary is used to indicate winding ratio rather than primary voltage).

2 By default Sag/Swell events are not recorded in the Event Log.

You also need to set the EvPriority register value if you want Sag/Swell events to
be recorded in the Event Log. To enable Sag/Swell events, the EvPriority value
must be greater than the Event Log Controller module’s Cutoff value (the
recommended Sag/Swell EvPriority value is 200). To disable Sag/Swell events so
they are not recorded in the Event Log, set EvPriority to zero (0).

You may need to change Swell Lim and Sag Lim, but most applications are served
by the default values entered into these registers. The Change Crit setup register
does not need to be changed for normal operation.

2\ NoTe

If the Sag/Swell module’s Nom Volts setup register is set to zero, all Sag/Swell module functions are
disabled. Nom Voltsis typically set when the meter is put into service. If Nom Volts has not been set, enter
a value for your system’s nominal voltage (i.e. 120, 277, or 347). The value you enter will also be used
by the Transient module in the ION8600A.

Transient Module Settings (ION8600A only)

The Transient module monitors voltage waveforms for transient activity (i.e. ITI
[CBEMA] Type 1 disturbances). The Threshold setup register defines what voltage
disturbance magnitude should be considered as transient activity. Threshold is
interpreted as a percentage of the nominal system voltage, plus 100. For example,
if you want transients recorded when voltage deviates from nominal by 20%, enter
120 into the Threshold setup register.

Setup Register Function Default
Threshold This is 1.he magnitude at which a voltage deviation is considered 125
a transient.
EvPriority The priority assigned to Sag/Swell and Transient module events ol

(0 to 255, 255 is highest).

! By default, Transient events are not recorded in the Event Log.

You also need to set the EvPriority register value if you want Transient events to be
recorded in the Event Log. To enable Transient events, the EvPriority value must
be greater than the Event Log Controller module’s Cutoff value (the recommended
Transient EvPriority value is 200). To disable Transient events so they are not
recorded in the Event Log, set EvPriority to zero (0).
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Displays

This chapter explains the available front panel displays. It also includes
procedures for customizing displays using ION Enterprise or ION Setup software.

In this chapter

@ Infroduction ....... ..ol 172
# Configuring Front Panel Displays . . ..............coiiiiiiienn... 173
Using the frontpanel ........... ... . o i i 173
UsingION Setup ............ 173
Using Designer ........... ... . i 174
o Default Front Panel Display Screens .. .............coviiiiena... 177
NORM mode display screens ..............coooiiiiiiiiiiii. .. 177
ALT mode default display screens ................. ... ... ... ..... 178
TEST mode default display screens ................. ... .. ... ... 181
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Introduction

The ION8600 ships with pre configured display screens designed to suit the data
needs of most users. Different types of screens are available depending upon the
meter’s current mode of operation (see “Modes of Operation” on page 27 for
details).

Front panel displays may also be customized on your meter to show virtually any
measurement or calculation. For example, you could do one or all of the following:
¢ change displayed parameters, such as from VIl to ViIn or Vilab to Vina

¢ adjust character size to be different on each screen

¢ change data display settings such as backlight timeout, automatic display
scrolling, parameter update rate and display mode*

Use ION Enterprise or ION Setup software to customize your front panel display
screens.

Page 172
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Configuring Front Panel Displays

Using the front panel

You cannot configure displays from the front panel.

Using ION Setup

1. Open ION Setup and connect, in basic mode, to the appropriate meter.
2. In the Setup Assistant, navigate to Displays and click Edit.

ION Setup will upload your meter’s display information to the Display Editor.
This may take a few moments.

Setup Assistant E
= Template Front Panel |
= Baszic Setup
= Security Alloves you to program the available front panel displays.
Communications
=D_ Clack Dizplay Editor I
== Demand
(2 Inputs/Outputs _ ove Up |
(Z] Logging i 5 tﬁiﬁh
[C] Revenue . Elock Paak Mave Down |
Power Cuality Pk Dmd Rset Cnt
= Displays O-Metering Mew
= Verification Disk Simulator
= Reports All Segments
Delete |
Bename |
Edit
INormaI Mode j
Alternate Mode
Sty Test Mode

3. Edit, rename, delete or rearrange displays as desired.

4. If you choose to edit or create new display, the Display Editor wizard contains
three steps for creating or editing display screens.
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Dizplay setup E
—Step 1: Select Screen Type
Screen Type: ITwo Paramneter j
—Step 2 Select P

Farameters: Edit |
kKiwih rec
Unlink |

—Step 3 Select Digit Display Propertie:

Resolution: I 12345678504

L L

Last Digit: I Truncate

Found
Send I Cancel | Help |

¢ Choose the screen type
¢ Select the parameters available for your chosen screen type

¢ Select your display qualities, including digit resolution and truncated or
rounded last digits.

5. Click Send to save the changes in the meter.

Using Designer

CAUTION

Before you reconfigure or delete a framework, you should make a copy. This ensures that you can restore
the framework without having to reinitialize the factory configuration.

To remove a data display screen:

1. Launch Designer.
2. Select the Display module responsible for the screen.
3. DPress delete. This also deletes all links to that particular Display module.

If the display screen you are deleting is part of the automatic scrolling cycle, you
should reconfigure the links from the Scroll module’s Trigger outputs to the
remaining Display modules so that the following considerations hold true:

& The first Display module in the scrolling cycle is linked to the Trigger 1 output of
the Scroll module.

¢ The last Display module in the scrolling cycle (module ) is linked to the
Trigger n output of the Scroll module. For example, if your scrolling cycle
consists of 5 screens, then Trigger 5 should be linked to the fifth module in the
cycle.

& The Wraparound setup register of the Scroll module designates the last trigger
output (Trigger n). Expanding on the previous example, since Trigger 5 is the last
trigger, the Scroll module’s Wraparound setup register would have a value of 5.
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To add a new display screen

1. Create a Display module.

2. Define the modules characteristics (display format) by adjusting its setup
registers.

3. Link any required data to the Source inputs of the Display module.

If you want your new screen to appear in the automatic scrolling cycle, then you
must link the Show input of the Display module to a Trigger output of a Scroll
module.

To create a Disk Simulator screen

1. Create a new Display module, and choose the type as Disk Simulator.

2. Connect the new Display module’s first input to the Calibration Pulser module’s
Disk Position output that you want to monitor for its pulsing interval.

3. Toinclude the newly added screen to the ALT screen list, connect the Display
module’s Show1 and Show?2 inputs to the Scroll module’s last available Trigger
outputs in ALT SCROLL UP and ALT SCROLL DOWN (respectively).

You can determine the last available Trigger by right-clicking on the output to
discover the Triggers’ owners.

4. Increase the Scroll module’s Wraparound setup register by 1 to include the new
screen.

5. Configure the remaining display settings according to your needs.

Although the Disk Simulator display is intended to show the disk behavior of
mechanical watt-hour meters, this feature can be used to monitor any accumulated
meter quantity over the time. To do this, connect the Display module’s first input
to the meter quantity, and connect the second input to the maximum value that
you expect the displayed quantity to be bounded by (this could be any ION output
register or an External Numeric module register). In this case, (i.e. the Display
module is not connected to a Calibration Pulser module) the Disk Simulator
revolves from left to right.

2\ NOTE

The inputs to the Disk Simulator display are always positive. If the value exceeds the maximum scale value

assigned in the second input, then nothing is displayed except labels and the disk rectangle.

To configure leading zeros

The leading zeros and decimal point in a numeric display can be configured with
the Display module setup register Screen Resolution. For example, the number
276.3443 can be configured in one of the following ways, depending on the
selection you make in the Screen Resolution setup register:

Value Screen Resolution
276.3443 1.x = 276.3

1234.xx = 0276.34

123456. = 000276.
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If the Screen Resolution setup register is set to DEFAULT, the Display module will
use the resolutions defined in the Display Options module.

Last digit mode

The Display module setup register Last Digit Mode lets you specify whether to
truncate or round a value’s last digit. Numbers round up at 5 or greater, and round
down from 1 to 4. A truncated value disposes of any digits after the number of
decimal places that you have specified in the Screen Resolution setup register.

Screen Resolution = 1.xxx

Value = 276.35192
Rounded = 276.352
Truncated = 276.351

To configure parameter titles

The parameter value on a display screen is the value of an output connected to the
Display module Source input register. By default, the displayed parameter’s title is
the name of the output connected to the Source input. The Display module Source
Title setup register lets you change the default to a title that better describes your
system. For example, if “KWh Net” is linked to the first Source input, you could
change its display name by setting Source 1 Title to “KWh Net West.” A maximum
of 25 characters is permitted.

See “Changing TEST Mode Timeout” on page 188 for information on configuring
TEST mode display timeouts.
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Default Front Panel Display Screens

Each mode of operation (NORM, ALT and TEST) has its own display screens,
providing various power system data and meter properties screens.

NORM mode display screens

The factory-configured ION8600 meter scrolls through nine displays detailed
below. If the settings in the Scroll module have not been altered, each screen is
displayed for five seconds if no front panel buttons are pressed.

Display scrolling is suspended when a front panel button is pressed, and you can
manually scroll through the display screens using the Up or Down arrow buttons.
If required, refer to “Front Panel Features” on page 20 for more instructions on
using the front panel buttons.

1.

kWh

This screen displays kWh delivered and received values.
kVARh

This screen displays kVARh delivered and received values.
kVAh

This screen displays kVAh delivered and received values.
Peak Demand Delivered

This screen displays the maximum delivered kW value and a timestamp of
when the peak occurred. This value is a Sliding Window (Rolling Block)
demand calculation.

Peak Demand Received

This screen displays the maximum received kW value and a timestamp of when
the peak occurred. This value is a Sliding Window (Rolling Block) demand
calculation.

Peak Demand Reset Count

This screen displays a count of the number of Demand Resets executed as well
as a timestamp of the latest Peak Demand Reset.

Q Metering

This screen displays approximated VARh measurements, one phase (60
degrees) behind the normal watthour connection (90° - 330° and 150° - 270°).

Disk Simulator

This display simulates the behavior of a mechanical watt-hour meter indicating
power received or delivered by the direction of the pulse.

All Segments

This is a screen test where a black screen showing all segments (all pixels on)
indicates that the display is functioning properly.
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ALT mode default display screens

The factory-configured ION8600 meter scrolls through the following ALT mode
displays. If the settings in the Scroll module have not been altered, each screen is
displayed for five seconds if no front panel buttons are pressed (until five minutes
have elapsed).

Viewing ALT display modes
1. Press the Alt/Enter button once to toggle between the NORM and ALT display
modes.

2. Press the Up or Down arrow buttons to scroll back or forth through the displays.

If no buttons are pressed the meter reverts back to NORM mode after five minutes.

2\ NOTE

These screens vary depending on the firmware version on the meter and custom display configuration.

1. Name Plate 1

The Name Plate 1 screen contains this information:

¢ Owner & Firmware revision of the meter
& TAGI from Factory module 4 Battery life indicator
& TAG?2 from Factory module
TAG1 and TAG2 typically identify the meter’s user and installed location. The

Owner and TAG registers are configurable with ION Enterprise or ION Setup
software. See “How to TAG Your Meter” on page 42.

2. Name Plate 2

This screen displays the following information for the current Sliding Window
(Rolling Block) demand settings:

Sliding Window (Rolling Block)

Length of the demand period multiplied by
CONFIG the number of demand periods
UPDATE Length of the demand period
SYNC Clock synchronization source

MAX (kW) Maximum kW Demcmd.|

1 The MAX (kW) value is a maximum allowable demand level based on installed transformer
configurations and nominal voltages and currents.

3. EventLog

The Event Log screen displays up to four most recent, highest priority events
(priority 255 only). The date, a timestamp, an event description, and an event
code are provided for each event displayed. If more than four high priority
events have been recorded, then the Event Log screen will indicate additional
logs exist. Refer to “Data Logging” on page 144 for more details.
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4. Vector Diagram

This screen shows phasors and numeric values for each phase current and phase
voltage measurement.

5. Instantaneous Voltage

This screen shows average voltage, line-to-neutral and/or line-to-line voltage
(depending on the meter’s service type).

6. Instantaneous Current
This screen shows the phase current and average current values.
7. Instantaneous Power

This screen shows kW total, kVAR total, kVA total and signed Power Factor
total values.

8. Instantaneous Demand

This screen shows kW delivered and received from the Sliding Window (Rolling
Block) demand calculation.

9, 10, 11. Voltage Harmonics

These screens show histograms of the per phase voltage harmonic content.
12, 13, 14. Current Harmonics

These screens show histograms of the per phase current harmonic content.
15. Instantaneous Demand

This screen shows kW td delivered and received.

ALT mode Time of Use (TOU) display screens

ALT mode display screens 17 to 56 are factory-configured to show Time of Use
(TOU) data. The measurements displayed originate from frameworks of ION
modules that are linked to a TOU module. For details about the TOU module, refer
to the ION Reference.

By default, all demand values result from Sliding Window (Rolling Block)
calculations.
17. TOU Energy by Rate
This screen shows kWh delivered values for each TOU rate.
18 - 25. kW Peak Demand

These screens display the maximum kW delivered value for each TOU rate.
These values result from Sliding Window (Rolling Block) demand calculations.

26. Previous Billing Energy

This screen displays the kWh delivered values for each TOU rate in the previous
billing period.

2\ NOTE

PB = Previous Billing period. A billing period is the time between two consecutive meter readings for
billing purposes by a utility.
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27 -

35.

34. Prev Billing Peak Demand

These screens display the maximum kW delivered value for each TOU rate in
the previous billing period. These values result from Sliding Window (Rolling
Block) demand calculations.

Previous Season Energy

This screen displays the kWh delivered for each TOU rate in the previous billing
season. These values result from Sliding Window (Rolling Block) demand
calculations.

2 NOTE

PS = Previous Season. Billing Seasons are defined in the TOU module description in the
ION Reference.

36 -

44.

43. Prev Season Peak Demand

These screens display the maximum kW delivered for each TOU rate in the
previous billing season.

Prev Billing/Season Energy

These screens display the kWh delivered and received values in the previous
billing period and billing season.

45, 46. Prev Bill/ Season Pk Demand

47.

These screens show the maximum kW sd received values in the previous billing
period and billing season. These values result from a Sliding Window (Rolling
Block) demand calculation.

Prev Billing/Season Energy

These screens display the kVARh delivered and received values in the previous
billing period and billing season.

48, 49. Prev Bill/Season Pk Demand

50.

These screens display the kVAR delivered and received values in the previous
billing period and billing season. These values result from a Sliding Window
(Rolling Block) demand calculation.

Prev Billing/Season Energy

These screens display the kVAh delivered and received values in the previous
billing period and billing season.

51, 52. Prev Bill/Season Pk Demand

53.

54.

55.

These screens display the kVA delivered and received values in the previous
billing period and billing season. These values result from a Sliding Window
(Rolling Block) demand calculation.

Active TOU Rate

This screen shows which of the valid TOU billing rates is active.
Active TOU Season

This screen shows which TOU billing season is currently active.

Flicker
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This screen displays flicker measurements from V1, V2 and V3.
56. Frequency

This screen displays frequency information.

TEST mode default display screens

Recall that the values shown in the TEST mode display screens represent different
accumulators than those shown in NORM mode (although they perform some of
the same basic measurements). The TEST mode display values are for calibration
checking purposes; they will only accumulate while the meter is in TEST mode.

Viewing TEST mode

There are two ways to switch the meter into TEST mode depending on the type of
meter you have:

¢ Standard meter (without hardware lock): You must use ION Enterprise or ION
Setup software; refer to “Switching to TEST Mode” on page 185.

¢ Standard hardware-locked meter: You must remove the cover from the meter
and press the TEST mode button; refer to “Performing a Master Reset from the
front panel” on page 192 for detailed instructions on removing the meter’s
cover.

Once the meter is in TEST mode the front panel cycles through four TEST mode
display screens summarized below.
1. kWh Test
This screen shows TEST mode kWh delivered and received values.
2. kVARK/KVAh Test
This screen shows TEST mode kVARh/KVAh delivered and received values.
3, 4. Instantaneous Demand Test
This screen shows TEST mode kW delivered and received values. Both
quantities are produced from a Sliding Window (Rolling Block) demand

calculation. This value is reset if the Demand Reset switch is turned while the
device is in TEST mode.
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TEST Mode

This chapter describes your meter’s TEST Mode and explains how to switch from
Normal Mode to TEST Mode.

In this chapter

@ Infroduction ....... ..ol 184
& Switchingto TESTMode ............c.iiiiiiiiiiiiiinnennnnn. 185
Using the front panel (standard meter) ........................... ... 185
Using the front panel (hardware locked meter) ...................... 185
Using ION Setup (standard meter) ................ ... ... ... ... ... 185
Using ION Setup (hardware-locked meter) .......................... 186
Using Vista (standard meter) ............... ... ... ... 186
Using Vista (hardware-locked meter) ............................ ... 187
¢ Changing TESTMode Timeout . .........covviiinnennnnnnnnnnnnns 188
Using thefrontpanel ........... ... ... ... i i il 188
Using ION Setup ...t 188
Using Designer ................ .. i 189
o TEST Mode Default Display Screens . ............ccovvviiieenn... 190
TEST mode LED energy pulsing ............... ... ..., 190
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Introduction

TEST Mode is typically used for verifying meter calibration and function. The
meter is usually reading data from a test power supply while these functions are
performed.

Several things to note about TEST Mode:

¢ All of the billing quantities that are recorded when the meter is in normal mode
will stop accumulating when the meter is switched to TEST Mode — the data is
sent to special TEST Mode registers instead.

¢ The values accumulated in these test registers are displayed on the front panel
and in ION Enterprise or ION Setup software.

¢ The regular normal mode billing registers are unaffected while the meter is in
TEST Mode; accumulation of this data continues as soon as you exit TEST Mode.

¢ All test registers are reset to zero when you exit TEST Mode.

2\ NOTE

The meter will always return to NORM mode when you exit TEST mode, even if you entered TEST mode
from ALT mode.

You cannot place a hardware-locked meter in TEST mode using ION Enterprise or
ION Setup software. The meter must be placed in TEST mode via the front panel.

Please refer to Verifying ION8600 Meter Accuracy technical note for final accuracy
verification test details and procedure.
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Switching to TEST Mode

TEST
MODE

Place the meter into TEST Mode using the front panel, ION Setup or Vista. The
meter’s front panel informs you when the meter is in TEST Mode with a special
display screen.

Using the front panel (standard meter)

The TEST mode button on the ION8600 meter is located beneath the outer cover.
You must first remove the cover. Refer to the procedure for removing this cover on
page 192.

Once you have removed the outer cover, press the TEST mode button.

Using the front panel (hardware locked meter)

Hardware-lockable meters must be in TEST mode before they can be configured.

To place the meter in TEST mode, remove the outer cover following the procedures
listed on page 192.

The regular NORM/ALT mode billing registers are unaffected while the meter is
in TEST mode; accumulation of this data continues as soon as you exit TEST mode.
All test registers are reset to zero when you exit TEST mode.

Using ION Setup (standard meter)
1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to the Verification folder.

Setup Assistant E
= Template Werification |
= Baszic Setup

= Security Blloves you to verify meter readings. NOTE: The Test Mode

parameters Test Sub-Intervalz and Test Sub-Interval Length must be
changed in Mormal Maode under the Demand setup screen;
however, the Loss Mode is only accessible in Test Mode.

(C1 Loaging |N0rmal Mode
[C] Revenue
== Power Quality

== Werification
== Feports

[Z] Communications

Dizplay |

< Back | Mest » | Exit | Help |

3. Click on TEST Mode. If meter security is enabled, you will be prompted for
password. A dialog box informs you the meter is in TEST Mode.
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10N Setup | x|

& Meter is naw in test mode

4. Click OK. The TEST Mode screen appears and test values are displayed.

Test Mode E
Energy | Rolling Demand I “olts, Amps and F‘owerl
— kw'h KWARh
Delivered 0.000 Delivered 0.000
Feceived 0.000 Received 0.000
~ kidsh
Delivered 0.000
Received 0.000
Test Reset |
LCloze | Save Az | Help |

Click on the tabs to perform various test-related tasks. See the ION Setup online
help for more information.

5. Click Close. A dialog box informs you the meter is back in Normal Mode.

10N Setup E

& Meter iz now back in normal mode

Using ION Setup (hardware-locked meter)

You cannot place a hardware-locked meter in TEST mode using ION Setup. The
meter must be placed in TEST mode via the front panel. See “Switching to TEST
Mode” on page 185.

Using Vista (standard meter)

1. Open the meter in Vista.

2. Navigate to Revenue and click the Setup & Controls button in the bottom right-
hand corner of the revenue screen.
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3. Select the TEST Mode radio button. You will be prompted for the ION Enterprise
user password. If meter security is enabled, you will also be prompted for the

meter password.

Setup & Controls

{click radio buttons to change state)

Meter Mode: Revenue Measurement Scaling:

¢ Mormal Mode ¢ Secondary Units {"1:1")

= Test Made \ @ Primary Units {"CT,PT scaling")

LED Pulser Mode:

& OMin Mormal Mode
¢ OFF in Mormal Mode

Peak Demand Reset:
Master Reset:

Report Log Enable:

1

22 o ®

Meter Display Auto-Scroll Enable: a

Use this screen to view and reset the registers that accumulate real-time data. For
more information see the Vista section of the online ION Enterprise Help.

Using Vista (hardware-locked meter)

You cannot place a hardware-locked meter in TEST mode using ION Enterprise or
ION Setup software. The meter must be placed in TEST mode via the front panel.

See “Switching to TEST Mode” on page 185.
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Changing TEST Mode Timeout

If no front panel buttons are pressed, the meter will exit TEST mode after 30
minutes (unless the default TEST mode timeout value has been changed). While in
TEST mode, the value on the bottom right of the status bar indicates the amount of
time before TEST mode times out. The meter always returns to NORM mode when
the TEST mode time-out elapses.

kWh del T The timer indicates
6- 63 the TEST mode
kWhrec T timeout.

9:36:54 12/09/2005 ABC Q1 TEST EXIT:28:17 */

The time-out value resets to 30 minutes each time you press any front panel button.
By default the TEST mode time-out value is 30 minutes.

You can change the value of the TEST mode time-out using ION Enterprise or ION
Setup software or the front panel.

Using the front panel

Follow these steps if you are using the front panel:

2\ NOTE

You must be in TEST mode to change the TEST mode time-out if you have the hardware-lockable meter.

1. Enter the Setup menu by holding down the Alt/Enter button.

2. Scroll through the menu items, highlight DISPLAY OPTIONS, and press the Alt/
Enter button.

3. Scroll down and highlight the TEST MODE TO menu item. Press Alt/Enter.

4. The current TEST mode time-out is displayed. Use the Up or Down arrow
buttons to change the value of the highlighted digit. Press the Up or Down arrow
button to change the position of the highlight cursor. When you have entered the
new value of the TEST mode time-out in seconds, press the Alt/Enter button.

5.  Select YES to Confirm the change, and enter the meter password if required.

Using ION Setup

Follow these steps if you are using ION Setup:
1. Start ION Setup and connect to the desired meter in Advanced Mode.

2. Locate the Display Options module in the module list and double-click to open
the module.

3. Inthe Display Options module, click the Setup Registers tab and double-click
the TEST Mode Timeout setup register. The default setting for this setup register
is 1800 seconds (30 minutes).
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4.

5.

Set the TEST Mode Timeout to the desired time. You can choose from a numeric
bounded format or an elapsed interval format.

Click Send to transmit the changes to the meter.

Using Designer

Follow these steps if you are using Designer:

1.
2.
3.

Open Designer and connect to the desired meter.
Double-click the Display Setup folder on the Designer screen.

Right-click on the Display Options module to access the setup registers. Select
the TEST Mode Timeout setup register and click Modify to edit.

Set the TEST Mode Timeout to the desired time. You can choose from a numeric
bounded format or an elapsed interval format.

Click OK to send the changes to the meter.
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TEST Mode Default Display Screens

Recall that the values shown in the TEST mode display screens represent different
accumulators than those shown in NORM mode (although they perform some of
the same basic measurements). The TEST mode display values are for calibration
checking purposes; they will only accumulate while the meter is in TEST mode.

Once the meter is in TEST mode the front panel cycles through four TEST mode
display screens:
¢ 1. kWhTEST

¢ This screen shows TEST mode kWh delivered and received values.

¢ 2. kVARh/KVAh TEST
¢ This screen shows TEST mode kVARh/KVAh delivered and received values.

& 3, 4. Instantaneous Demand TEST

¢ This screen shows TEST mode kW delivered and received values. Both
quantities are produced from a Sliding Window (Rolling Block) demand
calculation. This value is reset if the Demand Reset switch is turned while
the device is in TEST mode.

TEST mode LED energy pulsing

+ Above the display screen are two pairs of energy pulsing LEDs and infrared
outputs. The LEDs and IR outputs are factory-configured to pulse while the
meter is in TEST mode.

VAR infrared
output

WATT infrared
output

The Kh label
indicates the
default pulsing
rate

WATT LED

The energy pulsing LEDs provide an ideal interface for calibration checking
instruments. The Kh label (to the left of the display screen) indicates the factory-
configured pulsing rate. (You can change the energy pulsing frequency with ION
Enterprise or ION Setup software.) Refer to “TEST mode” on page 28 for more
information about using TEST mode.
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Resets

This chapter provides instructions for performing various meter resets.

In this chapter

¢ PerformingaReset ..........ccouiiiiiiiininnnnnnnnnnnnns

Using the Front Panel

Performing a Master Reset from the front panel ..................
Parameters affected by a Master Reset ..........................
Performing a Demand Reset from the front panel ................
Parameters affected by a Demand Reset . ........................
Using ION Setup ... s
Using Vista ......... i

Master Resets and Hardware-locked Meters
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Performing a Reset

Resets allow you to clear various accumulated parameters stored by the meter.

2\ NOTE

Be sure to record any important data before performing a meter reset.

Using the Front Panel

The following resets can be performed via the front panel:
¢ Master Reset:

« deletes most accumulated values and all derived revenue measurements
from the meter.

& Demand Reset:

+ resets the peak demand values logged in the meter.

Performing a Master Reset from the front panel

The Master Reset button is recessed to avoid accidental activation. You must first
remove the meter’s cover before you can perform a Master Reset:

/\ DANGER

MASTER HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
RESET

During normal operation of the meter, hazardous voltages are present on its terminal strips and blades.
*Do not touch the meter’s terminal strips or blades while the meter powered.

*Ensure meter is connected to the protective earth ground.

Failure to follow these instructions will result in death or serious injury.

NOTE: Ensure fuses (customer supplied) are installed in all voltage measurement
inputs and auxiliary (control) power circuits.

1. Remove any anti-tamper sealing device located at the base of the meter. These
devices seal the meter cover to the backplate.

2. Rotate plastic cover ¥4 turn counter-clockwise and pull cover off.
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3. Using a pin or similar instrument, press and hold the Master Reset button until
the “Master Reset in Progress” message is displayed on the front panel.

CAUTION

After initiating a Master Reset, wait until the “Master Reset Completed” message appears on the front
panel (or about two minutes, depending on your firmware). This allows the meter to completely reset
parameters. This is especially important if you are powering down the meter after a Master Reset.

Parameters affected by a Master Reset

The Master Reset button resets many of the device's measurements and logs. The
mode that the meter is in (NORM mode or TEST mode - see “Modes of Operation”
on page 31) defines the values that will be reset.

NORM or ALT mode

In NORM or ALT mode, the following parameters are reset to zero:
¢ Energy and Demand

Peak Demand

Loss Calculation

Long-term Min/Max

Power Availability

Power Quality disturbance counters

* 6 6 6 o o

Time of Use

The following are cleared:
¢ Event Log

& All Data Recorders

& All Waveform Recorders

TEST mode

¢ Al TEST mode Energy and Demand measurements are set to zero.
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Performing a Demand Reset from the front panel

The Demand Reset switch can be activated with the cover on or off.

In most applications, the Demand Reset switch is sealed with an anti-tamper
mechanism; a through-hole in the switch can accommodate either an external seal
or a locking mechanism. See “Demand Reset Switch Seal” on page 69 for details of
anti-tamper sealing.

Parameters affected by a Demand Reset

The mode that the meter is in (for example, NORM mode or TEST mode) defines
the values that will be reset.

TEST mode

¢ resets the test demand parameters to zero.

Demand Lockout Time

The setup register labeled Demand Lockout Time (Display Options module) sets the
minimum time allowed between consecutive demand resets; the meter ignores
any attempts to reset the demand outside the bounds of the register.

The default value for the Demand Lockout time is 25 days. For details on the
Demand Lockout Time setup register, refer to “Demand and Peak Demand

Module Overview” on page 121.

For more details on the Display Options module, see the ION Reference.
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Using ION Setup

1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to the Verification folder.

3. Select Normal Mode and click Display.

Setup Assistant

= Template

= Baszic Setup
== Security

[Z] Communications

Werification |

Allows pou to verify meter readings. MOTE: The Test Mode
parameters Test Sub-Intervals and Test Sub-Interval Length must be
changed in Mormal Mode under the Demand setup screen;
howewver, the Loss Mode is only accessible in Test Mode.

Mormal =
Test Mode

< Back Mest » Exit Help

4. Select the desired tab in the Normal Mode dialog box. Two resets are available:
Peak Reset and Master Reset. Click the appropriate button to perform the reset
(Peak Demand in the example below).

2 NOTE

Master reset is not accessible via software in a hardware-locked ION8600 meter, whether the meter is in

TEST, ALT or NORM mode. A master reset on a hardware-locked meter can only be performed from the
front panel. See “Master Resets and Hardware-locked Meters” on page 197 for screen details. With a

meter that is not hardware-locked, you can perform a Master Reset via software. It does not have to be

in TEST mode.
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Mormal Mode E
Energy  Fioling Demand |VOIts, Amps and Powerl Power Qualityl
Demand Peak Demand
ki Delivered 0.000 ki Delivered 0.000
k' Received 0.000 k' Received 0.000
kAR Delivered 0.000 kAR Delivered 0.000
kAR Received 0.000 kAR Received 0.000
kia, Delivered 0.000 kia, Delivered 0.000
kia Received 0.000 kia Received 0.000
\ Feak Reset | Master Reset |
Close | Savehs.. | e Help |

A dialog box informs you when the reset is complete.

Using Vista

Open your meter in Vista. You can perform several resets from within Vista:

Performing a Peak Demand Reset or Master Reset

2\ NOTE

Master reset is not accessible via software in a hardware-locked ION8600 meter, whether the meter is in
TEST, ALT or NORM mode. A master reset on a hardware-locked meter can only be performed from the

front panel. With a meter that is not hardware-locked, you can perform a Master Reset via software. It

does not have to be in TEST mode.

1. Click the System & Logs tab and click the Setup & Controls object.

2. Click the appropriate reset button to perform the reset.

Performing a Min/Max Reset
1. Click the Volts & Amps tab and click the Long-term Min/Max Measurements

object.

2. Click the Min/Max reset button to perform the reset.

Performing a Sag/Swell or Harmonics Min/Max Reset
1. Click the Power Quality tab and click the Power Quality Controls object.

2. Click the appropriate reset button to perform the reset.
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Master Resets and

Hardware-locked Meters

Master reset is not accessible via software in a hardware-locked ION8600 meter,
whether the meter is in TEST, ALT or NORM mode. A master reset on a hardware-
locked meter can only be performed from the front panel.

Test Mode

In Test mode, the following screen is displayed:

MASTER RESET

UNAVAILABLE IN
TEST MODE

19:36:54  12/09/2005 Q1 TEST EXIT: 29:55

Normal Mode, Locked

In this case the meter attempts the Master Reset, but revenue and event logs are not
cleared. The rest of the Master Reset is successful.

LOCKED METER

PARTIAL RESET
IN PROGRESS

13:36:54  12/09/2005 Q1 NORME__J 0:46m

LOCKED METER

PARTIAL RESET
COMPLETED

13:36:54  12/09/2005 Q1 NORME__J 0:49m
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Alerting

ION alerts can send an email or contact a modem, fax, pager, or software in the
event of a user-specified condition. These conditions can be changes in relays or

power quality problems including surges, sags, swells and outages.

This chapter explains how to configure your meter network for alerting.

In this chapter

@ Alerting ....ooiiiiii i i i i i i i e e e
Alerting ION Software via the Alarm Server ........................
Remote Site Event Notification ............... ... ... ... ... ...
Alerting via an AlphanumericPager ...............................
Alerting viaa NumericPager ............... ... ... ... oL
Alerting viaEmail ............ .. .
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Alerting

The meter’s Alert module sends an alert whenever its Trigger input is pulsed. You
can connect this input to any module that produces a pulse output. You can use
modules that monitor alarm conditions such as changes in relay status and power
quality problems. For example, you can connect the Trigger input to the output of
a Setpoint module, thereby allowing the Alert module to send an alert when the
setpoint condition is reached.

The Alert module delivers these types of alerts:

Numeric Pager

Alphanumeric Pager

PEGASYS (for alerts to PEGASYS software)

ION Alert (for alerts to ION Enterprise software)

ASCII

® 6 6 6 o o

Email
Selection between modes is made with the Alert module Alert Type setup register.

The Alert module requires access to either a modem (a dedicated modem or a
modem handling a loop of meters) or Ethernet (for the Alert module email
capabilities).

Your meter has no pre-configured Alert framework. For detailed information
about alerting, including how to build a framework to send alerts, refer to the Alert
module description in the ION Reference.

Alerting ION Software via the Alarm Server

2\ NOTE

For detailed information about sending alerts to ION Enterprise software via the Alarm Server, refer to

the ION Enterprise online help.

The Alarm Server can run on any ION Enterprise Primary or Secondary server.
The server computer should have a dedicated phone line and modem. Modems at
remote sites are programmed to dial the server's phone number when a priority
event occurs. The Alarm Server monitors the phone line and waits for the remote
sites to annunciate events. The most common use of the Alarm Server is to handle
Remote Site Event Notification.
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Remote Site Event Notification

Server or LAN

Dedicated Alarm
Server Modem @ Remote Site informs
the Alarm Server that

. ./ a priority message
- ) .
# :l'- exists Modem Site
1

Server computer
receives the alarm

Alarm Server.exe

Connection
Manager

./ @Communicoﬁon ,,,,,,,,,,,,,,,,,,,, ]

%% 53 Services contact the
Any Dialout Modem modem site and retrieve
priority messages

The Alarm Server uses a series of command line arguments to specify the actions
it takes when a priority event is reported. These commands must be entered on the
computer that is running the Alarm Server utility. Typically the Alarm Server is
configured to launch the Connection Manager, which dials up the remote site and
retrieves the logs from the devices. The Alarm Server can also be configured to
launch other applications. A series of parameter switches are added to the
command line to pass information about the event to the application that is
launched.

Configuring the Alarm Server

The Alarm Server should have a dedicated phone line, modem, and COM port to
avoid conflicts with other software and hardware components.

The modem used by the Alarm Server is not configured with the Management
Console; only dialout modems are configured in the Management Console. The
Alarm Server's executable, alarmsrv.exe, is typically located in ...\ION
Enterprise\ SYSTEM\bin. You can run the Alarm Server in a console window, or
you can define a shortcut icon that includes all of the command line arguments
required.

Alarm Server Command Line Arguments

Refer to the ION Meter Alerts technical note for a list of command lines that the
Alarm Server supports.

Alerting via an Alphanumeric Pager
2\ Note

For detailed information about building a framework for alerting via an alphanumeric pager, refer to the
Alert module description in the online /ON Reference.
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If an alphanumeric pager is specified as the destination address in the Alert
module, then an alphanumeric paging service receives a message from the ION
meter.

Once the modem at the paging service is contacted, the ION meter transmits the
following information:

¢ Pager identification number

¢ Local time (year, month, date, hours, minutes, seconds)

& Remote site identification

¢ Priority of the alarm

¢ Alert message, with text strings and realtime measured values

To include a module’s Source input in the message, reference the message string by
using the form %Vn, where n is the Source input number. In the following Message

register setting, the kWtot value is %V1. The string includes Source input 1 which
would be the kWtot register from the Power Meter module.

The destination register contains your modem access number for the paging
service provider and is what is dialed out first. The Pager Num register is the pager
access number that is provided by your paging company.

Alerting via a Numeric Pager

2\ NOTE

For detailed information about building a framework for alerting via a numeric pager, refer to the Alert
module description in the online /ON Reference.

If a numeric pager is specified as the destination address in the Alert module, then
a numeric paging service receives a message from the ION meter. Due to the
inherent limitations in numeric paging, the ION meter can only send a string of
digits to the paging service. The Alert module then waits a specified time,
determined by the number of commas inserted after the phone number in the Pager
Num setup register. Finally, the Alert module dials the message digital string.

There are two important factors to consider when setting up the Alert module for
numeric paging. First, be sure to specify a string of digits that is meaningful to you,
such as a coded message. Second, be aware that there is no way to ensure that a
message has been successfully transmitted; there may be a busy signal or an
answering machine may take the call. The number of commas you add to your dial
string is an estimate of how long the modem at the remote site waits before it
transmits numbers.

2\ NOTE

In the following destination-setting example: 1-250-555-777,,,,,999#, the pager number is 1-250-555-
777 and the message string that displays on the pager is 999. You may need to insert 9,,, before the

destination number if the line you are using is not a direct line. In this case the destination numberis 9,,1-
250-555-666,,999#
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Alerting via Email

2\ NOTE

For detailed information about setting up your network and building a framework for meter email
(MeterM@il) alerts, refer to the technical note /ON MetermM@il.

If email is specified as the destination address in the Alert module then an email
message is sent to any address you specify. You can only set one email address per
Alert module. If you want to send an alert to more than one email address you
need to create a group — be sure your email server is configured to send email to
groups via SMTP (Simple Message Transport Protocol).

Follow the steps below to send email alerts from your meter. Note that your meter
must support emailing (with a correctly configured SMTP server):

1. Create an Alert module.

2. Configure these Alert module setup registers as indicated:

Message — type in the text of the alert to be emailed.

Destination — type in the destination email address.

Type — select Email.

Com Port — select Ethernet.

Location — type in a custom string; this is optional, and appears in the email.

* 6 6 6 o o

Email From — type in an address that you want the email to appear from. This
may be required as some SMTP servers only accept emails from valid
addresses.

3. Create an ION module that will produce a pulse on its Trigger output when the
exceptional event occurs (for example, a Setpoint module pulses its Trigger
output when the setpoint condition is reached).

4. Link the Alert module’s Trigger input to the Trigger output of the module created
in step 3.

Send and save. When the Trigger input is pulsed, the Alert module establishes
communications with the SMTP mail server, and emails the alert message.

© 2009 Schneider Electric. All rights reserved.
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19

Setpoints

This chapter provides instructions for configuring meter setpoints.

In this chapter

@ Infroduction ....... ..ol 206
& Configuring Setpoints .........coiiiiiiiiiiiiiiiiiiiiiaaa 206
Using the Front Panel ................ .. ... ... .. oot 206
UsingION Setup ............ 206

Using Vista ......... ... 206
Relative Setpoint Module Settings ................... ... ... ... 207
Fine Tuning Over Condition Monitoring ............................ 207
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Introduction

The Relative Setpoint module provides extensive control, secondary protection,
and analysis capabilities by allowing you to initiate an action in response to a
specific condition. It is particularly useful for performing actions based on
differences between a value (e.g. kW on phase A) relative to a reference value (e.g.
kW demand for all three phases). Use this module’s outputs for demand control of
equipment or any other applications requiring setpoint activity relative to a
varying value. See the ION Reference for more information on the Relative Setpoint
module.

Configuring Setpoints

"Over kW SWDemand"

Enable Ower Demand Setpoint :

(all setpoints have a default ON and OFF time delay of 30 seconds) Status | |

Annunciate if the total kw SwWDemand exceeds

Use ION Enterprise or ION Setup software to change your meter’s setpoints.

Using the Front Panel

You cannot configure Setpoints using the front panel.

Using ION Setup

1. Connect to your meter in ION Setup, using Advanced Mode.

2. Click on the Relative Setpoint module you wish to configure.

Using Vista

Open your meter in Vista, and click on the Setpoints tab. Click the Setup grouping
object. Use the switches to turn various monitoring on and off (see circled below).
Click the numeric boxes to edit condition settings.

ki

i

real-time reading :

Demand 1k

®

Annunciate if the current on phase A exceeds
Annunciate if the current on phase B exceeds

Annunciate if the current on phase C exceeds

Enable Owver Amp Setpaoint @ a;l

L

"Over Current on phase A,B,C" Status

real-time readings : I a
1b
te

"Over Voltage unbalance"

.

Annunciate if the Yoltage unbalance exceeds

1

Enable Owver Yunbal Setpaint : ao

Status |

real-time reading :
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Relative Setpoint Module Settings

The Relative Setpoint modules monitor the following for “over” conditions: phase
current, kW demand, and voltage unbalance.

Module Label Description
Relative Setpoint 1 Over KW sd When active, this annunciates when the total kW SWDemand exceeds a specified amount.
Relative Setpoint 2 Over | a When active, this annunciates when the current on phase A exceeds a specified amount.
Relative Setpoint 3 Over | b When active, this annunciates when the current on phase B exceeds a specified amount.
Relative Setpoint 4 Overl c When active, this annunciates when the current on phase C exceeds a specified amount.
Relative Setpoint 5 Over V unbal When active, this annunciates if the voltage unbalance exceeds a specified percentage.
Relative Setpoint 6 Over | 4 When active, this annunciates when | 4 exceeds a specified amount.
Relative Setpoint 7 Over | 5 When active, this annunciates when | 5 exceeds a specified amount.

2\, NOTE

There is usually no need to change any of the Relative Setpoint modules’ setup registers for normal
operation of the meter.

See the ION Reference for more information on the Relative Setpoint module.

Fine Tuning Over Condition Monitoring

If you want to fine-tune over condition monitoring, the only setup registers you
should change are SusUntION and SusUntIOFF.

SusUntlON determines how long the modules wait after an over condition is
detected before reporting it. This gives the monitored value a short period to
correct itself before the event is registered with the module so that very brief over
conditions are ignored. Similarly, SusUnt/OFF is the amount of time a normal
value must be present before the module considers normal operation to be
restored. Both SusUntlON and SusUntlOFF values are entered in seconds (the
default value for both is 30 seconds).

© 2009 Schneider Electric. All rights reserved.
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Chapter

20 Reports

This chapter provides instructions for viewing various meter reports and logs.

In this chapter

@ Infroduction ....... ..ol 210
¢ ViewingMeterlogs ........cciiiiiiiiiiiiiiiiiiiiiinennens 210
Using the Front Panel ................ .. ... ... .. oot 210
UsingION Setup ............ 210
Using Vista ......... ... 212
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Introduction

Accumulated meter values are saved in logs. These logs are acquired by your
energy management software (ION Enterprise or third-party) and saved in its
database for analysis and reporting.

The Reporter component of ION Enterprise is a database reporting application that
lets you define, generate, and manage comprehensive reports based on the
information in your system database. It processes selected data and generates a

finished report in Microsoft Excel format.

For more information on reports, see the Reporter section of the online ION
Enterprise Help.

Viewing Meter Logs

View meter logs using ION Enterprise or ION Setup software, or the front panel.

Using the Front Panel

The front panel only displays recent high priority events (Event Log).

DATE TIME EVENT CODE
12/08/2005 10:23:45  Shutdown SD25
12/08/2005 10:42:03  Power Up SD25

12/08/2005 11:19:26 Changed Setup  SD25
VIEW EVENT LOG THROUGH COMMUNICATIONS
9:36:54  12/09/2005 ABC Q1 NORM M ]

Press the Up/Down buttons to navigate to the Event Log.

Using ION Setup

Display various meter logs or reports using the Report Assistant.
1. Open ION Setup and connect to your meter, using Basic Mode.

2. Inthe Setup Assistant, navigate to the Reports folder.
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Setup Assistant E
= Template Meter Infa |
= Basic Setup

E= Security This shows the meter load profile information.

(2] Communications

1o
(Z] Revenue Evertlog
Meter Configuration

; Configuration Comparizon
= Displays Template Comparizon

= Verification b%-90 Report

\ Display |

< Back | Hext » | Exit | Help

3. Select one of the logs or comparisons in the list and click Display to view the

associated log.

Below is an example of an Events Log.

1 Event Log for PQ-D206A010-03 E
D ate/Time Cause Walue Effect
18/411/2004 1:2312533 P Front Panel Changed Setup SD395ub Intvl - 900
18/411/2004 1:2312884 P Front Panel Changed Setup SD405ub Intvl - 900
18/411/2004 1:2313.045 P Front Panel Changed Setup SD41 SubIntel 900
15/411/2004 1:2313.444 P Front Panel Changed Setup SD42SubIntvl - 900
18/411/2004 1:2313675 P Front Panel Changed Setup SD435ubIntyl - 900
18/411/2004 1:2313.912PM  Front Panel  Changed Setup SD44 Sub Intvl 900
18/411/2004 1:2314.310 P Front Panel  Changed Setup SD45 Sub Intvl - 900
18/411/2004 1:2314.476 P Front Panel Changed Setup SD46 Sub Intvl 900
18/411/2004 1:2314.777 P Front Panel  Changed Setup SD47 SubIntvl - 900
15/411/2004 1:2314.953PM  Front Panel Changed Setup SD48SubIntvl - 900
18/411/2004 1:2315.353 P Front Panel Changed Setup SD495ub Intvl - 900
15/11/2004 1:2315.586 PM  Front Panel  Changed Setup SDA0Sub Intvl 900
1841172004 1:2315.812PM  Front Panel Changed Setup SD51 SubIntvl 900
18/411/2004 1:2315.993 P Front Panel Changed Setup SDB2 SubIntvl 900
15/411/2004 1:2316.386 PM  Front Panel Changed Setup SDB3 SubIntyl - 900
18/411/2004 1:2316552 PM  Front Panel Changed Setup SD54 SubIntvl 900
15/411/2004 1:2316.850 PM  Front Panel Changed Setup SDES Sub Intvl - 900
15/11/2004 1:2316.951 P Front Panel Changed Setup SDBE Sub Intvl 900 LI
Cloze | Save bz | Frint | Help |

4. You can view, save or print the log. Click Close to exit.
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Using Vista

¢ Volts/Amps tab:

¢ Meter Events
+ Voltage

¢ Current

+ Power

+ Frequency/PF

Revenue tab:

¢ Revenue Data

Power Quality tab:

+ Harmonics Trending
o Transient & Sag/Swell Statistics CBEMA

+ Waveforms/Sequence of Events

Open your meter in Vista and click on the various tabs available. Click a grouping
object to view the associated logs. The following logs are available in Vista:
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